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Preface

Preface

ISPSoft is Delta’s new generation software development tool for programmable logic controllers.
IEC 61131-3, which supports five programming languages and a large number of applied
instructions, is adopted. Besides, ISPSoft manages projects by means of integrating tasks. The
efficient and convenient development environment that ISPSoft provides enables users to apply
PLCs to more complex control systems as well as to small control systems.

About IEC 61131-3

In early days, PLC developers established their own programming languages. These different

programming languages were burdens on users. In view of this, IEC 61131-3, which was published

by the International Electrotechnical Commission (IEC), appeared. IEC 61131-3 integrated the

characteristics of the programming languages. It considered users’ backgrounds and users’ habits,

and defined programming language standards that manufacturers and users could follow. The

program codes which meet the IEC61131-3 standard are more readable and compatible. The

description of IEC 61131-3 is as follows.

® |[EC 61131-3 integrated the programming languages established by PLC developers, and defined
five programming languages for programmable control systems: instruction lists (ILs), structured
texts (STs), ladder diagrams (LDs), sequential function charts (SFCs), and function block
diagrams (FBDs). Besides, continuous function charts (CFCs), derived from function block
diagrams, are also a common PLC programming language.

® The concept related to symbols is adopted. Users can replace a device with a symbol. A program
is more readable, and the time of assigning devices is saved,

® The architecture related to program organization units (POUS) is adopted. A traditional program is
divided into several program organization units which can be developed independently. The
architecture of a program can be more modular and can be maintained more easily be means of
calling functions and function blocks.

® Program organization units are managed and organized through the concept related to tasks. The
development of programs is upgraded to the management of projects. The large-scale
development of programs can be managed more easily.

About the manual

The manual aims to introduce the functions of the software. The related concepts are also

introduced. The slight variations among different models which are not obstacles to the operation of

the software are mentioned briefly. Users have to refer to the related operation manuals or

programming manuals for more information.

The contents of the manual are oriented towards the introduction of the operation of the software.

Users can easily find topics related to the operation of the software in the table of contents, such as

setting communication parameters, inserting a contact in a ladder diagram, monitoring devices

online, and enabling a simulator. If the topic of a chapter is related to a certain concept, the concept

will be introduced in the front part of the chapter. Users who are equipped with basic knowledge, or

who want to know the operation of the software can skip this part, and directly refer to the related

sections. Besides, if parts of the contents of a chapter are related to the contents of other chapters,

the sections to which users have to refer will be noted in the chapter. The brief introduction of the

chapters in the manual is as follows.

® Chapter 1 and chapter 2 introduce the installation of the software, the environment, and the basic
setting.

® Chapter 3 is about configuring and setting a PLC system.

@ Chapter 4 provides a simple example, and leads users to create a traditional ladder diagram in
ISPSoft in a short time without using the IEC61131-3 architecture.

® Chapter 5~chapter 8 introduce the concepts related to IEC61131-3, and the ways in which the
concepts are applied to ISPSoft.

® Chapter 9 introduces the relative concepts of motion control and axis and the ways in which the
concepts are applied to ISPSoft.

® Chapter 10~chapter 15 introduce ladder diagrams (LDs), function block diagrams (FBDs),
instruction lists (ILs), structured texts (STs), sequential function charts (SFCs), and continuous
function charts (CFCs) and the ways in which the concepts are applied to ISPSoft.




ISPSoft User Manual

® Chapter 16 introduces the auxiliary tools provided by ISPSoft.
® Chapter 17 is about monitoring a program, testing a program, and debugging a program through

ISPSoft.

® Chapter 18 introduces the password setting, and the data protection mechanism in ISPSoft.
® Chapter 19 is about configuring a network through ISPSoft, and creating a data exchange

mechanism.

® Chapter 20 is about backing up data and restoring data through ISPSoft.
® Chapter 21 introduces the tools used commonly in motion control through ISPSoft.

® Chapter 22 introduces auxiliary tools and wizards provided by ISPSoft for easier programming
and better operation.

Graphic representations

The graphic representations used in the manual are listed in the following table.

Graphic
representation

Description

Clicking the left mouse button

Clicking the right mouse button

Clicking the left mouse button two times in quick succession

Pressing and holding the left mouse button, and then moving the mouse without
releasing the button.

Typing with a keyboard

Operating sequence (The graphic representation is used when an operating

sequence is mentioned. For example, \O/ and

Number used to describe a figure

Point for attention (The item mentioned may be related to damage to equipment,
property, or a human body.)

Trademark declaration

The products and trademarks which do not belong to Delta Electronics, Inc. belong to the
companies which produce and declare them.
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1.1 Introduction of ISPSoft and System Requirements

ISPSoft is a software development tool for Delta’s new generation programmable logic controllers.
IEC 61131-3, which supports six programming languages and adopts a large number of applied
instructions. In addition to basic programming functions, ISPSoft also contains many auxiliary tools.
The multilingual environment and the friendly user interface provide users with a convenient and
efficient development environment.

1.1.1 Characteristics

® |t supports the international standard IEC 61131-3 and a large number of applied instructions.

@ |t supports five programming languages. They are ladder diagrams (LDs), sequential function
charts (SFCs), function block diagrams (FBDs), instruction lists (ILs), and structured texts (STs).
Users can use more than one programming language in one project.

® |t supports traditional Chinese, simplified Chinese, and English.

® The Find and Replace functions can be applied to a present window, or a whole project.
® |t provides a user-defined operating environment.

® The project management adopts an interface which uses a hierarchical tree structure.

® Users can develop several models in a group of projects.

® It provides many convenient functions such as making comments, creating bookmarks,
activating/inactivating networks, managing devices and symbols, simulation, and etc.

® |t supports several types of online operation such as monitoring programs online, editing
programs online, monitoring devices online, debugging programs online, operating/setting a PLC
online, and etc.

® Users can import and export projects by means of the Import and Export functions.
® Afile (*.dvp) created with WPLSoft can be opened directly, and can be converted into an ISPSoft
format (*.isp).
® |t provides several password setting mechanisms and data protection mechanisms.
® |t supports COMMGR, a new generation communication manager.
® There are three built-in configurations.
» HWCONFIG: It is used to configure hardware for a system, and manage parameters.
» NWCONFIG: It is used to configure networks for a PLC system, and manage data exchanges.
» CARD Utility: Users can backup and restore a system through a management wizard and a
memory card.
@ |t provides various solutions for motion control including PLCopen MC function block, G-code
editor, E-CAM editor, positioning planning chart tool and many more.
® The software can be applied to DVPxxMC series including DVP15MC, DVP15MC-06, DVP50MC
and DVP50MC-06.

1.1.2 System Requirements

Before using ISPSoft, users have to make sure that an operating system meets the requirements
below.

Item System requirement
Operating Windows XP /7 /810
system
CPU Pentium 1.5 G or above
Memory 256 MB or above (A memory having a capacity of 512 MB or above is

recommended.)

Hard disk drive Capacity : 1000 MB or above

For installing ISPSoft

CD-ROM drive . . )
It is optionally required.
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Item System requirement
Monitor Resolution: 800x600 pixels or above
(Recommended setting: 1024x768/96 dpi )
Keyboard/Mouse | General keyboard/mouse, or device compatible with Windows
. Printer with a driver for Windows
Printer . . . . . .
(It is used to print projects, and is optionally required.)
RS-232 port For connecting to a PLC Users have to select one of them
USB port For connecting to a PLC according to the communication

interfaces provided by the PLC or the

Ethernet port

For connecting to a PLC module used. (1)

Communication

COMMGR, a communication manager, must be installed on a computer. (*2)

software
AH500 series PLCs/DVP series PLCs (exclusive of DVP-PM series
PLCs)/VFD-C2000 series AC motor drives/VFD-C200 series AC motor
Models which drives/VFD-CP2000 series AC motor drives /VFD-E series AC motor drives

are supported

(*3)

PLC: all AH series, AS series and DVP series (except DVP-PM series)
AC motor drive: VFD series with PLC built-in

Text panel: TP series with PLC built-in

*1. ISPSoft supports several ways in which a computer is connected to a PLC. Users have to make sure of the ports
and the modes supported by a PLC before a computer is connected to the PLC.

*2. Please refer to section 1.2 for more information about COMMGR.
*3. In addition to ISPSoft, users must use PMSoft version 2.05 or above to develop AH10PM-5A and AH20MC-5A.

*4. The functions and specifications mentioned above are only applicable to ISPSoft version 2.00 or above. The
older versions may not be equipped with complete functions.

1.1.3

Installing 1SPSoft

When the previous version of ISPSoft is detected in a computer, that version is advised to be
uninstalled first before the latest ISPSoft can be installed.

(1) Start a computer and enter the operating system. Users have to log on to the system as a
system administrator before installing ISPSoft.

(2) Putan ISPSoft CD in the CD-ROM drive, or download the installation program from the official
Delta website http://www.deltaww.com/ to download ISPSoft. (The installation programs need
to be decompressed if downloaded from the internet.)

(3) Click Start, and Run... to open the Run window. Specify the path denoting the executable file
which is used to install COMMGR in the Open box, and then click OK. Alternatively, users can
double-click the icon which is used to install ISPSoft to execute the installation program.

OR

Q@ ‘\@
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(4) When a previous version of the ISPSoft is found, click OK then Yes to uninstall that version
shown in the pop-up windows (see below).

& I15PSoft 3.06 Setup X

| A previous version of ISPSoft was found, Please uninstall it

first. G)

Windows Installer

Are you sure you @tn uninstall this product?

—
‘ Yes ) Mo

2

(5) Click Install once Shield Wizard window appears.

48 I1SPSoft 3.06 Setup - b4

Welcome to the ISPSoft 3.06 Setup

Setup will guide you through the installation of ISPSoft 3.06.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Install to start the installation.

6

‘ Install ' Cancel
———

(6) Type related information in the User Name box and the Organization box, and then click
Next.
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()

(8)

Customer Information

Please enter your information.

User Mame:
|pELTA

Qrganization:
|DELTA

Install this application for:
(®) Anyone who uses this computer (all users)
() Only for me (DELTA)

InstalShield

< Back

Choose | accept the terms in the license agreement. Click Next to proceed to the next step.

15 1SPSaft 3.06 - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

SOFTWARE LICENSE AGREEMENT ~

THIS IS A LEGAL AGREEMENT BETWEEN %¥0U, THE END USER, AND DELTA ELECTRONICS,
INC., ACTING THROUGH ITS INDUSTRIAL AUTOMATION BUSINESS GROUP (*DELTA"). BY
INSTALLING, COPYING OR OTHERWISE USING THIS SOFTWARE, INCLUDING ANY "ONLINE™
OR ELECTRONIC DOCUMENTATION

(COLLECTWVELY REFERRED TO AS " SOFTWARE™), ¥'OU ARE ACCEPTING AND AGREEING
TO THE TERMS OF THIS AGREEMENT. IF %'0U DO NOT AGREE TO THE TERMS OF THIS
(AGREEMENT, DO NOT INSTALL, COPY OR USE THIS SOFTVWARE.

COPYRIGHT DELTA, 2014
: v
(®) 1 accept the terms in the license agreement K

(_)I do not accept the terms in the license agreement

InstallShield / @

T (s

Then, click Next for the next step.
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(9) Check the installation information, and then click Install.

1 15PSaft 3.06 - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Current Settings:

Setup Type:

Destination Folder:

C:\Program Files (x86)\Delta Industrial Automation\ISPSoft 3.06Y
User Information:

Mame: DELTA

Company: DELTA

Installshield

<ok (sl )| Concel

S~————

(10) After installation is complete, click Finish to continue the next step.

15 15PSaft 3.06 - InstallShield Vizard -

Installing ISPSoft 3.06
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs ISPSoft 3.06. This may
take several minutes.

Status:
Copying new files

InstallShisld
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(11) When installation is complete, shortcuts to the software is created on the desktop and Start
menu. Click Close to exit the setup.

&8 I1SPSoft 3.06 Setup -
Installation Complete
Setup was completed successfully. g

Completed

Qutput folder: C:\Users\ben. yuan'Desktop

Extract: ISPSoft_3.06_Installer.exe... 100%

Qutput folder: C:\Users'ben. yuan'Desktop

Execute: "C:\Users'ben.yuan\Desktop\ISPSoft_3.06_Installer.exe
Delete file: C:\Usersiben. yuan\Desktop\ISPSoft_3.06_Installer.exe
Completed

0

< Back Cancel

1.1.4 Uninstalling ISPSoft

(1) Generally, users can click ISPSoft Uninstall or choose Programs under Control Panel to
remove the ISPSoft; when ISPSoft Uninstall is not found, there are two methods to uninstall
the software:
® Method 1: Choose ISPSoft x.xx from the Windows list, click More then select Open file
location.

® Method 2: Place %ProgramData%\Microsoft\Windows\Start Menu\Programs\Delta
Industrial Automation\PLC\ in the address box and press Enter. Then, double
click ISPSoft x.xx file.

=2 Pin to Start

More
-2 Pin to taskbar

]E Uninstall

L3 Run as administrator

D Open file location

®
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(2) Remove the software by double-click the ISPSoft Uninstall.

&

(3) To uninstall ISPSoft, click Yes shown in the pop-up window. The window will automatically
close once the software is removed.

I15P5oft 3.06

Please wait while Windows corfigures I1SPSoft 3.06

A
Are you sure you want to uninstall this product ? o
Gathering required information. ..

] Cancel

1.2 Introduction of COMMGR

COMMGR is a new generation communication management tool developed by Delta Electronics,
Inc. in 2011. It functions as a communication bridge between Delta software and hardware.
Communication becomes more convenient and more efficient through the management of
COMMGR.

1.2.1 Operating Mode of COMMGR

Users can create communication parameters which must be set on the management list in
COMMGR in advance. The communication parameters which have been created in advance are
called drivers. Users can start or stop a driver in COMMGR. If a driver is started, a connection will be
created automatically. After the users specify a driver which is started in ISPSoft, a communication
will be carried out.

Software Communication Port

ISPSoft

F 3
v

COMMGR

F 3
Y

COM 1

F 3
v

Hardware

In addition to ISPSoft, other software communicating with hardware through COMMGR can operate
simultaneously. COMMGR automatically manages all communication commands, and makes
software connect to hardware.
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Software 1 \ / COM 1 <+—| Hardware 1

Software 2 |«=——»| COMMGR |+— Ethernet |<«—| Hardware 2

Software 3 / \ USB <+—| Hardware 3

The COMMGR window and the management list in the COMMGR window are shown below. The
drivers which are named by users are displayed in the Name column, parameters related to the
drivers are displayed in the Description column, and the statuses of the drivers are displayed in the
Status column.

EH COMMGR — 4
Name Description State Add

EP Driverl Ethernet, Realtek USE GbE Family Controller, Local IP Address OK (START) —

W Driver3 RS232/422/485, COMS, ASCIL, Protocol=0600,7 2,1, Retry=3,"  ERROR e

e Diriverd AS300 Simulator, Port=10002, Retry=3, TimeOut=3000ms STOP ———

o Driver3 RS232/422/485, COMS, ASCII, Protocol=115200,7 2,1, Retry=  OK (STOP) Delete

o Drivers RS232/422/485, COMS, ASCIL, Protocol=115200,7.2,1, Retry=  ERROR

EP Driver] Ethernst, Intel(R) Ethernet Connection 1219-LM, Local IP Addr  OK (START)

EP Driverd Ethernst, Intel(R) Ethernet Connection 1219-LM, Local IP Addr  OK (START)

1.2.2 Installing COMMGR

COMMGR is a software independent of ISPSoft. It must be installed separately. When the previous
version of COMMGR is detected in a computer, that version is advised to be uninstalled first before
the latest COMMGR can be installed.

(1) Start a computer and enter the operating system. Users have to log on to the system as a
system administrator before they install COMMGR.

(2) Put a COMMGR CD in the CD-ROM drive, or download the installation program from the
official Delta website http://www.deltaww.com/. (The installation programs need to be
decompressed if downloaded from the internet.)
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(3) Click Start, and then click Run... to open the Run window. Specify the path denoting the

executable file which is used to install COMMGR in the Open box, and then click OK.

Alternatively, users can double-click the icon which is used to install COMMGR to execute the
installation program.

—  Typethe name of a program, folder, document, or Internet
= resource, and Windows will open it for you.
Open:  ||C\COMMGR\DELTA |A-PLC_COMMGR.exe - OR

N

When the previous version of COMMGR is installed, click OK to remove that version shown in
the pop-up window (see below) and when uninstall is complete, click OK again.

(4)

COMMGR is already installed,

Click [DK] to remove the previous version or [Ca

<o cancel
this upgrade.
o Cancel

"4
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(5) Click Next after the Setup window appears.

<O

(6) Use default setup in the destination folder. Click Install to start the installation.

(7) When the installation is complete, the shortcut for COMMGR is created on the Start menu,
click Finish to close the setup.
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(@) COMMGR 1.09 Setup -

Installing
Please wait while COMMGR. 1.09 is being installed.

Extract: AS300Simulator.exe

Qutput folder: C:\Program Files (x86)\Delta Industrial Automation\COMMGR. 1.09Ya... ~
Extract: COMMGR_DATA_CHS. txt

Extract: COMMGR._DATA_CHT. txt

Extract: COMMGR_DATA_ENG. txt

Qutput folder: C:\Program Files (x86)\Delta Industrial Automation\COMMGR. 1.09\Sim. ..
Extract: AHSIM_5x0.exe

Extract: AHSIM_Sx1.exe

Extract: AHSimulator. exe

Extract: AS2005imulator. exe

Extract: AS300Simulator.exe

Mullsoft Install System 3,01

< Badk Mext = Cancel
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1.2.3 Uninstalling COMMGR

(1) Enter the settings of Apps & features in Windows, select COMMGR x.xx and click Uninstall.

©®

(2) Click Yes then OK to complete COMMGR uninstallation.

o Are you really sure that you want to uninstall the COMMGR
1,097
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1.3 1SPSoft for PLC Devices

The ISPSoft supports a variety of Delta PLC devices with many functions included. This chapter
provides information regarding the ISPSoft that is applied in 8 PLC series: AS200, AS300, AH5x0,
AH5x1, AH560, AHXXEMC, DVP, DVPxxMC series.

1.3.1 ISPSoft - List of Programming Languages

The ISPSoft supports 6 programming languages: ladder diagram (LD), sequential function charts
(SFC), function block diagram (FBD), instruction list (IL), structured text (ST) and continuous
function chart (CFC). The following table lists the PLC device and programming languages
supported.

AS200 | AS300 | AH5X0 | AH5x1 | AH560 | AHXXEMC
Vv V Vv Vv Vv Vv Vv

Ladder
Diagram V
(LD)
Function
Block
Diagram \ \Y \Y
(FBD)
Instruction Do Not
V V \ Support
ES3
Structured Only
Text V V V V V V Supports
ST ES3
Sequential
Function
Charts V V V V V V V
(SFC)
Continuous
Function Cally
Chart V V V Supports
ES3

(CFC)

1.3.2 1SPSoft - List of Functions

The following table shows major functions of ISPSoft.

DVPxxMC

AS200|{AS300 | AH5x0 | AH5x1 | AH560 [AHXXEMC

Motion Module
HWCONFIG V V V V V V Supports
ES3 ONLY

printing Funcion A

Ordered List V4 \Y/ \Y \Y \% \%
Custom Library [V V V V V V \Y

Delta Library V V V V V V V V

viv]|iv|iv]|v] v Y Y
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AS200| AS300 | AH5x0 | AH5x1 | AH560 | AHXXEMC DAV DVPxxMC
Axis V \
ModFi)fIi_c(;tion \ \ v v v \ \ v
‘ Con?r?w\gﬁ?ust \ \ \ v v v v
Status Bar V \Y V V \Y V V
Edit Register V V V V V V V
| Status Editing [V V V V V V V
| Supports
SA/SX/SCI/E
H/EH2/SV/E
File Registers V V H2-L/ES2/ES
2-E/IEX2/SX2
[SA2/EH3/SV
2/EH3-L/ES3
Position-Step [V Vv V V V V V
Alignment V V V V V \Y \
Supports
EH3/EH3-L/S
Online Editing V V V V V V V2/ES2/ES2-
E/EX2/SA2/S
X2/MC/SS2
‘Troubleshooting V V V V V V \%
system Log  [AVARNINAVAR SRV IRV N VAR B VAR s Y
| 3D Coordinate V
s v | v v v v v v Y
N v | v v v vy v Vv
[ POU Password V vV V V V V \Y V
Subroutine SDL?plr\)lc())rtt
Password ES3
Do Not
NWCONFIG Vv Support
ES3
Data Backup Supports
Supplerentar EHS/EH2

1-15



ISPSoft User Manual

AS200| AS300 | AH5x0 | AH5x1 | AH560 | AHXXEMC DVP DVPxxMC
Supports
PLC Permanent EH2/EH2-L/E
Backup Setting H3/EH3-L/SV
ISV2
CARD Utility V V
E-CAM Editor V V V
Position vV vV Supports
Planning Table ES3 ONLY
Supports
Oscilloscope V V Esg%NLY
Supports
Data Logger V V ES3 ONLY
High-speed Supports
Counter Setting [V V ES3 ONLY
Wizard
AIO Wizard Do) e
. Support
Setting ES3
Do Not
Control ES3
o Do Not
Weighing Support
Module ES3
Extension guo Ng:t
Module Wizard EpSps
Extension
Module- L (el
o Support
Monitoring ES3

Wizard
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2.1 Guidelines and Environment

2.1.1 Getting Started

After installing ISPSoft, shortcuts is created on your desktop and Start menu for quick access of the
software. In addition, users can install ISPSoft by taking the following steps below .

6

After the welcome screen image, the Delta ISPSoft window appears with basic functions provided.

o

Click on the toolbar to create a new project.

0
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In the Create a New Project window, type a project name in the Project Name box and a path in the
Drive/Path box. Also, select a Controller Type and PLC Type from the drop-down lists. After users click

Properties..., they can give a description of this project and click OK.

Project Name My _Project
Controller Type AH hd PLC Type AHCPU330-EN
Drive/Path C:

Properties...& OK | Cancel |

Pro gram Titla DEMO 0K ‘

| File Name My_Project Cancel
|| Company DELTA
Designer USER1
|
DEMO Project Comment

After the project is created successfully, a Project section appears on the left side of the dialog box with
items listed in a hierarchical tree structure. If the section did not appear, users can click View on the

toolbar, then choose Workspace or click from the icon bar. To view Compile Message section,

select View > Output Window (M) or click

2-3



ISPSoft User Manual

O

NV

When a project is created, the main working area is blank with no editing. To start PLC programming,
users can right-click Programs in the Project section and click New....

& Device Mon

o F8 4Pls

In the Create Program window, users can type a program name in the POU Name, and select a
programming language in the Language section. Other parameters in the window use defaults and the

description is provided in section 5.4.

Create Program X
POU Name rTask
Progd Cyelic Task (0) hd
v| Active
rProtection
+) None
Password Sequential Function Chart (SFC)
Function Block DHagram (FED)
Instruction List (IL)
Structure Text (ST)
POU Comment
0K Cancel
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When a program is added under Programs, an editing area is formed in the new program window.

Th LHCFUSIEN (My Project) w Progh =N =R
B Motion Moduls Local Symbals

+ @ Tasks Class Identifiers | Address Type... |Initial Va... |dentifier Comment...
EP Clobal Syrebols

=3 Progrs

S Network 1 B
gl Fumstion Blocks shwor
& Dewice Ivonitor Table

+-- T8 APIs
< LH

The ISPSoft main screen is shown below.

0 —J»i’ My_Projext[DEMO] - Delta ISPSoft - [Prag0] - O e
@ ) J‘! Fil= Edit View Compile PLC Tools Window Help -5 X -
B = & & i 7 5 & s
(3) QO YPDS @43 Qe i i 1] 5 Tl TN R S R V|
Local Symbols | Delta Library, Preview 1 x
= NWCONFIG A Class Identifi | Address  Type... Initial ... Identifier Com... |De1m]_ibm-y ~ |
o Projectfcwy_ee 4T w7 Delta Library
) Device Comr 0
Used Devic
&4 HWCONFIC @
CARD Utility =
AHCPUS30 MNetwork 1 N
9 —» Wotion Modi Delta Library | User Defined Library
Tasks |Preview - |
2 DUT M1 M2
- Global Sym 1 1 ] { ) 7
N |
3 Programs ¥ | P b
< >
A .
Project < | > Preview
|Compile Message qx
v 0 Erors
@ —¥|| v 0Waming
WCompﬂeMessage Find Result
@ —>| Insert  Network: 1 /262128 Steps Undefined Driver

© Window title: It displays a project name and a program title.

@ Menu bar: There are eight menus.

© Toolbar: There are five toolbars.

@ Project: Uses hierarchical tree structure to manage the section.
© Compile Message: Shows compiling result and project search.
@ Status bar: Displays current edit or network status.

@ Work Edit: Includes program edit section, local symbols, monitoring chart a device table, and etc. are
displayed in this area.

@ Delta Library: Lists out contents regarding Delta library and user-defined library.
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When using ISPSoft, users can click Help from the toolbar to get help.

Help

About..
B Aunitiary Edition »
&P 15PSoft User Index
@) PLC Instruction and Special Registers Reference
@ Revision History

Iltem Description
About... Information about software version and date of release.
Auxiliary Edition Auxiliary edit tools, e.g. communication format < = > parameter code.

Contains software usage information. (Alternatively, users can click

ISPSoft User Index on the toolbar to view the information.)

PLC Instruction and | Information on instructions and registers. Users can click any

Special Registers | instruction in the program edit section and press F1 on the keyboard for
Reference explanations.
Revision History Lists out the software version updates or modifications.

2.1.2 Window Title and Status Bar

After a project is created, the window title displays in the format of project name [program title]. If there
is no program title, the project name is shown as the window title. Users can also click Edit (E) and select
Project Properties to view the program title.

Program Title DEMO OK
_ Cancel|

| File Name My _Project Cancel |
| Company DELTA
Designer USER1

DEMO Project Comment
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The status bar at the bottom of a window displays all kinds of working status. For example, edit mode
(insertion/replacement), current network, PLC scan time, compiled program size or program capacity,
connection status, PLC status, communication parameters, and PLC model nhame.

PLC Model Name —

Communication Parameters

PLC Status
Connection Status
l A\ 4
Insert  Network: 1 Scan Time: 1.200 ms 195/262128 Steps RITH Drv_USE, [U3E: COM4] AHCFUS30-EN

A

T—Compiled Program Size/ Program Capacity
PLC Scan time

Current Network

L Insertion/Replacement mode

2.1.3 Toolbar - Functions

The ISPSoft toolbar contains eight functions. The contents of the functions may vary based on the editing
and model selected. This chapter presents a brief introduction of the toolbar. For more explanation,
please view the following chapters concerning the functions.

File Edit WView Compile PLC Tool Window Help

® File: To save a project as its main function.

File | Edit Wiew Compile
Hewr 3
Cpen Crl+O
Save Ctrl+s

Save &s  Cirl+Alt+S

Closs Project

G Pl L

Euint Ctil+P
Project Prnt

Prnter Setup

L

1 CAPRI_0isp
2 CAPRI_Lisp
3 CAPRI_2isp

Exit Al+E

® Edit: Lists out the operating tools used for editing.
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® View: Offers information regarding the project and workspace.

Yiew  Compile PLC Tools Window Help
%  Toohar ]

Cnatprat Windowr

Workspace

Zaoom 3
Monitoring Data Format Signed Decinal -

Floating Format Setting
@ Used Device Feport

o

BY Project Properties

® Compile: Check programming syntax or compile programs into executable code.
Compile | FLC  Tools W
BE cheek  ameF?

B Compile  CtleF?

® PLC: Sets up a PLC connection and functions through ISPSoft.

® Tools: Provides convenient functions to execute ISPSoft.
Tools | Window  Help

Comnmnication Settings...

i}

Change PLC Type...
Program Settings 3
(] setrTC
\a Export 3
l-a Import 3
Langmage English -
Options...

® Window: Manages the windows regarding the Edit section in workspace.

Window | Help

ﬂ Cascade

M Tile Vertically

B Tile Horimontally
1 Progll

2 Progl

3 Progd
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® Help: Provides auxiliary functions for ISPSoft.

Help

About...
B Augiliary Edition 3
&P 1SPSoft User Index
@ Motion User Index
9 PLC Instruction and Special Registers Reference
@ Revision History

2.1.4 Toolbar- Icons

There are five icon categories on the toolbar. The icons may also vary based on the editing and model
selected. When a mouse cursor points at an icon for a short while, its function and keyboard shortcuts is
shown; users can select their icons to show or hide under Toolbar by clicking View.

> [ __; View | Compile PLC Tocls Window Help
n =l [=0E e e
M Workspace FLC
Chutput Windowr Cormmon Editor

Monitoring Data Format  Antomatically -
Floating Format Setting
§  Device Comment sed Device

® File toolbar: Provides functions related to managing a project.

BeEg @

® Editing toolbar: Provides functions related to editing work.

® Quick PLC toolbar: Provides functions related to PLC operation.

® Troubleshooting toolbar: Provides functions related to troubleshooting. The icons in the toolbar may
vary based on the model selected.
*. The DVPxxMC currently does not support this function.

AH/AS series:

DVP series:

® Programming toolbar: Provides functions related to programming. Icons may vary based on the
programming language used.

D: TR % At (R {IME R %3 -0
FBD: B HEF0 W% it DDE 0404 3% %0

IL: -2 Gl G T
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ST. |: = IF REFEAT WHILE FOR CASE

SFC MR BREGEERERL T
cre: B e A0 H 08«

.1.5 Project and Compile Message

he Project section contains contents related to project development and uses hierarchical tree structure
to manage its interface. The section includes tools for configuration, device information and instruction
application, user-defined variables, program items and monitoring tables. In addition, the lists in the
section may vary based on the model selected.

On the left of the ISPSoft screen is the default Project section and click on the upper right corner to
close the section. Users can click or select Workspace under View from the toolbar to open or

close the Project window. When users right-click an item in the Project section, a corresponding quick
menu offers items for selection.

In Compile Message section, users can click the tabs referring to the Compile Message and the Find
Result. The Compile Message page shows the results of compiled programs or messages when
checking on the syntax. While the Find Result page lists out the results on the searched projects.

The default Compile Message section designed at the bottom of the ISPSoft main page, users can click

on the toolbar or select Output Window (M) under View from the toolbar to open or close the
section. Click on the upper right corner of the window can also close the window.

>
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Users can click [@ on the upper right corner of the window to change the display of the Project or
Compile Message section. When the icon changes to [, the section is hidden. When the mouse cursor
moves away from the section for a while, the window of the section automatically turns into a tab on the
page, but when the mouse cursor moves to the tab, the tab is opened.

O

<«— The tab opens when a mouse
cursor points at the Project tab,

When the section is not hidden, users can drag the tab with a left click mouse button to any position or

combine the tab to a different section. If users want to drag the whole section, they have to drag the title
bar.
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2.1.6 Workspace

Users can view maximized or minimized windows in this section. To maximize a window, the status
buttons for the window appears on the right side of the toolbar.

® Display windows

® Maximize the window

Select Window on the menu to change the Prog. windows.

Window | Help
Bl Caseade
[T Tile Vertically
= Tile Horizontally
1PieD )
2 Prol <«— Click to change for the
3 Prog? current Prog. Window.
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® Cascade: When selected, all windows will stack on top of each other, and the current window is the
first one displayed.

B Tilk Hovizentally "
1 Prog)

2 Progl

3 Prog2

® Tile Vertically: The windows are displayed like tiles in vertical alignment; the current window is at the
leftmost side.

Windear | Help
ﬂ Cascade
||jj Tile Vertically

® Tile Horizontally: The windows are displayed like tiles in horizontal alignment; the current window is
at the topmost.

Window | Help
B Cascade

[T Tile Vertically
|E Tl Bl |
1 Progll

2Pmgl

3Prog2
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2.2 Project Framework
2.2.1 Single Project and Group Project

Two types of project frameworks are described below.

® Single project
This is the basic project type. Each project can only execute one model. The file type of a single
project is *.isp.

® Group project

If several devices are connected on a network, users can create a group of single projects for the
devices without restriction. The number of projects which can be created is unlimited. Users can
make projects according to practical application, and they can carry out network configuration for the
devices in a group of projects through NWCONFIG rapidly and easily.

The filename extension for a group of projects is *.pri, and the filename extension for every project in
the group is *..isp. The isp files are in the folders whose names are the same as the project names.
Users can import a single project which was created previously to a group.

*. Please refer to chapter 19 for more information about NWCONFIG.
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2.2.2 Integration of Motion Control Modules

The AH series include motion control modules such as AHO5PM-5A, AH10PM-5A, AH15PM-5A,
AH20MC-5A, AHOSBEMC, AH10EMC, AH20EMC. Users can write a program regarding AHxxPM and
AHxxXMC motion control modules by means of PMSoft, a software developed by Delta Electronics, Inc.
Please refer to PMSoft User Manual for more information about usage. The AHXXEMC can be used as
host or motion control module in ISPSoft.

Users can create projects concerning motion control modules in ISPSoft and configure hardware as well
as parameter settings through HWCONFIG. Each AH series can create more than one motion control
module project whether the project framework is single or in a group, the corresponding motion control
modules also need to be added for hardware configuration in HWCONFIG. Please refer to section 2.2.5
for more information.

GROUP

The PMSoft projects include AHxxXPM and AHxXxMC modules, with filename as .ppm. While ISPSoft
project contains AHXxXEMC modules, the file name is .isp and is placed in the same path as of single
projects for AH series. Regarding previously created PMSoft or ISPSoft projects, users can import those
to an ISPSoft project.

|iject o x

o g WWCONFIG
= B Project [CAISF_ProjectlSP_Projectisp]
o] Device Comment List
gl Used Device Report
& HWCONFIG
B CARD Utility
-7 AHCPUS30-EN (ISP_Project)
-4 Motion Moduls
- B AH20MC-54 Rack:] 8ot [CASP_ProjectddC_1 ppm]
- B AH20MC-54 Rack:l Slotl [CAISP_ProjectddC_2 ppm]
AHO5PM-58 Rack:l 8lot:2 [CAISP_ProjectPM_L.ppm]
AHOBEMC Rack:l 8lot3 [CASF_ProjectEMC_IEMC_1 isp]
- [ AH20EMC Rack:l Slotd [CAISP_ProjectEMC_2EMC_2 isp]
3 DT
q Global Symbols
B Programs
—gia Function Elocks
-8 Device Monitor Table
F- R APLs

Project

*1. An imported PM project must use file format that is avilable for PMSoft v2.05 or above, and do not support DVP-PM
series projects.
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2.2.3 Managing a Single Project

® Creating a single project
User can click the File menu, point to New, and click New to create a new project. They can also
create a new project by clicking E on the toolbar.

File | Edit ¥iew Compile

Hewr 4 ilE Mew  Ctrl+l
Open Cal+ Group Px‘ﬁt J OR IE

Close Project

Save Ctrl+3

Sawve &z Ctrlvdl+S

G EgE SR

Print Ctrl+P
Project Print

Printer Setup
Program Comparison  »

Export 3

LYol

Import 3

Exit AT

In the Create a New Project window, type a project name in the Project Name box and a path in the
Drive/Path box, and select a Controller Type and PLC Type from the drop-down lists. After users

click Properties..., users can add description of this project. Finally, click OK.

Project Name My_Project

Controller Type AH AHCPU330-EN -

Dirive Path Ca

Browser..
| Pmpemes..gl\. m Cancel

Program Title ~ |DEMO 0K
| File Name My_Project Cancel
| Company DELTA
Designer USER1
|
DEMO Project Comment
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After a project is successfully created, the ISPSoft window title displays the project name, under the
format of project name [Program Title]. When no program title is setup, the window will display only
the project name. When users want to view or modify the program title, users can click Edit from the
toolbar and select Project Properties to type in the information.

Wy Eile | Edit

B

o My_Project{ DEMO]Y) Delta [SPSoft - [Prog0]

View Compile PLC Tools
Undo Ctri+Z
Redo Cerl+T
Ctrl+X
Ctrl+C
Cri+V
Ctr+R
Ctrl+D
Delate Del
Select All Ctrl+-A
Select Block Ctrl+B

Add Network (After)  Shift+Cted+
Tnzert Network (Befors) Cte+

Find.. Ctr+F
Replace. (H) Ctrl+H
Goto..(D Ctri+-G
Step Positioning

Bookmarks

Activate Network Shift+Ctrl+A

Inactivate Network Shift+Ctrl+§

Project Properties w

Window E

Local S
ddr | Ty

[T

Compile Message | Find Result

Insert Network: 1

Program Title DEMO

| File Name My_Project
| Company DELTA
Designer USER1
DEMO Project Comment

0K

Cancel |

4

Under Project, users can view the path of the project file and selected model. For AH/AS series
projects, the PLC label name is shown in parentheses next to the selected model, and the project
name is set as default. However, the project name can be reset in HWCONFIG. Users can refer to
section 3.3.2.1 for more information.

1

*. Only AH/AS and DVPxxMC series have PLC label names, but DVP series do not. The main function of the label name
is to perform device identification, especially for network applications or other online operations. The gathered

information can be used to check whether the object is operating as we expected.

® Save project

When a project is created, the file denoted by a path is not established immediately. Users need to
click ‘Save'’ first for the file to exist. To ‘Save’ a project, please refer to the following description.

Select File from the toolbar and click Save. Or click on the icon bar.
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File | Edit ¥iew Compile

Her 3
& Open Ctrl+0
E% Close Project
= |
Save Ct:

Save As  Clrl+Alt+3

& Prmt Cl+P O R

Praoject Print

&g FPrnter Setup

E Program Comparison  »

] Esxport b
I-a Import 3
Exit AN+E

Select Save As from the File menu to save the file using a different file name or save the file denoted
by a path in another location on your computer. After setting a new path and a new file name, click
Save.

File | Edit View Compile

Hewr 3
E Cpen Ctrl+O
E& Close Praject
Save Ctrl+d
| B saveds Ctrelies ¥ |
& Prnt Chrl+P
Project Prnt
&3 Printer Setup
E Program Comparison b
\a Export ]
I-a Import 3
Exit Al+X

&1 NWCONFIG @\
= Project [CAISP ProjectMew PJisp]
i} _T'10] _TJ 5],

Dewvice Corareent & Used Device | ©

&4 HWCONFIG

B CARD Utility

¥ LHCPUS30-EN (PI_0)
B Motion Maduls

*. To ‘Save As’ a file will not change the PLC label name, the name adopts the created project name by default but can
be modified in HWCONFIG.

® Open previous project
If users want to open a previous project, they can click Open on the File menu, or click on the

toolbar. Users can select from the Files of type for the previous file and click Open. The following
table shows the file types that can be opened.

File type Description

This is a single project file. If old file format is opened, the
ISPSoft will automatically change the file into the new format.
This file is created be WPLSoft. When the file is opened and
saved, it is automatically changed into an ISPSoft file (*.isp).

ISPSoft Group Files (*.pri) It is a group of files in ISPSoft.

ISPSoft Files (*.isp)

WPL Files (*.dvp)
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*. WPLSoft is a PLC programming software produced by Delta Electronics, Inc.. Please refer to WPLSoft User Manual
for more information.

File | Edit Wiew Compile
N\

——— OR H=aE&mo ¢

Close Project \
Save Ctrl’

Save &z Clrl+AlL+5

Print Chl+P

@ aE B

Project Print

Printer Setup
Program Comparison b

Export 3

LYol

Import ]

Exit AM+E

24

)l
15PSoft Group Files[* pri]
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Users can select File from the menu to open recently edited files.

File | Edit Wiew Compile
Hew 3
Open Crl+0

Close Project

Save Crl+2
Save fs  Cirl+Alt+3

GEE PR

Print Ctil+F
FProject Print
Prnter Setup

Program Comparison b

Export 3

LYol - [

Import ]

|  1coemo2ip wf
2 C:DEMO_Lisp v

Exit A+

® Close project
Click Close Project from the File menu once the editing is complete. When the modified project is not
saved, a pop-up window appears to confirm whether the project needs saving or not.

Hewr 3

@ Open Ctrl+i

E& Closa Project

M zave Cirl+S K@
=

=

Save &z Ctel+Alt+5

Print Ctrl+P
Project Print

Printer Setup
Program Comparison  #

Export 3

(o) ol o I

Import »

Exit AIE

A4

Additional remark

If users do not close the project before leaving ISPSoft and restart the software again next time, the
system will automatically open the file edited from last time by default. (Users can set the function to
enable or disable for opening previous projects. For more details, please refer to section 2.3.1.)
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2.2.4 Managing Group Project

® Creating group project

Click the File menu, choose New then move to Group Project and click on New Group Project.
File = Edit ¥iew Compile

Weor , | B Hew cubn

Open Crl+0r | Group Project || Hew Group Projec
Close Project

Save Crl+5

Save b5 Clrl+AlL+3

Print Ctil+P

G EgE P

Project Print

Printer Setup
Program Comparison b

Export 3

Import 3

LYol -

Euut AW+E

When creating group project, users also need to create a single project from the group. In the Create a
New Project window, type the Project Name and Drive/Path, select the PLC Type and Controller
Type from the drop-down lists. Users can add information and description related to the project by
clicking Properties; Nevertheless, type Group Name in the box then click OK.

Project Name PI O
Controller Type AH v PLC Type AHCPU3S30-EN v
Diive Path C:AGROUER_PI

Group Name GROUP_0 Erowse...
Properties... 0K | Cancel |

After a group project is created, information related to the first single project will be displayed in the
Project section. Owing to the fact that there is only one single project in the group, so it is displayed
and operated in the same way as creating a single project. The only difference is under the group
project framework, users cannot execute the Save As function.
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® New to group project

Click File from the menu, choose New move to Group Project and click New to Group Project to
add new single project to the group. Or, you can also right-click a Project in the section and select
New to Group Project.

File = Edit ¥iew Compile

| Hew P Hew coew

@ Cpen Cirl+0 | Group Project Hew Group Project
E& Clase Project Hewr to Gronp Project
Save Ctzl+S

Close All Project

@

Print Ctil+F
Project Print

Printer Setup
Program Comparson

Export ]

(N bl s I

Import 3

Exit A+E

Letive Project

Hewr to Group Project

B CARD Utility Add to Group pm!Q .
T AHCPUS20-EN (P.J_ @

B Motion Module

[ Tasks

E DuT

EP Global Symbols

i Programs

g5 Function Blocks

& Device Monitor Table
+--FH APls

In Group Project, only one project is edited at a time. Therefore, when a new project is added to the
group, the editing project needs to be closed. A window will appear to confirm if this editing project
needs saving or not.

In the Create a New Project window, users can type a project name in the Project Name box, and
select a PLC in the PLC Type drop-down list box. Besides, after users click Properties..., they can
give a description of the project. However, users can not specify a path.

Project Name PI_1
Controller Type AH v PLC Type AHCPUS30-EN v
Dnve/Path

T
Properties... OK | Cancel |
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® Active project
In Group Project, only one project is edited at a time. To edit another project, right-click on the selected
project and choose Active Project. Or, double click to activate on the selected project.
e NWCONFIG
=

&4 HWCONFIG
B CARD Utility
T AHCPUA30-EN
B notion Module
[B) Tasks

E DuT

EP Global Symbols

i Programs

g5 Function Blocks

& Device Monitor
+-- T APl

Eemove from Group Froject

OR

S NWC ONFIG

L Project [CAGROUP_PAPJ_1PJ_1.isp
= (5 Project [CAGROUF_POPJ_2FJ_2.isp]
g} Device Comment & Used Davice
& HWCONFIG
B CARD Utility
T AHCPUSI0-EN PJ_%
B motion Module
[ Tasks
E DuT
EP Global Symbols
s Frograms
g2 Function Blocks
& Device Monitor Table
4. T8 APIs

When switching to another project, the selected file can be edited in the Project section, while other
files not activated are in gray colors.
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® Importing single project to a group

When a single project (*.isp) file is not created under a group, users can import it into the group. To
import a single project, you can right-click a project in the Project section, then select Add to Group

Project from the quick menu to select the import file.

B

| MG OMFIG

i cfive Project

Newr to Group Project

|| 444 to Group Project

m AHCPUS30-EN iPJ

B Motion Madule Remove fom'Seryf t
[ Tasks @
B ouT

EP Global Symbaols

B Frograms

g Function Blocks

& Device Monitor Table
4. T/ APIS
E Praject [CWGROUP_PAPJ _1MPT 1 1sp]
% Project [CAGROUP_PPJ_2\PT 2 isp]

Only single project *.isp files are allowed to be imported. When importing a single project, the project
will be copied to the group project file, and the single project is still saved in the original path of your

computer.

24

.8 Project [CAGROUP_FIFI_DPI_0.isp]
£ Device Corornent & Used Device
£ HWCONFIG
B CARD Utility
¥ 4HCPUS30-EW (PI_0)

B Motion Iodule
[T Tasks
EP Global Syrbols
I Progams
B, Functinn Blocks
[ Device Morvitor Table
. T LPIs
(% Project [CAGROUP_PIPI_1]_L isp]
(% Project [CAGROUP_PIPI 2] 2 isp]
| 3% Projest [C:AGROUP_PJibew_PItNew PJisp] |

2-24



Chapter 2 Starting and Setting ISPSoft

® Remove from group project
When removing a single project from a group, they can right-click the selected file in the Project
section and click Remove from Group Project from the quick menu. However, if there is only one
project in the group, that project cannot be removed.

Wewr to Group Project
4dd to Group Project

&4 HWCONFIG :
B CARD Utility || Remave from Group Project

TR AHCPUS30-EN LN .

B Motion Module

(@) Tasks

B DUT

EP Global Symbols
i Programs

g5 Function Blocks
& Device Monitor

4T APls

B MAWCONFIG
% Project [CIGROUP_PJPJ_11P_1.isp]
=% Project [CAWBROUR_PJRJ_21PJ_Z.isp]
& Device Comment & Used Device
& HWCONFIG
B CARD Utility
T AHCPUS30-EN (PJ_D)
A Motion Module
[ Tasks
B ouT
EP Global Symbols
R Programs
g Function Blocks
& Device Monitar Table
+ T8 ARIS

Froject

When removing, the file is removed only from the list of projects in the group project file, and not from its
former path. Users can re-add the project into the group through importing the file.
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® Open a group project
To open previously created group projects, click Open from the File menu, or in the toolbar, then
choose Files of type to select ISPSoft Group Files (*.pri) in the drop-down list box and click Open.

uﬁ:)!lﬁ.l &

9 0 o

File | Edit Wiew Compile

Hewr »
@ Open Cirl+ O
Clase Project
Save Ctal
TH] Saveds Codvaltd
& Primt Ctr+P

Project Print
Printer Setup

=

E Program Comparison  #

\a Export 3

I-a Import 3
Ext Al+E

When the group file to be opened has a red cross icon on it, this means the single project saved in the
path used to denote group project appears abnormal and may be either removed, saved in a new path
or using a new file name.

r'ﬂ' Project [CAGROUP PIPT 0FT 0.isp]

{%+ Projest [CAGROUF_PIFI_IWPJ_1 isp]

¥ Froject [CIGROUE_FIE] 2IF]_2isp)
® Close project
Click Close Project from the File menu to close editing projects, but other inactivated single projects

can still be activated. Users can click Close All Project to close the entire project.

File | Edit View Compile

Hewr 3
D” Open Cirl+ O
|E§ Close Project |
Save Ctrl+S

| Close All Project |

& Erint Chl+F
Project Print

& Prnter Setup

E Program Comparison  #

\a Export 3

I-a Import 3
Eaat AN+E
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2.2.5 Managing Motion Control Modules

In the Project section of ISPSoft, the Motion Module option is added for AH series. To add AHxxPM and
AHxxXMC motion modules, users must install PMSoft version 2.05 or above.

® New Motion Module - AHxxPM and AHxxMC

If users want to create a PMSoft project in ISPSoft, click Motion Module in the Project section and
choose New Motion Module from the quick menu.

S MWCONFIG
= Praject [CIEX_PMIEX_PM.isp]

il Device Comment & Used Device
£ HWCONFIG ‘
B CARD Utility

: ()

Hew Motion Module J

CE= DuUT 4dd Existed Motion M&gule
£P Global Symba @
5 Programs

g Function Blocl
& Device Monito
+--TH AFls

Then, type the File Name of the motion module project and select a model Type from the drop-down
list. In addition, choose the Rack No. and Slot No. from the drop-down lists based on HWCONFIG
configuration. Each slot also corresponds to a motion module. If users are uncertain of the mounting
position or may rearrange the slots later, users can select Undefined from the Slot No. drop-down list.
Click OK once the setting is complete.

| File Name FLI_O ”Type AHIOPM-54 hd |

| RackHMa. 1 - Slot Ha. vl

1}
/ o D et |

T AHCPUS30-EN (EX_PM)

=B
4H10PM-54 Slot:0 [CAEX_PMIPM_0 pprd |

[B Tasks

EP Global Symbols
B Frograms

o Function Blocks
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® Open AHxxPM and AHxxMC Motion Module Projects
To edit AHxxPM and AHxxXxMC motion modules, please double-click the project file and PMSoft will
automatically be opened for users to implement software development and programming on motion

modules in PMSoft.

S MWCONFIG
= [3 FProject [CAEX_PMER_PM.isp]
g} Device Comment & Used Device
& HWCONFIG
B CARD Lhility
T AHCPUSI0-EN (EX_PM)
=[] Motion Module
AH1 0P -5 )
AHTOPM-5A Rack:Undefined Slot:Undefined [CAEX_PMER_PM1 ppm]
[@) Tasks
. DUT
£V Global Symbols
i Programs
g5 Function Blocks
& Device Monitor Table
4T APls

*. Please refer to PMSoft User Manual for more information on the usage. If PMSoft is opened through ISPSoft, users
can only edit motion modules, but must save the edited content in PMSoft to complete the execution.

® Open AHXxXEMC Motion Module Projects
To edit an existed project concerning AHXXEMC motion module, please double-click on the file and
ISPSoft will automatically be opened for users to implement software development and programming on

motion modules in ISPSoft.

|Pro]ect o =
g WMCONFIG

Br_'g Project [CASP_ProjectlsP_Projectisp]

<[ Device Comment List

@ Tsed Device Report

2 HWOONFIG

CARD Ttility

AHCPUS30-EN (IRF_Project)

Motion Module

-f AHZOMC-54 Rack:1 Slot0 [CAISP_ProjectMC_1 ppm]
<[ AHIOMC-54 Reck:] Slotd [CAISP_ProjectddC_2 ppm]

M AHOSFM-54 Rack:l 3lot:2 [CSF_FrojectPh_L .ppm]
AHOBEMC Rack:1 Slnt:3

Tasks
. DUT
g ¥labal Symbals
e Programs
g3 Function Blocks
<[ Device Monitor Tabls
G- T APLs

| N
= v

*. When ISPSoft is opened through the ISPSoft, users can only edit motion modules, but must save the edited content in
ISPSoft to complete the execution.
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® Remove Motion Module

To delete an existed motion module project, users can right-click the selected project and choose
Remove Motion Module from the quick menu; when removing, the module project files (*.ppm) or
(*.isp) is removed only from the list under the Project section, but still saved in its original path.

Ha MWCONFIG
] (3 Project [CAEX_PWMEX_PM.isp]
i Device Comment & Used Device
&4 HWCONFIG
B CARD Utility
T AHCPUS30-EN (EX_P)
< B Motion vodule
AHTOPM-5A Rack:1 Slot:0 [CIEX_PMPM_0.ppm]
AHTOP -5 Indefined Indefl

@) Tasks \ ‘ Hew Motion Module
DUt

4dd Existed Motion Modale
Glabal Symbals @
@: Y || Eemove Motion Module ||
S Frograms

m> Function Blocks Change Slot Ha. V\ .
& Device Monitor Table
+-- T8 APIs @

® Add Existed Motion Module

To add an existed motion module project file (*.ppm) or (*.isp), right-click Motion Module in the Project
section and select Add Existed Motion Module from the quick menu.

B MWCONFIG
= @ Froject [CAEX_PMEX_PM.isp]
&% Device Comment & Used Device
& HWCONFIG

Hew Motion Modale
&, DuT | AddExisted Motion Modle ||

EP Global Symb
B Proorams
B> Function Blocl @

& Device Maonitar
+--T8 APls

Choose the added motion module project based on file name and type in the Open Project window,
then click Open. The slot number is set as undefined.
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T AHCPUS30-EN (EX_P)
= ul i otion Module
&H10PM-54 Rack1 Slot0 [CIEX_PMIPM_0ppm
| AH10PM-62 RackUndefined SlotUndefined [CEX_PMAHTOPM_PRJ.ppm] |
[ Tasks

. DUT

EP Global Symhols

When adding a PMSoft project, the file is copied to the path concerning ISPSoft projects, while the
original PMSoft project is saved in the former path. The file format used in PMSoft version 2.05 or
above is applied to the added PMSoft project, but does not apply to DVP-PM projects; when adding an
ISP project file, a file is created and copied to the path concerning ISPSoft projects.

® Change Slot Number

If users want to change the slot and rack number in a motion module project, right-click the selected
project and choose Change Slot No. from the quick menu.

Ha MAWCONFIG
= [E Froject [CAEX_PMIEX_PM.isp]
£} Device Comment & Used Device
& HWCONFIG
B CARD Utility
T AHCPUS30-EN (EX_Phi)
= [ Motion Module
AHTOPM-54 Rack Siot0 [CAEX PP 0 pom
AHT0PM-5A RacklUndefined SlotUndefined (G Sy i
@ Tasks \ Hew Motion Module
B DUT 444 Existed Motion Module
EP Global Symbols @ Remmove Motion Module
i Programs

B Function Blocks || Change Slot Ho. ||

€ Device Monitar Table V\ '
+ m APls @

Select the Rack No. and Slot No. from the drop-down list. Please do not select a slot number which is
already occupied, then click OK.
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File Hame Type

RackNo. “. Sat No.

B MWCONFIG
= (& Project [CIEX_PMEX_PM.isp]

£ Device Comment & Used Device
&4 HWCONFIG
B CARD Utility
T AHCPUS30-EN (EX_Ph)
= f] Motion Module
AH'IDF'M 54 Rack:l Slotl [COEX_PMPR_ IJ Bpm

=) Tasks ]

B DUT

EP Global Symbols

i Programs

g5 Function Blocks

& Device Monitor Table
+- T APls

2.3 Basic Configuration

2.3.1 System and Environment

Select Tools and choose Language from the drop-down list.

Tools | Window Help

-.:I‘i Compmnication Settings...
2 Changs PLC Type...
Program Settings ]
[] setrTC
\a Export 3

Import ]

Langnage |English | Chiness [Simplifisd)
Chinese (Traditional’

Optioms...

Users can click Options in the Tools menu and choose desired settings from corresponding tabs at the
top or listed on the left side of the window.

2-31



ISPSoft User Manual

Tools | Window Help
Communication Settings.

Change PLC Type...

il =

Program Settings }

5]

Set RTC
Review Error Log Filz

Language English

| Options...

£

Y@

General %

Project Setting ] Workspace | Output Window | Sjlmbol Table |

Praject Setting
‘Workzpace
Output Window
Spmbal T able

Editor S

[LADDER]FED]
[5FC]

ILYST]

[CFC)

rISPSoft Startin

v| Open the Previous Project

reate Backup File( bak)————
v| Enable

rAuto Save Project
v| Save Time Interval 30 w| Minutes
3 -

Backup File Number

Auto-save before Compiling

rCompiler

Allow first character of a symbol in number
Old Vaniable Array Compiling

Default

OK | Close

® System Configuration - Project Setting

Project Setting | Workspace | Output Window | Symbot Table |

rISPSoft Startin,

v| Open the Previous Project

reate Backup File(bak)————

@ Open the Previous Project: When starting ISPSoft, the system will automatically open the
previous project that was last edited and not closed.

rAuto Save Project
v| Save Time Interval 30w | Minutes
Baclkup File Number

5 -

Auto-save before Compiling

Compiler

Allow first character of a symbol in number

0Old Variable Array Compiling

@ Create Backup File & Enable: Creates a backup file when saving.

© Save Time Interval: The system automatically saves the project files according to the selected
Minutes from the drop-down list in the Auto Save Project section. Next, users can choose the
maximum Backup File Number. If the auto-saved files exceeds the maximum backup number, the
earliest saved files will be replaced by the backup files accordingly; if ISPSoft is not closed properly
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and a project file is opened, users will be asked if the last backup file of that project need to be
loaded in or not.

Auto-save before Compiling: Auto-save the edited project file before compiling.

@ Allow the same address in symbol table: Allow different symbol variables to assign the same
address.

Allow first character of a symbol in number: Allow the first character of a symbol variable to be
a number.

Old Variable Array Compiling: Supports variable array compiling of previous version.
*Functions may vary based on different PLC models.

® System Configuration - Workspace

Project Setting  ¥Wotkspace lOutput Wi.ndow] Symbol Takle l

oerh
Previe

Text

= E Project i
& Device Corraent List I Ty 0 Tines New Roman =
B Used Dievice Report Font Color I - |—0
+- T PLC 1
@) Tesks Fomnt Bize ? e
EP Global Symbols Font Style Regular hd
B Prograres
o Function Blocks rBackground
. T8 AFls
il o
+0

~—©

@ Setup Text related contents i.e. font type, color, size and style.
@ Setup a background color for Workspace.
© A preview of the modification.

® System Configuration - Output Window

Project Setting l Workspace Output Window l Symbol Table

=1y Programe=: Bodsy
+0
0 warning
T ext:
Faont Type T Times New Roman -
Font Color _ v o
0
Font Bize 9 &
Font Style Regular -
rBackground:
Color B
+—©

© A preview of the modification.
@ Setup output text.
© Setup a background color for Output.
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® System Configuration - Symbol Table

Project Setting ] Wotkspace ] Output Window Symbol Table

rPresie
lobal Symbal i‘
o > Class Identifiers  Address Type... Initial Comment...
YAR start =0 TRUE Comment area J
rtem rText
@—) + Band Font Type hd
Header
Font Color _ S s
Content
Font Size 9 hd
@\b v| Auto-close 'Add Symbol Dialog
9—»« Auto-leading "4 dd Symbol Dislog | FontStyle Regular h
v Paste symbol with comment Background
@/yv SymbolfA ddress mode switch Cailtase — Joeo

/v v| Show auto comgplete list

L7

© A preview of the modification.

@ Select an item in the left Item box, then choose the style of display in the right Text box.
© The dialog Add Symbol configuration will close automatically once it is declared.

@ Input undefined symbol variables in ladder diagram (LD), function block diagram (FBD), or a

sequential function chart (SFC) environment, click [Enter] when complete and the dialog Add
Symbol configuration appears.

€N Copy or paste from symbpol tables, select to include comment.
© wh te f bol tabl lect to includ t

elect = rom the icon toolbar to switc etween sympol or ress mode.
@ Select EF from th toolbar to switch bet Symbol or Add d

@ Input symbol variables in the program and a list of created variables are shown. To select, users
can use the mouse or the up and down arrow keys on the keyboard. (See below)

Metwark 1

warl

Metwork 1

Metwork 1

(NI ORIV]
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® Configuration Editor - LADDER and FBD

[LADDER] (FED] | (sFc] | OLIsT] | [CFCI |

Preview rtem:
Hetwork 1 Lahel:
Flace comment over here Hetwork Number
N Hetwork Label
@ Comment i o
Identifier Text

Operand Text
Box Text

A

rBatner Color

rahow Symbol Hint:

Type Normal - v| Comment
9 v| [dentifier
Color clhloneyCreen S — 9

v Device Name

A

v Class

v| Type

rCompotient Width
y; !

_T_
@

© Select an item for setup.
@ A preview of the modification.
© Select a display type and color.

® In Ladder and FBD programming editor section, users can choose from the ‘Show Symbol Hint’
box to display selected hints of the device or symbol variable pointed by the mouse cursor.
© Set the Ladder and FBD component width in the box. The setup will affect the word length in FBD

programming.

® Configuration Editor - SFC

[LADDER] [FED] [3FC] ] mET) |

Previewr e
STEFP Font
NEW STEP TEANSITION Font
@ Tratis~
+O0
T ext:
Font Type T Times New Roman -
Font Color -
A—
Font Size 10 -
Font Style Regular -

© Select an item for setup.
@ Based on the selected item, select the Text box for display.

© A preview of the modification.

® Configuration Editor - IL and ST
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[LADDER] [FBD]] [BFC] [LI[ET] '| [CFC]]

Preview rltem:
PLIRRR NI lectedColor|
0002 ADD | Edit Text Style
ooos input = 2227 OperatorColor
0004 FE/Function Color
@ —> 0005 CAL wyFEB({ [*comment#) Comment Color <
000e& input := 27777 Erpual Bymbol (=) Color
ooa7 output => wvarl Active Line Color
ooog | Background Color
¢ IS Selected Color
tter Setting
Start Color clWhite S
End Color 11258315 ol
A— .
Leading Zero v| Bhow Leading Zero
Lines Humber  |v| Show Lines Number
© Select an item for setup.
@ Based on the selected item, select the Text box for display.
© A preview of the modification.
® Configuration Editor - CFC
[LADDER] [FED] | [8FC] | ML]BT] [CFC]
Previewr rltem
ClobalW ar
FE
©0—
Default — — LocalVar <|_0
olot Setting
Default Color: - w

@ | Global Variable cotor | ~ -
Local Variable Color:

© Select an item for setup.
@ Based on the selected item, select the Color Setting for display.

© A preview of the modification.

By clicking Default, all settings are restored to defaults. When modification for all setups are complete,
click OK.
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|  General A Project Setting | Workspace | Output Window | Symbol Table |
Project Sefting rISPSoft Startin, ’-C:eate Backup File( bak)————
Wieikepees v| Open the Previous Project | Enable
Output WWindow ~Auto Save Project

| St Vet v Save Time Inferval 30w | Minutes

? Editor * Baclkup File Number i -

I [LADDERTFED] Auto-save before Compiling
[5FC) rCompiler

| [ILIST]
[CFE] Allow first character of a symbol in number

Old Variable Aray Compiling

< Default P ‘) Cloze |

*. When several windows are opened in ISPSoft, each window provides a different setting. However, the software only
remembers the environment setting of the last window closed, so it will automatically apply that setup once
re-started.

2.3.2 Importing and Exporting User Preference

Users can export and import their preference concerning environment settings through ISPSoft.

® Export User Preference

Choose Export from the File menu and select Preferences. Input file name to export from the pop-up
window and click Save.

Fil: | Edit Tiew Compile

Hewr 3
Z Open Ctrl+0
E& Clase Project
Save Ctzl+S
TR] saveds Crledltss
& Pt Chil+P
Project Print
& Prnter Setup
E FProgram Comparison  # @
|\a Export P| Programs. .
2] Impert 3 Function Blocks...
Exit @ Global Symhals...
} Praferences ||

® Import User Preference

Choose Import from the File menu and click Preferences. Select a file for import from the pop-up
window and click Open.
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File | Edit Wiew Compile

Menar 3
& Open Chl+ G
[% Close Project
Save Crl+S
T3 saveds Ctebedliss
& Prmt Ctil+P

Project Print

Printer fetap

Program Comparison b e

Export » \

Import 3 | Programs... O

Function Blocks...

) M e

Egxit Al+E

User Defined Library. ..
@ Global Symbals...

Preferences

Additional remark

Since environment parameters may vary based on different ISPSoft versions, not all import preferences
may be applicable. Users need to check the imported Preference file (*.pfs) to make sure the contents is
desired if unsure which ISPSoft version it is exported from.

2.4 Communication Settings

The following picture shows a communication structure between ISPSoft and a Delta PLC. Unlike
previous ways of connection, the ISPSoft uses Communication Manager- COMMGR as the
communication interface. The section explains how to build communication between ISPSoft and PLCs
with basic tests completed.

COMMGR _|Communication| _ > PLC

ISPSoft Port <

F 3
A 4
F 3
A

*1. Please refer to section 1.2 for information about COMMGR and installation guide.
*2. For ISPSoft version 2.0 or above, COMMGR is used in the communication structure; while earlier versions adopts the
traditional ways of connection.

2.4.1 Start/Close COMMGR

COMMGR

When COMMGR is installed, its shortcut can be found in the Programs of a PC Start menu. Users need
to click the shortcut to start COMMGR only for first-time installation. Afterwards, when starting a
computer, the COMMGR is automatically started and remains in the Windows system; however, when its
icon is not shown, please click the shortcut of COMMGR listed in the Programs.
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To start COMMGR, select its icon and double-click Open or right-click the icon to open the program on
Windows PC.

[T '
‘ m Name Description State Add
Close ‘\1'!’ —
" \&/ e |
* .H V;I E:] X Delste

Language

Lo |
About

The following image is a display of the COMMGR status window. In the middle of the window contains
description of drivers established for communication. The ISPSoft assigns a driver from the description
box to form connection with PLCs; on the right are buttons for managing these drivers. For more
information, please read the next section.

Ed

Name Description State Add
EP Drv_IL_EN Ethernet, Intel(R) Ethernet Connection 1219-IM, Loce OF (START) g

o Drv_DL_USE RS232/422/485, COM3, ASCII, Protocol=9600,7.e,1, Rel 0K (STOPR)

3 Drv_DVE_SIM  DVP Sinulator, Device=EH2/SV/01d Series, Port=lODD2,  STOP Configure
P Drv_EN Ethernet, Intel(R} Ethernet Connection I219-IM, Loc: QE (START) Delste
L% Drv_Rd DirectLink USE, USE/Disk hode, Retry=3, TimeQut=3000 OF (START) Q—” -
o Drv_USB R8232/422/485, COMI1, ASCII, Protocol=0800,7,e,1, Re 0K (STOP)

anguage

d

About
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Users can close the COMMGR window by clicking or in the upper right corner, but the

program still exists in Windows; to close COMMGR completely, right-click the COMMGR icon displayed
in the system and choose Close.

2.4.2 Driver Management for COMMGR

Communication

COMMGR B Port

F 3
y

The driver in COMMGR act as a channel that connects the program and communication port. When
users add a new driver and has setup the communication parameters, the COMMGR forms a channel
connecting the assigned communication port in the driver and when the computer reboots, the
COMMGR will automatically start the driver. However, when the channel for connecting the driver is not
properly functioning, for instance, the existed network card or USB cable is removed, the COMMGR wiill
automatically stop the driver and ERROR status is displayed. Meanwhile, a small red ‘X’ appears on the
COMMGR icon of the Windows system tray. When connection restores, the status for the driver also
returns to OK.

L3y

Name Description State
£&p Drv_DL_EN Ethernet, Intel(R) Ethernet Connection [219-IM, Loce 0F ART
w3 Drv_DL_TRE USE, COM2, Retry=3, TimeQut=3000ms ERROR

1% Drv_IVP_SIM  I¥F Binulator, Device=EHZ/3¥/01d Beries, Port=10002, i

P Drv_EN Ethernet, Intel(R) Ethernet Connection [219-IM, Loce O0F (START)
E:'.u D _R3 Directlink U8B, U8B/Disk Mode, Retry=3, TimeDut=3000 CF (START)
o Drv_URE RS232/422/485, COM11, ASCID, Protocol=9600,7.e,1, Re 0K (STOPY

2.4.3 Creating Connection Channel - Add Driver

Click Add on the right side of the COMMGR window to start settings concerning communication
parameters.
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EM COMMGR - X

Name Deseription State
Configure | e
Delete |

"3-1'--'5-'-3-':- perties X

|
| Driver Name [Drivert | {
|

[-Connection Setup

I Type [Rs2321422/485 -] |

-Communication Protocol

l COM Port [cons -] |

Data Length I} vl ¢ ASCI
Parity |e -[  RTU
Stop Bits I 1 = l Auto-detect

Baud Rate Ig@o - l Default
-Setup Responding Time
Connect Retries |3 ﬁ
Connection Time-Out (Units: 100ms) |30 :I
| I
ok | [ Coneal

Quick steps to set up a driver:

(1) Driver Name Setup

Type the Driver Name in the box. Users can input maximum of 31 characters, and special marks
such as“ " but not*, #, ?,\, %, @ in the name box.

Driver Name ID‘.’I_RS

(2) Connection Setup

Select a desired connection Type from the drop-down list. The following is a list of the connection
types supported by COMMGR.

DireotLink (Ethernet)

IVF Simulator

MEx0 Simulator

MExl Simulator A
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» RS232/422/485
Uses COM Port to communicate with PLC hosts.

» USB (Virtual COM)
Some PLC hosts provides USB port, so a PC and PLC host can directly connect through USB.
However, before using this connection method, please make sure that the software for the USB
driver is installed in the computer. For more information on methods of installation, please refer to
appendix A or other PLC user manuals.

» Ethernet
Uses Ethernet to communicate with PLC hosts.

» DirectLink (USB) & DirectLink (Ethernet)
Used by Delta human-machine interfaces (HMI) for connection. Under normal connection of PLC
and HMI, a computer uses an USB or Ethernet to connect with the HMI, and indirectly builds
communication with PLC host. Please refer to Delta HMI user manuals for more information on
connection and notifications.

» DVP Simulator& AH5x0 Simulator & AH5x1 Simulator & AS300 Simulator & AS200
Simulator

Serves as virtual channels for simulators regarding all PLC types, but must use corresponding
devices for connection in the ISPSoft.

(3) Communication Protocol Setup

Setup the communication protocol based on the selected connection type. Each type of connection
has its own communication protocol setting. The following section will introduce the different types
of communication parameter settings.

Commumnication Protocol

COM Port \coMS3 ~

Data Length 7 j f« ASCH

Parity . 7]  RTU

Stop Bits | 1 j Auto-detect

Baud Rate | SE00 j Default
Setup Responding Time

Connect Fetries 3 :I

Connection Time-Out (Unitz: 100ms) 30 :I

2.4.3.1 Communication Parameter Setting - RS232/422/485
Before starting the setup of RS232/422/485 driver, make sure:

(@) The software for driver installation can be found in the computer.
(b) The PC and PLC hosts has now established connection and is functioning.
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@ > Driver Name |Driv=t1
Connection Setup
@ —p Tipe |Rs232:422/485 |
Communication Protecol
COM Port Ccon3 hd
@— ' g

Data Length 7 - + ASCH
,ﬁJ @
Parity g - " FTU
@ Stop Bits 1 - Auto-detect
Eaud Rate 2600 = Defanlt

Setup Responding Time

@ — Connect Retries 3 il
Connection Time-Out (Units: 100ms) 30 il

(1) Type the Driver Name. To add special marks, only * ' can be used .

(2) For Connection Setup, select RS232/422/485 from the drop-down list for Type.

(3) For COM Port, select the desired port for communication from the drop-down list. The list contains
complete information regarding COM Port number and device name, which is the same as in
Windows Device Manager. If (a) and (b) mentioned above is confirmed, users will be able to select
the COM Port.

COM Port |C0MS =]

Intel(E) Active Management Technology - S0L (COMZ)
ELTIMA Wirtual Serial Port (COMIL
Frolific USE-to-Serial Comm Fort [COMS)

(4) The data format for communication is ASCIl or RTU.

(5) The communication protocol setting of the COM Port is the same as its connected device. When
Default is clicked, the communication protocol parameters returns to defaults.
If not sure about the communication protocol of the connected device, click Auto-detect to find out
the parameter. When detection is successful, users can connect the device to a RS232
communication port selected with a RS232 cable, and click to automatically detect the
communication protocol. If the communication protocol is successfully detected, its parameters will
be automatically filled in the corresponding boxes in the section; however, the system will not
auto-detect parameters for COM Port and ASCIl / RTU, therefore, please confirm these two
parameters before clicking auto-detect.

(6) To setup parameters concerning responding time. For Connect Retries, users need to setup the
number of retry once connection error occurs, while for Connection Time-Out setting, the
parameter concerns the time interval between retries.

*. When changing a hardware device connected to a PC, users need to close the setting page concerning communication
driver properties and re-start in order to obtain the new hardware communication device.

2.4.3.2 Communication Parameter Setting - USB (Virtual COM)

Before starting the setup of USB type drivers, make sure:

(a) The software for driver installation can be found in the computer.
(b) The PC and PLC hosts has now established connection and is functioning.
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@ — Driver Name Drv_USB
Connection Setup
@ — Type |USB (Virtual CQpL x

Delta FLC (COMS) d|
elta PLC |

Telta

Communication Port

COM Port
O—

Setup Responding Time
Connect Retries 3 jl
@ — P Connection Time-Cut (Units: 100ms) 0

(1) Type the Driver Name. To add special marks, only * ' can be used.
(2) For Connection Setup, select USB (Virtual COM) from the drop-down list for Type.

(3) For COM Port, select the desired port for communication from the drop-down list. If (a) and (b)
mentioned above is confirmed, the list will display the host device name and COM Port number.

(4) To setup parameters concerning responding time. For Connect Retries, users need to setup the
number of retry once connection error occurs, while for Connection Time-Out setting, the
parameter concerns the time interval between retries.

*. For more information regarding USB drivers in PLC hosts, please refer to appendix A .

2.4.3.3 Communication Parameter Setting - DirectLink (USB)

@ % Driver Name Drv_DL_USB
Connection Setup

@ —  Type | DirectLink (USB) |
HMI USE Mede

{+ USB / Disk Mode
~ CDC Mode
@O—

Setup Responding Time

Connect Retries 3 i‘
@ Connection Time-Out (Units: 100ms) 3 4

(1) Type the Driver Name. To add special marks, only * ' can be used.

(2) For Connection Setup, select DirectLink (USB) from the drop-down list for Type.

(3) Choose from the HMI USB Mode. When selecting CDC Mode, choose the desired COM Port from
the drop-down list. For more methods regarding connection, please refer to Delta HMI user
manuals.

(4) To setup parameters concerning responding time. For Connect Retries, users need to setup the
number of retry once connection error occurs, while for Connection Time-Out setting, the
parameter concerns the time interval between retries.
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2.4.3.4 Communication Parameter Setting - Ethernet

@ — Driver Name Drv_EN
Connection Setup
@ — Type |Eth3m=l j
Ethernet Card
Description | Intel(R) Ethernet Connection 1219-LM |
@ 192.168.2.93
IP Address Setting
a¢ | Deete | Search
IP Address Port Label Type
192.168.2.56 302 Main Controller AHCPUS3(0-EN
@ > 192.168.2.40 302 CMC-EIPO1 CMC-EIP01
192.168.2.211 302 DVP32ES2-E ES2-E
192.168.2.210 502 DVPI2SE SE
Setup Responding Time
Connect Retries 3 il
@ ——P Connection Time-Crut (Units: 100ms) 30 il

(1) Type the Driver Name. To add special marks, only ‘' can be used.
(2) For Connection Setup, select Ethernet from the drop-down list for Type.

(3) For Ethernet Card, select the desired network card from the drop-down list. The current IP address
is shown below the description.

(4) Inthe IP Address Setting, setup the communication device IP address and name.
» Click Search and the result for devices in the same network are shown in the box.
» Click Add for a new IP address and input information regarding each cell.

© IP address: The device IP address.
@ Port: Used during communication, default setting is 502.
©) Label: The name of the device.

@ Type: The device model type that can be found through clicking Search.
» Select an IP address and click Del or press Delete on the keyboard to remove it from the list.

(5) To setup parameters concerning responding time. For Connect Retries, users need to setup the
number of retry once connection error occurs, while for Connection Time-Out setting, the
parameter concerns the time interval between retries.

*. When changing an internet device connected to a PC, users need to close the setting page concerning communication
driver properties and re-start in order to obtain the new internet device.
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2.4.3.5 Communication Parameter Setting - DirectLink (Ethernet)

@ — Driver Name Drv_DL_EN
Connection Setup
@ —>  Tpe |DirectLink (Ethernst) -
Ethernet Card
@ Description | ntel(R) Ethernet Connection 1218-LM ~|
192.168.2.95
TP Address Setting
Add | Delete | Search
IP Address Port Labal Type

192.168.2.220 302 HMI 1

@—

Setup Responding Time

Connect Retries 3 :I
@—} Connection Time-Out (Units: 100ms) 30 :l

(1) Type the Driver Name. To add special marks, only * ' can be used.
(2) For Connection Setup, select DirectLink (Ethernet) from the drop-down list for Type.

(3) For Ethernet Card, select the desired network card from the drop-down list. The current IP address
is shown below the description.

(4) Inthe IP Address Setting, setup the communication device IP address and name.
» Click Search and the result for devices in the same network are shown in the box.
» Click Add for a new IP address and input information regarding each cell.

© P address: The device IP address.
@ Port: Used during communication, default setting is 502.
© Label: The name of the device.
@ Type: The device model type that can be found through clicking Search.
> Select an IP address and click Del or press Delete on the keyboard to remove it from the list.

(5) To setup parameters concerning responding time. For Connect Retries, users need to setup the
number of retry once connection error occurs, while for Connection Time-Out setting, the
parameter concerns the time interval between retries.

*. When changing an internet device connected to a PC, users need to close the setting page concerning communication
driver properties and re-start in order to obtain the new internet device.
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2.4.3.6 Communication Parameter Setting - DVP Simulator

(1) Type the Driver Name. To add special marks, only ‘_’ can be used.
(2) For Connection Setup, select DVP Simulator from the drop-down list for Type.
(3) Input assigned Port Number.

(4) For Device Setting, DVP simulators include EH2/SV/OId Series, EH3/ EH3-L/SV2, ES2/
EX2/SA2/SX2/MC, SE and SS2.

(5) To setup parameters concerning responding time. For Connect Retries, users need to setup the
number of retry once connection error occurs, while for Connection Time-Out setting, the
parameter concerns the time interval between retries.

* When ES, SS, EX, VFD, EC devices download the DVP simulator, these devices will change to EH device once uploaded.
*. Regarding TP devices, please select SS2 series as simulator.

2.4.3.7 Communication Parameter Setting - AH5x0 & AH5x1 Simulator

@ — Driver Name |Drv_AH_SIM
Connection Setup
@ —>  Type | AF15%0 Simulator ~|
Simulator
@ —»  Port Number 10003 =
Setup Responding Time
Connect Retries 3 jl
@ —»  Connection Time-Out (Units: 100ms) 0 =

(1) Type the Driver Name. To add special marks, only * ' can be used.

(2) For Connection Setup, select AH5x0 Simulator or AH5x1 Simulator from the drop-down list for
Type.

(3) Input assigned Port Number.

(4) To setup parameters concerning responding time. For Connect Retries, users need to setup the

number of retry once connection error occurs, while for Connection Time-Out setting, the
parameter concerns the time interval between retries.
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2.4.3.8 Communication Parameter Setting - AS Simulator

@ —— Driver Name |Drv_AS_SIM

Connection Setup

@ —> Type | A5300 Simulator ~]
Simmlator
@ —  Port Nomber 10003

@ Setup Responding Time
Time of Auto-retry 3 i‘

Time Interval of Auto-retry ( 100 ms ) 0 o

(1) Type the Driver Name. To add special marks, only ‘' can be used.

(2) For Connection Setup, select AS200 Simulator or AS300 Simulator from the drop-down list for
Type.

(3) Input assigned Port Number.

(4) To setup parameters concerning responding time. For Connect Retries, users need to setup the
number of retry once connection error occurs, while for Connection Time-Out setting, the
parameter concerns the time interval between retries.

Additional remark
(&) To use simulator functions, we suggest using ISPSoft V3.05 or later versions.

(b) When using simulators, users need to be aware that they do not support all functions and
commands.

2.4.4 Creating Connection Channel - Start/Stop a Driver

For USB driver, users do not need to operate because COMMGR will auto-detect for the connection
when a device is properly connected to a PC.

EH COMMGR - X
Name Description L
=+ Drv_USB USB, COMBS, Retry=3, TimeOut=3000ms @ —
/" \ Configure
Delete
OK(START) o]

Status Auto-detected GU

ERROR

About |

Users must enable a simulator first to start execution. By choosing the desired simulator driver from the
list in the COMMGR window and click Start button on the right, you will see START shown in the State
column if the simulator driver is successfully enabled.
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B CC SR -
| Name Description State |

Add...
%= Drv DVP_SIM DVP Simulater, Device=EH2/$V/Old Serizs, Port=10003 —
| \ Configure
: STOP

@

START

To stop a driver, select the desired driver on the list in COMMGR window and click Stop button on the
right, you will see STOP shown in the State column if the simulator drive is stopped.

EH CC 5F —
Name Description State
% Drv DVP_SIM DVP Simulator, Device=EH/SV/OId Series, Port=10003, Retry @

\O/ START
A %4

STOP

2.4.5 Creating Connection Channel - Configure/Delete a Driver

To modify the parameter of a particular driver, please click Configure button on the right or double-click
the selected driver to open a setup window for modification.
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L3
Name Description State
&P Drv_IL_EN Ethernet, Intel(R) Ethernet Conmection I219-LM, Loc: 0K (START)
o Drv_DL_USE RS232/422/485, COM3, ASCIL, Protocol=9600.7.e.1, Rel O {STOR)
2 Ty _IVP_SIM  IVP Simulator, Device=EH2/8V/01d Beries, Port=10002, STOF
@ Tirv_EM Ethernet, Intel{R) Ethernet Commection I219-IM, Loce QK (3TART)
I_:l'_“,’:I Drv RS Directlink USE, USB/Disk Mode, Retry=3, TimeOut=300C OF (START)
I]] o Drv TSR RS232/422/485, COM11, ASCII, Protocol=9600,7.e.1, Re O (STOR)
L1
Name Deseription State
@ Drw _DL_EN Ethernet, Intel{R) Ethernet Connection IZ219-IM, Loce QK (3TART)
o Drv_DL_USE RE232/422/485, COM3, 83CII, Protocol=9600.7.e.1, Rel 0O (STOP)
£ Drv_IVP_SIM  DVP Simulator, Device=EH2/3V/01d Reries, Port=10002, STOP
&P Drv_EN Ethernet, Intel(R) Ethernet Connection I219-LM, Leoc: 0K (START)
E'i Drw R3 Directlink USB, USB/Disk Mode, Retry=3, TimeOut=300C 0K (3TART)
o Drv_TRE RE232/422/485, COM11, ASCII, Protocol=9600,7.e,1, Re O (STOP)

ER
Name Description State
@ Drw_DL_EN Ethernet, Intel{R) Ethernet Connection IZ219-IM, Loce OF (START)
o Drv_DL_USE RE232/422/485, COM3, A3CII, Protocol=9600,7.e,1, Rel O (3TOP)
£ Drv_IVP_SIM  DVP Sinulator, Dewice=EH2/3¥/01d Series, Port=10002, STOP
&P Drv_EN Ethernet, Intel(R) Ethernet Connection IZ219-LM, Loce 0K (START)
g'j; Drw_RE Directlink USB, USB/Disk Mode, Retry=3, TimeOut=3000 OF (START)
I]] o Drv_TRE REZ232/422/485, COM11, ASCII, Protocol=9600,7,e,1, Re O (3TOP)

Add...
Configure

Delete

Language

About

d

To delete a driver, select the desired driver and click Delete button on the right or press DEL on the
keyboard for removal.
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2.4.6 Creating Connection Channel - Simulator with Operating
Panels

When the state of a simulator shows START, an operating panel (see below) pops-up to demonstrate the

current states of AH5x0 and AH5x1 simulators and provide STOP or RUN mode for users to control.

The 10 Module button of a simulator can open an IO module panel. However, modules must be
configured in HWCONFIG and please refer to section 3.8.4 for parameter download to hosts.

Information: Rack 1

Slot No Label MDS Version Desciption Input Device Range | Output Device Range Comment
AHPS03-3A - AH Power Supply Module None None
- AHCPUI30-EN 01.00.00 Basic CPU module building with Ethernet, ES4 None None
0 AHI6APIIP-SA - 2xDIVDC, 8 x DO PNP VDC X0.0~X0.13 Y0.0~Y0.15
1 AHOSXA-SA 01.00.00 4x 16 bit AL 2 x 16bit AO D0~ D7 D§-~Dit
2 AHOPT-3A 01.00.00 4 x 3/4 wires RTD input 0.1 degree Celsius/0.1 { D12 ~ D19

Users can switch to RUN mode and view the same HWCONFIG module configuration and state on 10
module panel.

@ ah5x0 — K
AH5X0 Series
RESET ()

5 Input & Output Module Information =]
Module Type Rack ID Slot ID Register 0 2 3 5 8 9 2 3 . 5

X .
AP1IR 1 0 o

[A] 0.2 03 04 05 0.6 0.7 0.8
2 4

0QODE+00  0.000E+00

O RUN 10 Module

our # 0
0.000E +00 --- 0000 +00 --- [ 0.000E +00 --- J0.000E +00 ---
w 12 " %

The following chart demonstrates the digital input and output registers area. The Y device offers only
output status but cannot perform any operation; while X device offers users to click and change the
ON/OFF status of each contact for external input simulation.

The following chart shows analog input and output registers area. Each column requires 32-bit floating-
point format and corresponds to every channel of the actual module; for D8 and D10 (see below)
corresponds to analog output channel - D device, the output are for viewing only; while DO, D2, D4 and

D6 corresponds to analog input channel - D device. Users can click """/ to open the setup window (see
below) for analog input value.
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1.220E+02 --- | W0.000E +00 -

0.000E+00 0.000E+00

Analogy Input Value *

&+ Constant Value i

" Random ’7

" Sine Wave ’7

" Sguare Wave ’7

" Trangle \Wave ’7

oK

Signal Type Description
Constant A constant signal with fixed value.
Random To assign the maximum and minimum value of random signal.
Sine Wave To assign the maximum or minimum value and signal cycle of sine wave.

To assign the maximum or minimum value, ON and OFF times of cyclic

Square Wave
square wave.

Triangle Wave To assign the maximum or minimum value and signal cycle of triangle wave.

When setting is complete, the column (channel) will continue to send data to COMMGR based on the
signal mode setup. While ISPSoft can conduct related tests when capturing simulator signals through

COMMGR.

0.000E+00 == F+
2 > En

3.286E-42 DE=3.230E+0 51

]

| D=1 135E+1
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Users can right-click the 10 module panel and select Show All IO Module to display all modules. To hide
the modules, click IO Module Visible Settings and choose the module to hide from the list of module
types then click OK. You will be able to view the current state on the right bottom corner of the window.

(See below)
@ Input & Output Module Information — ﬂ

16AP1T1R

ot 00 01 02 03 04 06 07T 08 08
1.230E+00 --- [0.000E +00 0.000E+00 --- 19, 230E+00
w0 z 4 [ 4

0.2 0 05
o 0.5

0.000E+00 0.000E+00

ouT

0.000E+00 -+~ 0.000F +00 --- [W0.000E +00 -« W0.000E+00 -

Visible Modu

10 Module Visible Settings s
[~ Select Al
Vizible Rack ID Slat ID Module Type
v 1 0 1BAP11R
Il
v 1 2 04PT

@ Input & Output Module Information o ﬁ

16AP11R

[ 0.5

our 00 01 02 03 04 0 06 07 08
D DDDE+UD DDDE+DD o DDDE+UD DDUE+DD -
w12 3 8

Visible Module

The AH5x0 and AH5x1 simulators also provides backup function which combines parameters and
program backup into an *.asdup file then use this file and restore in other identical simulators. (See

below)
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A=

Restore ¢ .l‘!\.H.EIE-Dl up

. ¢ Backup
s
@ About

2.4.7 Creating Connection between ISPSoft and COMMGR

AH.asdup

Communication PLC

COMMGR > Port

ISPSoft

r 3
\ 4
F 3

y

When a driver is created and also enabled in COMMGR, users can assign the driver and use it in ISPSoft.
After the setting is complete, a connection between ISPSoft and COMMGR is formed. For single project
setup, each requires an assigned communication, thus, under the structure of group project, users must
open each single project and complete the setups.

(1) First, please enable the desired project for communication setup, but if under a single project
structure, you can skip this step.

6

(2) Choose Communication Settings from Tools menu in ISPSoft and its setting window will appear.

Tools | Window  Help Driver Drv RS
. b

Yy

1 (i Cormnmmication Settings... |

Changz PLC Type... V\ Station Address (0
Program Settings 2 ¢ P Address

et RTC

=

Review Envor Log File
Language Enghsh v

Options...
0K Close
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When AH5x0 series is selected as the connection target for group project, the option Routing Mode is
added and used together with NWCONFIG. Please refer to chapter 19 for more information.

®)

(4)

Communication Setting *
Driver Drv_RS v
Station Address
IP Address | |

rConnection Target
(%) AHCPU Rackl  ¥| [Slt0  ¥|
i Motion Controller
[ ] Routing Mode
First Station | -
0K | Close |

Select the desired Driver from the drop-down list in Communication Setting window.

Communication Settin

(]

x

Driver Drv RS

Station Address

i~
L

onnection Target

Motion Controller

oK |

Select the PLC station address from the drop-down list that is to connect with the PC or choose 0

for station address (broadcast).

Communication Setting >
Driver |Dn'_R.S v|
Station Address
IP Address 5 -]
I £ N/

Connection Targe|g
@AHCPU 2 v| [sioto ]
1 Motion CDT‘I[TC? hd

4

OK Close |
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(5) When driver type is Ethernet or DirectLink (Ethernet), users can select the desired IP Address to
connect with PLC hosts from the drop-down list.

Dnver Drv_EN -
Station Address |0 -

IP Address 192.168.2.40 h

192.168.2210
1921682204
192.168.2202
192.1682211
192.168.2.203
192.1682201
192.168.2.36 &

(6) Click OK once all settings are complete. Meanwhile, the current connected driver information will
appear in the ISPSoft status bar.

v [ Errors
v [ Warning
<
Compile Message | Find Result
Insert  MNetwork: 2 BA262128 Steps Div_EM, [Ethetnet] AHCPUS30-EN

e

Additional remark
If COMMGR setting is modified, then communication settings in ISPSoft must be re-selected for proper
connection.

2.4.8 Connecting PLC (Host) and Communication Port

COMMGR _|Communication|

Port N PLC

ISPSoft

F 3
A 4
»
Y

A

Users can use communication cables to connect PLC hosts and assigned communication ports. The
following introduces most commonly used connections and useful notes. For more details, please refer to
any types of PLC user manuals.

1. DVP series PLC (RS232)
Adopts Delta communication cable to connect a computer with a PLC host. Select RS232 for
COMMGR driver type.
Note: Before connecting, please confirm that the setups in COMMGR drive concerning RS232
parameters is the same as in PLC hosts.
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2. DVP-SX2 series PLC (USB)
A DVP-SX2 series PLC provides a type B mini USB interface. Users can use the USB cable to
connect a PLC host with a computer. However, since the USB framework in SX2 series contains USB
converting to RS232 (circuit built-in), therefore, the internal function adopts RS232 mode and is also
selected as the COMMGR driver type.

Note:
(a) Please confirm that the USB driver is properly installed in SX2 series. For more details, please
refer to Appendix A.

(b) Before connecting, please confirm that the setups in COMMGR drive concerning RS232
parameters is the same as in PLC hosts.

3. AH/AS series PLC (USB)
Adopts USB cable to connect a computer with a PLC host. The USB port of the host is a type B mini
USB. Select USB (Virtual COM) for COMMGR driver type.

Note: Please confirm that the USB driver is properly installed in AH/AS series. For more information,
please refer to Appendix A.

4. AH series PLC (RS232/422/485)

The COM port for AH series PLC host is a standard type, therefore, please use RS232 communication
of RX and TX lines or an adapter that has jumper function to proceed the connection with a computer.
Please select RS232/422/485 for COMMGR driver type.

Note:
(a) Before connecting, please confirm that the setups in COMMGR drive concerning RS232 parameters
is the same as in PLC hosts.

(b) The COM interface of AH series provides many modes including RS232/RS485/RS422. Before
connecting, please confirm that current desired mode is correct. (Please refer to follow-up
comments.)

5. AH/AS series PLC, DVPxxMC and DVP-SE (Ethernet)

The AHCPU5xx-EN, AHXXEMC, AS series, DVPxxMC and DVP-SE series PLC hosts contain built-in
RJ-45 port (Ethernet) and can connect with a PC through Ethernet. A PC can also connect with a PLC
host to the same domain through the hub or uses direct network cable for connection. Please choose
Ethernet for COMMGR driver type.

Note:
(a) Before connecting, please check the structure of the internet is properly functioning.
(b) Check the accuracy of the Ethernet parameter in host CPU. Please refer to follow-up comments
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Additional remark
For communication parameter defaults regarding all PLC types, please refer to related user manuals.

2.4.9 Practical Connection Test

When all the steps mentioned above are completed, users can conduct a simple test to check on the
connection with a PLC host is properly functioning.

COMMGR > Communication < > PLC

ISPSoft Port

A
\ 4
A

Before connecting, please check on the following:

(@) A PLC host and PC is properly connected through communication cable, while the host power is
turned on and well-functioning.

(b) Provides communication device including PC network cards, internet hub and serial port is properly
functioning.

(c) To use the desired COMMGR driver, please check related parameters to be correct and the driver
state is OK.

(d) Please check the assigned driver, station number and IP address in Communication Setting for
ISPSoft is correct.

After confirming the list above, please select System Information (I) from PLC menu and a pop-up
window will appear. However, if the pop-up window concerning system information did not appear, this
means connection failure, users will need to check the above list (a) to (d) again.
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Tools Window Help

System Security
Run

Stop

Online Mode

Cil+F11
Cul+F12

Ctl+F4

New Devices Table

Edit Register Memory

Edit Bit Memory

Format PLC Memory...

Svystem Log

System Information...  Ctr+Alt+T

N
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MEMO
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Users can adopt ISPSoft built-in functions or tools to execute system configuration and parameter
settings for PLC hosts. This chapter will introduce the steps and setups concerning configuration
and parameter settings.

3.1 Parameter Setting for DVP Series PLC

*. The old DVP series do not support HWCONFIG; however, the new DVP-ES3 supports HWCONFIG. Regarding
parameter setting for DVP-ESS3, please refer to section 3.1.4.

3.1.1 System Management Tools for DVP Series PLC

In the project for DVP series, users can find system management tools under the category of the
PLC hosts name where some of the functions need to connect with the host for operation. The
functions are described in the following:

® Retentive Range: Set the PLC retentive device range.
® Device Resource Allocation: Set the device range for auto-configuring symbol variables.
® Connected Information: View the current PLC host system setting and parameters.

Apart from Device Resource Allocation function to be introduced in section 6.2.11, the Retentive
Range and Connected Information function will be explained in the following sections.

3.1.2 Retentive Range

(1) Double-click the Retentive Range and its setting window will appear.

X

Retentive Range

Retentive Range
The specified memory range will retain data through a power eyele,

BlockO Block

Range 500 2| |oow . Clear ook

L ]

—

SetinPLC | ReadfomPLC|  Default | oK | Cancsl

3-4



Chapter 3 PLC System Configuration & Settings

(2) Click on a desired device type for setup.
Retentive Range E'
Retentive Range
The specified memory range will retain data through a power cycle.
D
Elack
<. low z Clear ”
[ —_——
SetinPLC | ReadfiomPLC|  Default | 0K | cama |
(3) Since the range for PLC retentive block may be discontinuous, therefore, please first select the
desired setting section.
Retentive Range E'
Retentive Range
The specified memory range will retain data through a power cycle.
T @ ] D
Elock0 Elock
Range 500 <] looo : Clear -
[ —_——
|
Setin PLC | ReadfromPLC| Default | oK | Cancel |
(4) Users will see a strip graph in the block section, with two values on both ends representing the

setting range limit. The orange color in the strip graph refers to the existed retentive range;
however, when the Block 0 section shows grey content, this means the current section cannot
setup retentive range for the selected PLC model.

For the setup, users need to input values of the Retentive Range, where the beginning point
is the value on the left box and the end point is the value on the right box. When input values,
the beginning point on the left must be smaller than the end point on the right and cannot
exceed the strip graph appearing as the range limit.

X

Retentive Range

Retentive Range
The specified memory range will retain data through a power cyele.

Block:

Block0

500 I -

Range

Block 1

Clear

SetinPLC | ReadfromPLG|  Default | 0K | Cancel
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(5) Click Clear to remove the retentive function for the devices in that block and the range values
will be from -1 to -1.
Retentive Range ['5__<|
Retentive Range
The specified memory range will retain data through a power cycle.
T T o g D
Block0
|Range -1 = "o =
D v
[
SetinPLC | ReadfiomPLC|  Defuit |
(6) Click Default for settings to return to default values and the retentive function for all devices
will return to defaults.
Retentive Range ['5__<|
Retentive Range
The specified memory range will retain data through a power cycle.
T T o g D
Block 0 Block
R 500 =] oo z Clear ”
D v
[
SetinPLC | Read fromP | Concel
(7) When ISPSoft is connected to a PLC host, click Read from PLC to read the retentive setups

on all devices from the PLC host.

Retentive Range

Retentive Range
The specified memory range will retain data through a power cycle.

3

T c 3 D
Block0 Plock
- = BlockD
Range 500 P ] Clear Elock 1

Cancel
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(8) When all setting is complete and ISPSoft is in connection with a PLC host, click Set in PLC to
write the retentive settings for all devices into PLC hosts. Meanwhile, the system will
automatically close the setting window and the setups are stored, but it will be saved once an
ISPSoft project is saved.

Retentive Range FS__<|
Retentive Range
The specified memory range will retain data through a power cycle.
T c 3 D
Block
Rz 500 <. lows z Clear ”
ok | cancel
(9) When setting values are not required temporarily, click OK to apply the setting. The setup is

saved once an ISPSoft project is saved.

X

Retentive Range

Retentive Range
The specified memory range will retain data through a power cycle.

M T c =] D

Block0

rBlock

Range 500 :

Block 1

[ |

Setin FLC | ReadfromPLC| Default |

Cancel

(10) Besides using the setting window to write the setting values of functions into PLC hosts, the
retentive range in a project setting can also be written into PLC hosts when project program is
downloaded. Users only need to select Retentive Range from the Transfer Setup window
and click OK to download data to PLC hosts. For more details on download, please refer to

section 16.1.3.

X

Transfer Setup
PC => PLC (Download)

Memory Remain 15563 Bteps

rTransfer Selections
v Program Cancel

v Comments

i ject and PLC Password

Initial Value
RTC
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3.1.3 Connected Information

When ISPSoft is in connection with a PLC host, users can double-click Connected Information
from the Project section, with PLC system parameters been captured and placed under Connected
Information file for viewing only.

3.1.4 Parameter Setting for DVP-ES3 Series PLC

Double-click HWCONFIG in the Project section and choose Parameter Setting to open the setting

page of the host CPU.

A Before setting PLC parameters, please check the user manuals for all types of PLCs to avoid
any personal loss or system damages due to the effects of the parameter setting for PLCs and
the whole system.
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|iject o |
B[ Project [CAISPEatDYFESHDVEES3 dsp)

— WD
- E83 (DVPES3)
{0 Tashs

. DUT

- @ Global Symbols
- “J Programs

g Function Elocks
~-{&8 Device Monitor Tabls
T APls

Project

There will show

Description

In the Device Setting window, parameters are categorized into many pages and users can use the
main category labels at the top of the window or select from the list of items in hierarchy on the left.
On the right, the titles on the page (from left to right) are Parameter Name, Value for user input,
Unit of the setting value as well as Default, Minimum and Maximum value. For more details,
please refer to section 3.5.2.
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|
Options | Data Exchange -COM1 | Data Exchange -COM2 | Data Exchange -Ethernet

o DWF-ES3 System Parameter
B System settings
. Gystem Infarmation Farameter name Walue Lnit Default Minimum hadmum
i Bystem Parameter p—>Rur Enable Enable
Device Range Setting ' keeps outputting when Bun—>Stop i - Off - -
- Input Point Filter Time| || lgoting delay time to detect 0 Module |20 0lsec 20 20 200
Posn.\on Cont.rol Pgrg Assign ® Input Point Control Run/Stop | Disable - Disakle = =
i Daylight Saving Timi -
. COM Port Setting Select Input Point =0 - >0 = =
COM2 Port Sefting Constant Scan Cycle Time Disable - Disahle = =
- Ethernet Port Basic Sefti Input Constant Time 1 ms 1 1 30000
- Ethemet Port Advance 5 Setting Watchdog Time 200 ms 200 10 30000
Buift-in CAN comrmunicati Sawve Error history into PLC - PLC = =
COM Comminucation Error Record Disable - Disahle = =
Select Action when power Input unstakle| Continue Runni v Confinue Runn - =
1601 Timer interupt Setting Time Base (10 ms 10 1 2000 w7
« . 4 »
Default Import Expoart

DVP-ES3 series requires AlO wizard setting for configuring modules on the right. These parameters
also determines the actual function and characteristics of each modules. For module parameter
settings, please click AIO Wizard Setting to open its setup window and select Upload Module to
upload back the configuration through PLC or select Enter Edit Mode to create modules manually
as shown below.

HWCONFIG

AIO Wizard
Help
Type Choice ‘Upload ModuleEnter Edit Mode
E83 87 & Upload Module € Enter Edit Mode

Close Nest

Drv_USB, [USB: COMY]

3.2 Hardware Configuration Tool — HWCONFIG

HWCONFIG is one of the tools in ISPSoft for hardware configuration. Its functions include
configuration of module racks, parameter settings for modules, download/upload hardware
parameters and simple on-line detection and diagnosis function. This section will introduce the
functions mentioned above and point out some model types and its unique functions.

Attention! When parameter settings regarding hardware configuration are complete, the
settings are effective once downloaded into PLC hosts.
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3.2.1 HWCONFIG Environment

Users can double-click HWCONFIG from the Project section to open the setting window.

24

© Product list: Available hardware are listed in the box.
@ System configuration area: This is the main work area for system configuration and settings.

© Information: Manages the present system configuration through a list.
In System Configuration, the area uses graphics to demonstrate the current configuration. For AH

series PLC, each module is represented by a graphic and the backplane number of a module is
shown on the left of the graphic; when operating, use the mouse to click on the selected module in

the graphic.

G b
When selecting a backplane, click on the connected port on the left of the graphic.

0 D
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When using AH560 redundant PLC series, double-click on the CPU and select Enable from the
PLC Parameter Setting window where users will find a redundant CPU appear on the right with
settings that mirror the CPU on the left, but cannot be modified alone.

The CPU on the right
including backplane and
module mirrors with the
CPU on the left, so it
cannot be modified alone.

The system configuration area and Information section will update together in real-time. So, when a
module is chosen from the system configuration area and Information section, the module is
displayed as selected in both places.

Information: Rack 1

Slot Mo, Lahel Fittoarare Version Descrption Input Devwice ... Output Device... Comment -
\ - AHPE05-5A - AH Power Supply Module |None HNone
|}L"-AH|::.‘.PT_T1:'-E:|:|.E.I'-Ilrl oo Basic CPU module 1:||.1ﬂ|:1j11g11'-I ofe None

0
1
2
3

The AS series CPU has expansion module with non-backplane design placed on the right and slots
for function cards. Some series has built-in communication port for CANopen. Modules are
configured in the System Configuration area, while expansion cards are configured in the PLC
Parameter Setting page. To configure function cards and built-in CANopen communication port,
pleaser refer to section 3.5. Like other PLC series, the system configuration area and Information
section will update together in real-time.

=
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Function Card J

Expansion modules

The Product List listed out all supported modules on the left of the window. Select a device with
specification shown below.
Product List

+-- Extension Rack

Digital Ii0 Iodule
Analog 10 Wlodule
Temperature Iodule
Notion Control Module
Hetwork Iodule

AHIDSCM-SA\
AHINDNET-34

AHIOPFBS-54

T1-Er- B

Specification
Ethernet master module, build-in =~ |&
with 2 Ethernet potts, supporting

~]

Modbus TCP master and

Some PLC hosts provide exclusive configuration software and requires HWCONFIG to open these
software to execute advanced configuration and parameter settings, for example network planning
for Ethernet/IP or EtherCAT.

To setup advanced parameters for these PLCs, please right-click on the selected PLC graphic in the
System Configuration area. Then, choose Communication Software on the quick menu to open
the configuration software. Users will be unable to edit HWCONFIG window if the configuration
software is not closed. Some configuration software may require installation. If not installed, users
will see a pop-up message for software installation.

/'
B

1

For details on starting the configuration software, please refer to the users manuals concerning each
configuration software and modules.

When using DVPxxMC series, a HWCONFIG window is shown below.
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o—

© PLC host image.

@ Description: Describes the host functions.

© Comment: Comments concerning the host.

@ Version: DDF version.

© Parameter: Click Settings to enter PLC Parameter Settings
® CANopen: Click CANopen Builder to open the software.

3.2.2 Module Configuration

3.2.2.1 Add Module

® Method 1

Select the desired module from the left Product List regarding AH series and drag that module to
the desired vacant slot on the right.
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*. When a selected module is dragged to the system configuration area on the right, the module is placed in a
vacant slot. The system does not allow the selected module be placed in an existed module slot.

The AS series PLC has a non-backplane design with expansion module placed only on the right
(the ‘+' position) in the System Configuration area. Users can continue to add modules on the

right ‘+' position, while only one power module can be added on the left ‘+' position.
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|—> Power Module

| X | — Expansion modules

® Method 2
For AH series PLCs, double-click a vacant slot or right-click the slot and choose Add. For AS

series PLCs, double-click on the

j position or right-click the position and choose Open.

'\@ /’ \&/

AH Series I

v\@OR

AS Series I

(2) Double-click on the selected module to add.
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AH series I

[ @

l.‘.' Product List @

+1 Digital 1/0 Module

AS04DA
AS0ERE I

ASDARTD AS series
ASDATC

AS0ZLC
+ Network Moduls

AS044D0-4

4 channels 16 bitz analog input : 10~ +10W,
010, B=+8, 075, 04720 md,, -20ma ™20
e conversion time = 2msdchannel

® Method 3
(1) InInformation, double-click on the blank row of the corresponding slot or right-click and
choose Add to see the Module Selection window.
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Information: Rack 1

Slot Mo Lahel Firmarate .. Descption Input Device .| Output Device .. | Comment
AHPS05-54 AH Power Supply Module  |None Hone
AHCPUS30-EN [1.00 Basic CPU module building 1| Hone Hone
1
2
3
4
5
[
7
OR
Information: Rack 1
Slot Mo, Lahel Fitmwate ... Descrption Input Device ...| Output Device ... | Comment
AHP305-54 AH Power Supply Module  |Mone Hone
AHCPUS30-EN (1.00 Basic CPT module building 1 Mone Hone

Replace

Tt
_J Copy
J Paste

Dielete Diel

Ctrl+ ¥

Intelli

t Module Configaration

(2) By clicking on a selected module from the list, users can view the Specification containing
the module information and double-click to add the module.

AH series PLC I

[ Ix @
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of.‘ Product List @

=+ Digital 1/0 Module ¢

ASO4DA

ASOEA,
ASD4RTD AS series PLC
AS04TC
AS02LC

+ Metwork Module

AS044D-4

4 channels 16 bitz analog input : 10~ +10V,
010, 5+8V, 015, 024720 md,, -20ma~20
e, conversion time = 2mz/channel

3.2.2.2 Address Assignment of Modules

When data updates are constantly required for AH series PLCs, for example, analog input modules
constantly receives analog signals, the system will automatically assign a device address to save
data. The assigned device address is shown in Information containing Input Device Range and
Output Device Range (see below). For AS Series, the group PLC do not support manual settings
for address assignment but provides auto configuration on fixed IP address according to the
installation position of the modules. For RTU, users can only set up the starting device IP of the first
SCM module then the following modules are assigned accordingly. Please refer to section 3.5.3 for
AS series remote module configuration.

® AH16AM10N-5A Module (slot 0)
This is a 16-point digital input module. The system assigns X0.0~X0.15 that is 1 WORD device in
total to store and input module status regarding all points.
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® AH16ANO1T-5A Module (slot 1)

This is a 16-point digital output module. The system assigns Y0.0~Y0.15 that is 1 WORD device in
total to store and output module status regarding all points.

® AHO4AD-5A Module (slot 2)

This is a 4-channel analog input module. The system assigns DO~D7 which is 8 WORD in total and
the conversion of external analog input signal is stored in DO~D7.

® AH16AP11T-5A Module (slot 3)

This is a 8-point digital input/output module. Since the assigned device requires at least 1 word unit,
the system assigns X1.0~X1.15 (actual range of use: X1.0 ~ X1.7) device to store and input module
status regarding all points; in addition, Y1.0 ~ Y1.15 (actual range of use: Y1.0 ~ Y1.7) is assigned
to store and output module status regarding all points.

® AH20MC-5A Module (slot 4)

This is a motion control module, but since the module does not require constant data updates,
therefore, the system does not assign device address. To obtain the corresponding functions of the
assigned device address, double-click on the graphic module or the row on Information to open the
Parameter Setting window for the module.

If users want to know functions to which devices assigned correspond, they can double-click the
module or the information about the module on the information list to open the Parameter Setting

window.
&
OR

Information: Rack 1
Slot Ho. Lahel Fittroarare ... Descrption Input Device Range | Output Device Range Commett

AHP305-54 - AH Power Supply Mlodule Hone Hone
- AHCPUS30-EN 1.00 Basic CPU module building with || None Hone
0 AHIGAMION-34 |- 16 x DI, 24 VDC 00~ E015
1 AHIGANOIT-54 |- 16 x DO, NPN 12 to 24 VDO ¥0.0~¥0.15
2 a |4 AT 16bit DD ~ D7
3 2xDIVDC, 8 x DO NPN VDO H10~X115 T10~¥1.15
4 12-axiz DMCHNET MC None None
5
[
7

*. When users double-clicks the row on Information box, please click on either the Slot No., Label, or Description cell
to avoid columns for edit.

Click the Normal Exchange Area tab in the Parameter Setting window to see a list regarding
device address and corresponding descriptions.
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Parameter Setting

= AHDAAD-BA AHO4AD 54
CHO™CH3 Mode setting
CHO™CH3 Average Time MDS Information (
CHO™CH3 Calibration
CHO™CH3 Scale Range
Channel Alarm
Interrupt Enable
Interrupt number DS Build Date
Warming LED
Conversion Flags(Read onky)

Tvlodule Mame

WDS Version

Import File
Export File
Default _OK Cancel
WIDS Information  Mormal Exchange Area
Description Address
» | CHO Input value Do ~D1
CHI Input value D2~D3
CH2 Input value D4~ D35
CH3 Input value Dé ~ D7

In order to update data constantly, the system uses auto-configuration for the device in storing data.
As for internal parameters not updated frequently in modules, users can define the corresponding
device D and when the system starts operating, the corresponding device D in the host CPU will
align with internal parameters of the assigned module. As a result, users can indirectly save internal
data of the module through corresponding device D. This is more effective than using the traditional
FROM / TO command to save internal data of the module.

For example, the AHO4AD-5A module parameter setting window has D3000 defined as the module
parameter — CHO Average Time of corresponding device D. Thus, after HWCONFIG parameters
are downloaded to the hosts, users can directly modify D3000 content value in the host CPU and
indirectly modify CHO Average Time of AHO4AD-5A module.

In addition, if modules parameters written in corresponding device D are not permitted, the system
will restore the parameters to its original values.

Parameter Setting

-1- AHO04AD0-54, CHO--CH3 Average Time
] Description Address Monitor
CHO™CH3 Calibration 4 CHO Average Time D300 ID
CHO™CH3 Scale Range CH1 Averags T 0
Channel Alarm
Interrupt Enable CH2 fiverage Tire .0
Interrupt number CH3 kverage Time g

*. Please refer to section 3.7 for more information about internal parameter settings of modules; for FROM/TO
command, please see the instruction manuals for any PLC types.
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The information in Input and Output Device Range is auto-configured by the system, but also
user-defined. Users can choose the selected row listed in Information box and then click ===, or type
the starting address to open the setting window and click OK once finish input the address.

SlotMo. Lahel Fitmwrate ... Descrption Il evice Range | Output Device Range Comment
AHP305-54 - AH Power Supply Module @ Hone
AHCPUS30-EN  |1.00 Basic CPU module building with 4 \

N one

Q.0

AHIGAMION-54 |- |16xDL24VDC

1 AHIBANDIT-54 |- 16 x DO, HPH 12 to 24 VDC

Slot Ha. Lahel Firmarare .. Descrption Input Device Range | Output Device Range Comimert
AHPRE05-54 - AH Power Supply Module Mone Mone

|AHIEAMION5A |- |16 DL 24VDC X100~ X10.15 ~|

1 AHIAANOIT-34 |- 16 x DO, PN 12 to 24 VDO V0.0~ Y015

Whether in Input and Output Device Range from Information or corresponding device D for
defining the internal parameters of the module, the input device range cannot overlap. When the
setting address is in conflict, the system will auto-correct and suggest another available address
based on the current input; for instance, when D3000 device is occupied by another module but is
being assigned again, the system will automatically search for another available address from
D3000.

¢I:I

When Input and Output Device Range is modified and modules need to be added, the default
device address will be based on the last modified device address and skip the used ones for
assignment; even though the number in the last modified address is not the biggest, the new
module address assignment is still based on the last modification.
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The following example shows Input Device Range is modified to D50~D57 for Slot No. 2.

Slot Mo, Lahel
AHPE05-54
AHCPUS30-EN

a AHO4AD-5A

1 AHO4AD-S4

Slot Mo, Lahkel
AHPE05-54
AHCPUS30-EH

a AHDMAD-54

1 AHDMAD-54

AHO4AD-54

Firmwrare ... Descrption Input Device Range | Output Device Range Comment
AH Power Supply Module Hone Hone

1.00 Basic CPT module building with | None Hone

1.00 43 AT 16hit Lo~ L7

1.00 43 Al 16hit D100 ~ D107
4 x Al 16bit D200 . Do I I

Fitmwrate ... Descrption Input Device Range | Output Device Range Commert
AH Power Supply Module Hone Hone

1.00 Basic CPU module building with | None Hone

1.00 4x Al 16hit Co~LC7

1.00 4x Al 16hit 0100 -~ D107

D30 ~ D57

100 |4xAllewi

When a new module is added, the Input Device Range is automatically assigned from the last
modified D50~D57 and not based from the system’s biggest D100~D107. As a result, the Input
Device Range of the module is assigned as D58~D65.

Slot Na. Lahel
AHPE05-54
AHCPUS30-EN
AHO4AD-54
AH4AD-5A
AHO4AD-54

AHO4AD-S4

B W=

Firmarare .. Descrption Input Device Range | Output Device Range Comment
AH Power Supply Module Hone Hone

100 Basic CPT module building with None Hone

1.00 43 Al 16hit oo - D7

1.00 43 Al 16hit D100~ D107

1.00 43 Al 16hit D50 ~ D57

1.00 43 Al 16hit

AS series does not support the address assignment for every module. For more information on
remote group starting device address assignment, please refer to section 3.5.3.

3.2.2.3 Edit Comment

Click the gray area at the top of the System Configuration area and type comments for the
hardware configuration regarding the Project. When typing the comments, press Shift + Enter to
start a new line and when complete, click Enter.
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Hardware Parameter for PRJ_(|

For AH5x0, AH5x1 series and AH560 redundant series, users can select the Comment column and
click on the keyboard icon in the Comment window or click ***| to view a pop-up window and input

the comment concerning the module.

SlotHMo. Lahel Fitmwrare. .. Descrption Input Device .. |Cutput Device..| Comment

AHPEOS-SA |- AH Power Supply Module |Hone Hone

AHCPUS30-EN |1.00 Basic CP1 module building | None Hone
A 5B |100 3 x Al 16hit D0~ D15 _

Slot Na. Lahel Fitmarate... Descrption Input Device .. | Output Device.. |  Comment
AHPE05-54 |- AH Power Supply Module |None Hone

AHCPUS30-EN |1.00 Basic CPU module building | Mone Hone
: AT L6bit |Do -~ D15

For AHXXEMC and AS series, users can select the Comment column and click on the keyboard
icon in the Comment window or click -=-/ to view a pop-up window and input the comment

concerning the module.
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CPU Group
Extension Mo Type M odule Mame DDF Wersion | Input Device Ran.. | Output Device R Camment
{ Power Module
CPU Module | CPU Module A533ZP 071.00.00 X0~ K015 Y0005
! T H
EmEn
I -
CPU Group
Extension Mo Type Modulz Hame DDF Version | Input Device Ran...| Output Device R.. Comment

| Power Module

CPU Module CPU Module AS332F 1.00.00 #0077 X015 0.0 Y05

b Comrnert

[

3.2.2.4 Delete Module

There are two ways to delete a module which has been configured. (The CPU module and
AH-series power supply module cannot be deleted.)

® Method 1

(1) Select a module which will be deleted from the system configuration area or information list.

A

AH series I

OR

he,

AS series

Slot Ma. Lahel Fitmmwrare .. Dezctption
AHP3E05-54 - AH Power Supply Module
AHCPUSI0-EN 1.00 Basic CPU module building

OR

—_

116 x DI, 24 ¥DC

Extenzion Mo Type M ame Input Device Fange | Output Device Range
o+ Power Module Power Madule AS-PS02
CPU Moduls CPU Moduls AS3IT #0.0~ %015 Y00~ 015
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(2) Click Delete on the Edit menu, click &7 on the toolbar, or press Delete on the keyboard.

OR @ AH series I

Option  Help

N o cupx
m Copy Ctrl+C

ol Delete  Del \ =
AS series I

® Method 2
(1) Right-click a module which will be deleted from the system configuration area or information
list.
Slot Mo Lahel Fittroarate .. Descrption
OR - AHP305-54 - AH Power Supply Module
AHCPUS30-EN 1.00 Basic CPU module buildins
0 & ON-54 |- 16 x DI, 24 VD
®_ 6 1 '\< ,
AH series I
Estension Mo Type Name: Input Device Range | Output Device Rangs
Power Module Power Module AS-PS02
OR +{CPU Module CPU Madule A5332T 0.0~ %015 V0.0~ 015
AS series I

(2) Click Delete on the context menu.

Replace ¥
M out X AH series I
m Copy Crl+iC

ol

AS series I

Additional remark
When users select AH560 redundant series and enables Redundancy function, the redundant
backplane module can be deleted only from the left redundant backplane shown in the System
Configuration area, while the redundant backplane configuration on the right mirrors the left so it
cannot be modified.
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3.2.2.5 Replace Module
Users can take the following steps to modify AH series modules in System Configuration area:

(1) Select and right-click an AH series module for modification in System Configuration area or
from Information. (CPU and power module cannot be modified.)

Slot Na. Lahel Firmwrate .. Descrption
OR - AHP305-54 - AH Power Supply Module

\ AHCPUS30-EN 1.00 Basic CPU module building
A 54 16z DI, 24 VDC

(2) Choose Replace on the quick menu and two ways are shown in the following.

_ Same Type ClbeAleR
;{’ Cut Chale Al Chel+ A1+ \
m Copy Cirl+C

: Daleta Dl
&

» Same Type

Replace only the selected module to be the same type module. The new module
Input/Output Device Range will be the same, while other parameters may return to system
defaults if it is not corresponding.

> All
Replace selected module to be any type of module. The result is similar to deleting the
original module by adding a new one, so the new module Input/Output Device Range will
be re-configured and other parameter settings will also return to system defaults.
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(3) When selecting on methods to Replace, the Module Selection window appears with modules
available for the selected Replace method; when the replaced module is decided, you can
double-click on that module.

gy ¥

Additional remark
When users select AH560 redundant series and enables Redundancy function, the redundant
backplane module can be deleted only from the left redundant backplane shown in the System

Configuration area, while the redundant backplane configuration on the right mirrors the left so it
cannot be modified.

o | |

3.2.2.6 Search/Find and Replace

Users can take the following steps to search or find and replace AH series modules in System
Configuration area:
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(1) Click Search from the Option menu in the HWCONFIG toolbar and an operating window
appears.

I\@

(2) Click ==+ inthe Find and Replace box to search the selected module type from the Module
Selection window and double-click on the module. Or input keywords regarding the module
type in the Find What box and click Find.

; :l\
0

(3) When finding is complete, a list of modules that meet the search condition is shown below in
the Find and Replace window; when double-click a selected item from the list, that module is
also selected in the System Configuration area.

Find and Replace E|
Findwhat  |AH04AD5& |
Replace with | J f

3-29



ISPSoft User Manual

4)

(5)

(6)

To replace a module, please first select the item to be replaced from the list in the Find and
Replace window (see below) and select the checkbox if to replace as the Same Type.

Find and Replace r.s_—<|
Findwhat  |AHD4AD-34 |
Replace with | J

Rep! ’Replaceéﬂ] ’ Find ] ’ Cancel ]

A
RackNo. | SlotNo. ) M ¥wett Name | Input Device Ran... Quiput Device ... *)

AHD 72y
1 1 AHDAAD-5A DE-~Dl13 j

» Same Type Selected
A module selected is replaced by a same type of module. After the module is replaced, the
input/output devices assigned to the new module are the same as the input/output devices
assigned to the module replaced. Besides, if the parameters in the new module are not the
same as the parameters in the module replaced, the setting of the parameters in the new
module will be restored to the default values.

» Same Type Not Selected
A module selected can be replaced by any type of module. After the module is replaced, the
different input/output devices will be assigned to the new module, and the setting of the
parameters in the new module will be restored to the default values.

Click == in the Replace with box, select a module in the Module Selection window, and
double-click the module. Owning to the fact that a module must be replaced by a specific
module, typing a module model or part of a module model in the Replace with box is not
allowed.

Find and Replace

Findwhat  |AHO4AD-34 =

Replace with | /@
[~ Same Type [ Replace ] [Replaceé}l] [ Fingd ! ;!Cancel

RackMo. | Slot Mo MModule Name | Input Device Ran . Output Device R |+ :
1 1 AHO4AD-58 D2~ D15 j @
Find and Replace El
Findwhat  |AH04AD-34 B
1
| Replace with |[AHOGKA-54 JI
[~ SameType | Replace | [Replaceatl | [ Find | [ Cancel |
RackMNo. | SlotMNo Mlodule Name | Input Device Ran... Output Device R... il
1 a AHN4AD- 54 D0 - O7F
1 1 AHDAAD- 58 D2~ D15 j

* If the Replace With box is blank, the selected module is deleted once Replace function is executed.

When Find and Replace setting is complete, users can click Replace to replace the module
selected with the new module. The search list is updated once Replace is complete and will
automatically select the next item.
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x]

Find and Replace

Findwhat  |AHD4AD-34

Replace with |AH06XA-5A @ J

— =
[ Bame Type ’Replaceé]l] [ Find ] ’ Cancel ]
S ———

FackHMo. | Slot MNo. Module Hame | Input Device Ran.. OutputDeviceR...i‘

t o |sH044D-54 DO~ D7

1 1 AHDAAD-54 D2~ D15 j
~J
ind and Replace @
Findwhat  |AHI4AD-5A -
Replace with |AHD'5XA-5A J
[ Bame Type I Replace l ’ Replace All ] ’ Find ] ’ Cancel ]
FackMo. | 3lotMNao. Module Name | Input Device Ran... | Output Device E...
1 1 AHO4ATD-54 LE~ D15

(7) Afterfilling in the setups in the Find and Replace window, users can click Replace All and new
modules based on the setting will replace the listed items shown in the window.

Find and Replace r>_<|

Findwhat  |AHO4AD-34 =

H—I
Replace with | J
e,

[ Bame Type Replace ‘ Replace All ,’ Find ] ’ Cancel ]
~—_—

RackMo. | SlotNo. | Module Hame |Input Device Ran.. | Output Device R+

1 1 AHD4AD-54 Dg ~ D15 ﬂ

A4

* When using AH560 redundant system with Redundancy function enabled, only the main redundant backplane on the left in
System Configuration area can perform and replace modules, while the main redundant backplane on the right is
configured to mirror the left and cannot be modified. To execute Find and Replace function, the configuration of the main
redundant backplane on the right is not on the search list.

For AS series PLCs, users can view the following steps to replace modules in the System
Configuration area:

3-31



ISPSoft User Manual

(1) Right-click one of AS series modules which will be replaced in the system configuration area or
on the information list. (The CPU module and the power module cannot be replaced.)

CPU Group

Extension No Tupe Module Name | DDF Yersion | Input Deviee Ra.| Output Device Comment

O R Fower Moduie
=|CPU Module CPUModie  |AS5332P 00000 [X00-X015 Y00~ YDIS
Function Cardi
w v o
@ Modue Information Analog 140 Module| AS044D oizannd ~ 525015 [

Or, click on the module to be replaced and then click Replace from the Edit menu on the tool bar.

D

(2) Click Replace from the quick menu and a Product List window appears.

o D

m Open(Q) Enter
|g Replace(R) Ctrl+R |\

X cum Crl+X ‘e
{9 copy@ Ctri+C

[T Paste®) Ctrl+V

&5 Delete(D) Del

(3) Select and double-click on the module to be replaced, and a pop-up window appears with a
message indicating that the replaced module setting will be restored to default, choose Yes if
wish to continue to replace. To replace all the same type of modules at once, users can select
Replace All and click on the modules to be replaced as shown below.
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|
4

3.2.2.7 Copy/Paste

There are two ways to copy modules (CPU and power modules are not to copy/paste):

® Method 1
Right-click a selected module to copy in the system configuration area or Information, and
choose Copy from the context menu.

Slot Ma. Lahel Fitmwrate .. Desctption
- AHPE05-54 ile
3
Replace OR - AHCPUSI0 EN Feplace , ing

Ctrl+E

® Method 2
(1) Select a module to copy from System Configuration area or Information.

Slat Ma. Lahel Fitmwrate .. Dezctption
OR - AHP305-54 - &H Power Supply Module
AHCPUSI0-EN 1.00 Basic CPU module building

LN @ 0 |AHISAMION-5A |- 16 2D1, 24 VDO
1
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(2) Click Copy from the Edit menu, or @ on the toolbar.

Option Help O\

There are two ways to paste modules:

® Method 1

Right-click a slot to paste from System Configuration area or Information and choose Paste from
the quick menu.

Slot Ha. Lahel Fitroarate . Descrption

Add Ctel+Alt+h - AHPS05-54 Add Ctrl+alt+i 11#8

- AHCPUSI0-EN
‘ / OR ] AHIEAMION-54 ;

® Method 2
(1) Select a slot to paste from the System Configuration area or Information.

Blot MNa. Lahel Firmwrate ... Descrption
O R - AHPI05-54 - AH Fower Supply Module
- AHCPUS30-EN 100 Basic CPU module building
\ 0 AHIGAMION-54 |- 16 x DI, 24 VD2
2 Ao

(2) Choose Paste from Edit in the HWCONFIG toolbar, or click @ on the toolbar.

[ [ OR O\@
6

The two methods are applicable for AS series as well. Since AS series modules has non-backplane
design, thus, modules can only paste to the far right position for installation or the blank row at the
bottom of the list.

E stension Mo Type Narne: Input Device Range | Dutput Device Range
Power Module Power Module AS-P502
OR +CPU Module CPU Module A5332T ®0.0~®015 Y0.0~Y0.15

ule |ASO4AD-A  |D28000 ~ D28019

Module Information | &)

When choosing to paste on an existing module, the module is placed before the existed module. For
example, the image below shows that by selecting 04AD module and click Paste from the quick
menu, the 06XA module is paste before 04AD.
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/’

—6

Additional remark
To copy/paste a module, users can view the following descriptions on module parameters.

® Input/Output device range: The paste module automatically skips to the available device range
number.

® Comment: Comments are copied to the paste module.
® Internal parameters: Parameters are copied the paste module.

® Corresponding device D: An assigned column of the Corresponding device D for internal PLC
paste module, which automatically skips to the available device range number.

® Advanced parameters for intelligent module: The parameters cannot be copied and is referred
to as system defaults. Users will need to reset the parameters.

The following example shows that slot 0 is the copy module, while slot 1 is the paste module.

Description Address Monitor Initial Description Address Monitor Initial
|CHD Aoverage Time  D3000 & 30 | | CHO iverage Time D3001 ™) 30
CHI1 hverage Tire O 10 CHI Lversge Titee MmN 10

T _——

Slot Ma. Lahel Fitroarate . Descrption Input Device ... | Output Device .. | Comment
AHP305-54 - AH Power Supply Module |None Hone
AHCPUSS0-EN 1.00 Basic CPU module building None Hone

] AHO4AD-SA 1aa 43 Al 16kit Do~ D7 AT

1 AHO4ADSA 100 4 Al LEkit Dg -~ D13 Al

*. Some intelligent modules can enable exclusive configuration tools to execute settings. Please refer to section
3.7.5 for more information.

*. AHXXEMC and AS series PLCs do not support corresponding device D function.

When using AH560 redundant system with Redundancy function enabled, only the main redundant
backplane on the left in System Configuration area can copy/paste modules, while the main
redundant backplane on the right is configured to mirror the left and cannot be modified.

3.2.2.8 Cut/Paste

There are two ways to cut modules (CPU and power modules are not to cut or paste):

® Method 1

Right-click a selected module to cut in the system configuration area or Information, and choose
Cut from the context menu.

3-35



ISPSoft User Manual

Slot Ho. Lahel Firmwate .. Diescrption

- AHPE05-54 e
AHCPUS30-EN
AH Ob-54

Feplace 3

o OR

£ Delete Del

® Method 2
(1) Select a module to cut from System Configuration area or Information.

Slot Mo, Lahel Firmware ... Descrption
O R - AHPS05-54 - AH Power Supply Module
- AHCPUSA-EN (100 Basic CFU module building

\ @ AHIEAMION-54 16 x DL, 24 VDC

(2) Choose Cut from the Edit menu, or click x‘ on the toolbar.
—or (O
6 6

There are two ways to paste modules:
® Method 1

Right-click on the selected slot to paste from System Configuration area or Information, and
choose Paste in the context menu.

Blot Mo, Label Fitmwrare ... Descrption
add Clalrilica - AHP305-5A AT Prarar St W adyle
O R - AHCPUS30-EH & Culehlted

Crl+ W

® Method 2
(1) Select a slot to paste from System Configuration area or Information.

Slot Ho. Lahel Fittnrare ... Descrption
AHPE05-5A - AH Power Supply Module
AHCPUS30-EN 1.00 Basic CPU module building

OR -
'\G —*r

(2) Choose Paste from the Edit menu, or click [Fj on the toolbar.
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Option Help O O
AN

9 IE Paste Ctel+¥ @

The two methods are applicable for AS series as well. Since AS series modules has non-backplane
design, thus, modules being cut are added to the end position for installation. For instance, the
04AD module shown below is cut and paste on to the right side of 06 XA module.

E Open(Q) Enter
!u- Replace(R) Ctrl+R

X cwm Ctrl+ X
9 Copy(Q) Cil+C
[T Paste(®) Ctrl+V

If the module that is cut and pasted to an existed model, the cut module will be placed before the
existed one. For example, the 04AD module shown below is cut and pasted to the left side of 06XA
module.

E Open(0) Enter
',;_ Replace(R) Ctrl+R

X cum Ctrl+X
Copy(C) Cirl+C
! / Ctrl+V

Additional remark

When executing Cut/Paste function, modules that are cut can only be paste once. However, the
input/output device range, comment, internal parameters, corresponding device D and
advanced parameters for intelligent modules from modules that are cut is altogether transferred
to the paste module, but AS series will automatically re-arrange input/output device range based
on the positions of module installation.

*. Some intelligent modules can enable exclusive configuration tools to execute settings. Please refer to section
3.7.5 for more information.

When using AH560 redundant system with Redundancy function enabled, only the main redundant
backplane on the left in System Configuration area can cut/paste modules, while the main
redundant backplane on the right is configured to mirror the left and cannot be modified.

3.2.2.9 Drag and Drop

Besides CPU and power modules, all module graphics in System Configuration area can be
dragged by the mouse .

For AH series, there are two dragging and dropping conditions:

® Condition 1
Select a module to drag and drop onto a vacant slot, then the will be moved to a new paosition.

P
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® Condition 2
Drag a selected module to a position occupied by another module, the position of the two

modules are changed.
\ g
-

Since the AS series has a non-backplane design, when the module is dragged to a position
occupied by another module, a red arrow mark appears indicating the place to drop the module.

\@ LJ;> \9,’
N84

* When executing drag and drop, the input/output device range, comment, internal parameters, corresponding
device D and advanced parameters for intelligent modules are also dragged together with the module, but, AS
series will automatically re-arrange input/output device range based on the positions of module installation.

Additional remark

When using AH560 redundant system with Redundancy function enabled, only the main redundant
backplane on the left in System Configuration area can drag and drop modules, while the main
redundant backplane on the right is configured to mirror the left and cannot be modified.

3.2.2.10 Add Expansion Backplane and Redundant Expansion
Backplane

For AH series, there are two ways to add expansion backplanes:

® Method 1

Choose a backplane model from the Product List and drag to System Configuration area; when

the backplane is dropped onto the blank workspace area, the new backplane is placed
underneath the present one.

3-38



Chapter 3 PLC System Configuration & Settings

I N

N

G Sx
o

When the backplane is dropped onto an existed backplane, the new backplane is placed on top of
the present one.

I

N

\\-@_’
24

® Method 2
Right-click the blank in the system configuration area and click Add from the context menu, then
double-click on the selected backplane. The new backplane is placed underneath the selected
backplane.
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Y

@

Right-click the left side of the selected backplane graphic, choose Add from the context menu

and double-click on the backplane to add. The new backplane is placed underneath the selected
backplane.

/1| \ |

¢ :I\@

¢

To add redundant expansion backplane for AH5x0 and AH5x1 series, redundant expansion
backplane and expansion backplane cannot exist at the same time. For AH560 redundant system
with Redundancy function enabled, please refer to related product manuals on adding redundant
expansion backplane. Here are two ways to add expansion backplanes:

® Method 1

Choose a redundant expansion backplane model from the Product List and drag to System
Configuration area; when the redundant expansion backplane is dropped onto the blank
workspace area, the new backplane is placed underneath the present one.
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I PN
N

N
~

When the redundant expansion backplane is dragged to an existed redundant expansion backplane,
the new redundant expansion backplane is placed on top of the existed one.

* A redundant expansion backplane cannot be dropped on top of the main backplane and redundant backplane nor
exist along with expansion backplanes.

® Method 2
Right-click the blank in the system configuration area and click Add from the context menu, then
double-click on the selected redundant expansion backplane. The new redundant expansion
backplane is placed underneath the selected backplane.
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——— 1 I:l'\
a9 i =

@

Right-click the left side of the selected backplane graphic, choose Add from the context menu
and double-click on the redundant expansion backplane (rack) to add. The new backplane is
placed underneath the selected backplane.

y 6 > =g

¢

3.2.2.11 Delete Expansion Backplane and Redundant Expansion
Backplane

There are two ways to delete expansion backplanes (the main backplane cannot be deleted):

® Method 1
(1) Click on the left side of the selected backplane graphic to be deleted.

@/’
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(2) Select Delete from the Edit menu or click £ on the toolbar. Users can press Delete on the

keyboard too.
Eﬁlgpmnggm
O\ OR X oo cupx
@ m Copy  Ctrl+C

® Method 2
Right-click the left side of a backplane and choose Delete from the context menu.

"% Y
| |v\

*The AHXXEMC and AS series do NOT support expansion backplane function.

There are two ways to delete redundant expansion backplanes (redundant main backplane
cannot be deleted):

® Method 1
(1) Click on the left side of the selected redundant expansion backplane graphic to be deleted.

(2) Choose Delete from the Edit menu in HWCONFIG functions, or click &# from the toolbar.
Users can press Delete on the keyboard too.
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™ option Eelp

X oow cusx

O\ OR 5 copy CrbC
@ [ Detete Dt K@
A4

® Method 2

Right-click on the left side of a redundant expansion backplane to be deleted and choose Delete
from the context menu.

*The AHXXEMC and AS series do NOT support expansion backplane function.

3.2.2.12 Replace Backplanes

To replace backplanes, users can follow these steps:
(1) Right-click on the left side of a backplane to be replaced and choose Replace from the context

menu.
‘ f Add Crl+Alt+4
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(2) Double-click on the selected rack (backplane model) to be replaced in the window.

o

I:Iv\@

Additional remark

When the slot number of the new backplane is smaller than the original backplane, please be take
note that once replace is executed, modules in the original backplane with slot number exceeding
the new backplane is automatically deleted.

- —7

When using AH560 redundant system with Redundancy function enabled, only the main redundant
backplane on the left can be replaced, while the main redundant backplane on the right is
configured to mirror the left and cannot be modified.

/' W\
'-J;> ':k@

¢
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3.2.2.13 Cut/Copy/Paste an Expansion Backplane and Redundant
Expansion Rack

There are two ways to copy or cut an expansion backplane (the main backplane cannot
copy/cut/paste):

® Method 1

Right-click the left side of a backplane to copy or cut, and then click Copy or Cut on the context
menu.

/‘

® Method 2
Click the left side of the selected backplane to cut or copy.

To copy, users can click Copy from the Edit menu, or click [ from the toolbar.

Option Help
Cut  ChbX Ola
Copy  Ctrl+C @

There are two ways to paste an expansion backplane. If an expansion backplane is pasted on the
blank in the system configuration area, it will be under the present racks. If an expansion backplane
is pasted on a present expansion backplane, it will be put above the present expansion backplane.

® Method 1

Right-click on a selected position to paste in System Configuration area and then select Paste
on the context menu.
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® Method 2
Click the selected position in System Configuration area, and click Paste on the Edit menu, or

M on the toolbar.

3 Y

@ Paste Chl+V

B2 ostcn e
SN O Py

*The AHXXEMC and AS series do NOT support expansion backplane function.

There are two ways to Copy or Cut a redundant expansion backplane (the main backplane cannot
copy/cut/paste)

® Method 1

Right-click the left side of a redundant expansion backplane to copy or cut and then click Copy or
Cut from the context menu.
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/‘

‘0

® Method 2
Click on the left side of the selected backplane to copy or cut.

@/‘

To copy, users can click Copy on the Edit menu, or click {3 on the toolbar.

2 option Help

fee or ()
B Sy 6

9 Delets Del

To cut, users can click Cut on the Edit menu, or click ¥, on the toolbar.

There are two ways to paste the redundant expansion backplane. If the redundant expansion
backplane is pasted on the selected blank space in System Configuration area, it is placed under
the present backplane. If the redundant expansion backplane is to paste onto an existed redundant
expansion backplane, it is placed on top of the present redundant expansion backplane.

® Method 1

Right-click to select a place to paste in System Configuration area, and then click Paste on the
context menu.
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® Method 2

Click to select the place to paste and then click Paste from the Edit menu, or @ on the toolbar.

@/"

k
m Option  Help
¥ oo cemx
@ [ copy_ctrteC
\‘ [Ty Paste CirtV

Q Delete Del

OR

gy

The redundant expansion backplane function is not supported by AHXxXEMC and AS series.
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Additional remark
When an extension or redundant type expansion backplane is cut/pasted, the parameters of the
modules are processed as follows.
® Input/output device range: The input/output devices assigned to the modules on the extension
or redundant type expansion backplane cut are automatically
assigned to the modules on the or redundant type expansion
backplane pasted.
® Comments about the modules: The comments about the modules on the extension or
redundant type expansion backplane cut are copied into the
modules on the extension or redundant type expansion
backplane pasted.
® Parameters in the modules: The parameters in the modules on the extension or redundant type
expansion backplane cut are copied into the modules on the
extension or redundant type expansion backplane pasted.
® Data registers: The data registers assigned to the modules on the extension or redundant type
expansion backplane cut are automatically assigned to the modules on the
extension or redundant type expansion backplane pasted.
® Parameters in the intelligent modules: The setting of the parameters in the intelligent modules
is pasted.

When an extension or redundant type expansion backplane is copied/pasted, the parameters in the

module are processed as follows.

® [nput/Output device range: The input/output devices assigned to the module on the extension or
redundant type expansion backplane copied will automatically
switch number to the module on the extension or redundant type
copied.

® Comment about the module: The comment about the module is copied into the module pasted.

® Parameters in the module: The parameters in the module cut are copied into the module pasted.

® Data registers: The data registers assigned to the module copied will automatically switch

number to the module copied.
® Parameters in the intelligent module: The setting of the parameters in the intelligent module is
not copied, and is set to default value.

*. Some intelligent modules can be set by means of exclusive configuration tools. Please refer to section 3.7.5 for
more information.

3.2.2.14 Drag an Expansion or Redundant Expansion Backplane

Drag an expansion backplane to another expansion backplane when the left mouse button is held.
The two expansion backplanes will be interchanged. When the expansion backplane is dragged, the
input/output devices assigned to the modules on the expansion backplane, the comments about the
modules on the expansion backplane, the parameters in the modules on the expansion backplane,
the data registers assigned to the modules on the expansion backplane, and the parameters in the
intelligent modules are also dragged. However, the main rack is always at the top of the system
configuration area.

oy w

~

The expansion backplane function is not supported by AHXXEMC and AS series.
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Drag a redundant expansion backplane to another expansion backplane when the left mouse button
is held. The two expansion backplanes will be interchanged. When the redundant expansion
backplane is dragged, the input/output devices assigned to the modules on the redundant
expansion backplane, the comments about the modules on the redundant expansion backplane, the
parameters in the modules on the redundant expansion backplane, the data registers assigned to
the modules on the redundant expansion backplane, and the parameters in the intelligent modules
are also dragged. However, the redundant main rack is always at the top of the system configuration
area.

<l

*The AHXXEMC and AS series do NOT support redundant expansion backplane function.

3.2.2.15 Rearrange Input/Output Device Range

For AH/AS series, since the process of module configuration involves many executions to drag and
drop or copy/cut/paste, the input/output device range for each module may be automatically
assigned by the system and not according to a continuous sequence. Thus, users can click
Input/Output Device Rearrange from the File menu in HWCONFIG toolbar and all the
Input/Output Device Range of the module will rearrange base on the order of the slot and
backplane number.

The execution does not change the corresponding device D setting of an internal module; when
rearranging, if Input/Output Device Range and Corresponding Device D are not in conflict, the
system will automatically skip the address for corresponding device D to program the next available
address.
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SlotMo. Lahel Fitmwrate ... Descrption Input Device .. Output Device .. Comment
AHPE0S-5A - AH Power Supply Module |None Hone

- AHCPUS30-EN |1.00 Basic CPU module building | Hone Hone

i AHD4AD-54 100 43 Al 16hit Dé4~ D71

1 AHD4AD-54 100 43 Al 16hit Dié~ D23

2 AHD4DA-54 100 43 AO 16bit D32~ D3

3 AHNMDA-SA 100 43 AQ 16hit D& ~ Do5

2%

13158 Edit Option Help
Save Chil+S

& Brint ChI+FP
Rack Information List

InpaatiChatput @

Slot Mo, Lahel Fitmwrate ... Descrption Input Device ... Output Dewvice . Comnent
AHP305-54 - AH Power Supply Module |None Hone

- AHCPUS30-EN |1.00 Basic CPU module building [None Hone

0 AHD4AD-34 100 4x Al 16hit Lo-~D7

1 AHD4AD-54 100 4x AT 16hit Lg-~ D15

2 AHD4DA-54 100 4x A 16hit D16 ~ D323

3 AHD4DA-54 100 4x A 16hit D24~ D31

For AS series, users can apply «* on the toolbar and execute Input/Output Device Rearrange
function.

3.2.2.16 Show/Hide Module Names
For AS series, users can choose ™ on the toolbar to show or hide module names in System
Configuration area.

JOPNN

3.2.3 Managing the Version of a Module

The functions of a module or the parameters in the module vary with the versions of the module. In
HWCONFIG, the functions of the modules and the parameters in the modules are defined in a
document called MDS. When ISPSoft is installed, the latest MDS document will be also installed.

An MDS document provides the information about the firmware versions of the modules. If users
want to configure modules in HWCONFIG, they can select a suitable configuration according to the
firmware versions of the actual modules. Besides, the parameters which can be set in the modules
vary with the firmware versions of the modules which are set. If the firmware version of a module set
in HWCONFIG is older than the firmware version of the actual module, the module will operate
normally after the parameters are downloaded. If the firmware version of a module set in
HWCONFIG is newer than the firmware version of the actual module, the module will not operate
normally after the parameters are downloaded. Please refer to the descriptions in the table below for
more information.
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Difference Compatibility
The firmware version set is
older than the actual
firmware version.

The module operates normally. Functions or parameters not
defined in HWCONFIG are assigned with the default values.

The module cannot operate, and is in an erroneous condition.
Users have to select a firmware version which is the same as the
firmware version of the actual module in HWCONFIG, check the
parameters, and download the parameters again.

The firmware version set is
newer than the actual
firmware version.

*. The compatibility mechanism described above only applies to modules whose firmware version is 1.0 or above. A
firmware version below 1.0 is not compatible with firmware version 1.0 or above.

*. The equipment description file can be in DDF or MDS format based on different models.

If users want to set the firmware version of a module, they can select a version number in the
Firmware Version drop-down list cell on the information list. If the firmware version of a module is
unknown, no version number will be displayed.

Information: Rack 1

Slot ... Lahel Firmwrare Version Descrption Input Device ... Output Device .| Comment | =
AHPS05-34 |- AH Power Supply Module | None Hone
AHCPUS30.EN 1.00 Basic CPU module building | None Hone

» A N D
1 AHOAAD- 54 wﬁ, DE~ D15
=

If users want to change the firmware versions of the modules of a certain model, they can click Alter
Overall Firmware Version on the Option menu. The Alter Overall Firmware Version window will
appear.

LSRN Help

’;—E Upload Ctil+F2
7 Dovnload Ctal+FE
E 14 Sean Cal+N
&7 Online Mode CtrlF4

T roLst

Search Ctrl+F
Alter Overall Firmmarare Version |\ @

Click 'l in the Module Name box, select a module model in the Module Selection window, and
double-click the module model.
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Select a version number in the Firmware Version drop-down list. After the setting is complete,
users can click OK to change the firmware versions of the modules specified.

Information: Fack 1

AHPEOS-54
AHCPUS30-EN|1.00
AHO4AD-54  JO38 HWCONFIG has completed its alter and has made 2 modules
AHO4AD-3A  |032

Hlot .. Label Fitrroarare Versio Descrption Input Device ... |Output Device . Cotnmett j

Wt — =]

=

*The AS series do NOT support the version of firmware modification.

Additional remark

Users can know the firmware version of an actual module by clicking I/O Scan on the Option menu.
If ISPSoft is connected to the CPU module, users can get the information about the firmware version
of an actual module in the Module Information window. If users want to know the firmware version
of an actual module by clicking 1/0 Scan on the Option menu, or viewing the information about the
firmware version of an actual module in the Module Information window, ISPSoft must be
connected to the CPU module normally, and the installation of modules must be completed. Please
refer to section 3.8.5 and section 3.8.6 for more information.

3.3 Parameter Settings for AH500 Series PLC

3.3.1 Open the PLC Host Parameter Setting Page

When HWCONFIG is enabled, double-click the CPU graphic in System Configuration area to
open the Host CPU Parameter Setting page. In addition, the setting paged for parameters differ
based on different PLC model types.

A Before setting the PLC host parameters, please check on user manuals for all PLC types
and the effects of parameter settings to the host as well as the whole system, in order to
avoid any system or personnel risks.

*. Download the parameter once settings are complete, please refer to section 3.8.4 for ways to download.
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) :
The setting window contains many tabs based on different parameters. Users can use the main

category tabs near the top of the window, while each sub-category tab refers to a parameter setting
is shown near the bottom of the main category page.
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3.3.2 Setting CPU Parameters

3.3.2.1 CPU Basic Parameter: Name

After users click the CPU tab at the top of the window, and the Name tab at the bottom of the
window, the AH5x0 series can type 32 characters at most in the Name box, and 60 characters at
most in the Comment box. While the AH5x1 series or AH560 redundant system, users can type 31
characters at most in the Name box, and 63 characters at most in the Comment box, there is no
restriction on characters typed in the Comment box. Characters typed in the boxes can include
special marks and spaces. However, please take note that a Chinese character occupies two
characters.

COM Port 1 Ethernet - Basic | Ethemnet - & dvance

Hame [PRI_0

Comment |

@ystem] Latched Device Range J

When adding an ISPSoft project, the system uses the project name as the host name by default and
appears after the model type in the Project section which can be redefined from here.

I:I|$| |LJ}> [ 1]

By using PLC label name for device identification, especially during networking applications or
connecting, users can avoid operating mistakes through checking the PLC label name;

several devices are connected to one network, users can check whether a device connected to
the computer is the device they expect by checking the device name. To prevent errors, if users
want to download/upload the program, the system will remind the users to check the name of the
CPU module and the name attached to the model in the project management area, when the name
of the CPU module is different from the name attached to the model in the project management
area.
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3.3.2.2 CPU Basic Parameter: System

In System sub-category page of CPU main parameter category, the page provides CPU parameter
settings.

OM Pmtl Ethernet - Basic I Ethernet - Advance l

Clear Non-latched Device (3TOF -> RUH) Watchdog Timeout Constant Communication Response
[v Enable WLT 200 ms (10 ~ 40000 ms) I~ Enahle

T state (3TOF > RITN) [~ Enable Constant Scan Errot Log Location

+ Clear l— * FLC

" PLC and PLC CARD
" Retain Present State

Interval Internupt Time
CPUT Operation at Program Error

Interval Interrapt 0 (100 s (1 ~ 1000 hs)
" Previous State hefore 3TOP (v BTOP

Interval Interrupt 1 |40 ms (1 ~ 1000 ns) X
Reset Button " Continue

Interval Int t2 |20 1~ 1000
+ Enahle ISy ms ( ms) CPU Operation at Bus Fault
" Disable Interval Intermapt 3 |10 s (1 ~ 1000 ms) *+ STOP
Cllr et I~ Enable Remote Run " Continue
&+ Enahle

,— ’— Remote Reset
" Disable ’

[~ Enable
Narne( System bLatched Dewice Range I

® Clear Non-latched Device (STOP>RUN)

When Enable is selected and PLC host switches from STOP to RUN, the state of non-latched
devices and values are cleared.

Clear Non-latched Device (STOP -> RUN)
[+ Enahle

® Y State (STOP>RUN)
To set the host state from STOP to RUN of Y state.
> Clear: Set all Y device output to OFF.
» Retain Present State: Output retained to present state.
» Previous State before STOP: Restore to previous states before STOP.

Y state (3TOF -> RUN)
(+ Clear

(" Fetain Present State

(" Prewious State before STOP
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® Reset Button & Clear Button
The parameters are used to setup and enable the function concerning Reset (RST) and Clear
(CLR) button on CPU panels. For descriptions regarding button function and operation, please
refer to user manuals for related PLC types.

-l

Reset Button
+ Enahle

" Disable

Clear Button
{+ Enahle

(" Digahle

AH5x0 and AH5x1 AH500 Redundancy
Series Front Panel System Front Panel

® Enable Redundancy

When enabled, two redundant main backplanes will appear in System Configuration area (see
below) containing a left redundant main backplane and a right redundant main backplane which
mirrors the left and cannot execute functions including add, delete or replace modules. To
perform these functions, users need to use the left redundant main backplane. When
Redundancy function is enabled, the expansion backplane in System Configuration area will
automatically change to redundant expansion backplane; For redundant main backplane
configuration module and functions, please refer to AH560 redundant system related manuals.
(Currently, only AH560 redundant system series support Redundancy Enable function.)

"4

Left Redundant Main_T Right Redundant Main_T
Backplane Backplane

® Communication Loading of Scan Time

When enabled, users can adjust communication loading of scan time.
(ONLY AH5x1 and AH560 redundant system series supports this function.)

Communication Loading of Scan Time (%)

Communication Ratic/20 % (20~ 30%)
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® \Watchdog Timeout

Users can set a timeout during which the program is scanned. Generally speaking, the watchdog
timeout is reset whenever the scan of the program is complete. If the scan procedure cannot be
completed within the time set for some reason, the watchdog timeout occurs, and the CPU
module will be in an erroneous condition. Please refer to operation manuals for more information
about troubleshooting.

Watchdog Timeout
WDT 200 ms (10 ~ 40000 ms)

® Enable Constant Scan

Users can select the Enable Constant Scan checkbox, and set a scan time. If the actual scan
time is less than setting value, the CPU module will not carry out the next scan until the setting
value is reached. If the actual scan time is larger than the setting value, the CPU module will
ignore the setting value, and operate according to the actual scan time. Besides, if the scan time
set is larger than the watchdog timeout set, a watchdog timeout occurs when the CPU module
operates.

Jv Enable Constant Scan

Secan Time  |100 s (1 ~ 32000 ms)

® Interval Interrupt Time

An AH500 series CPU module provides four interrupts. Users can set intervals of triggering the
interrupts. In ISPSoft, a timed interrupt is created through a task and a POU. Please refer to
chapter 5 for more information.

Interval Internapt Time

Interval Interrupt 0 |100 ms (1 ~ 1000 ms)
Interval Interrapt 1 |40 ms (1 ~ 1000 ms)
Interval Internapt 2 |20 ms (1 ~ 1000 ms)

Interval Internapt 3 |10 ms (1 ~ 1000 ms)

Task Type rTask Description——— =
External Interrupt (236) A Interrupt Labe Timer Internapt 0 (257
External Interrupt (237) Cancel
External Interrupt (238)
External Interrupt (239)
External Intermupt (240) CPU Timer Internaption
External Interrupt (241) Please set the parameter at
External Interrupt (2420 HWCONFIG
External Interrupt (247)
External Interrugpt (24
External lterrupt (245) Unassigned POTs Assigned POUs
External Interrupt (246)
External Interrupt (247)
External Interrupt (248)
External Interrugpt (249
External Interrupt (250)
External [nterrupt (251

imet Internapt 0
Timet Internapt 1 (255)

Timet Internapt 2 (254 E:l |I|

Timet Internupnt 3 (25

® Enable Remote Run

If the Enable Remote Run checkbox is selected, users can specify an X device which controls
the status of the CPU module. For example, the CPU module runs when the state of X0.0 is ON,
and the CPU module stops running when X0.0 is OFF.
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|w Enahble Remote Run

Z G (00~ X515

® Constant Communication Response

If the Enable checkbox is not selected, commands received through the communication ports will
not be processed until the scan cycle is complete. If the Enable checkbox is selected, commands
received through the communication ports will be processed every specific period of time.
However, the scan procedure is interrupted when the system processes commands received
through the communication ports. As a result, the scan time will be prolonged if the Enable
checkbox is not selected. Please make sure that the operation of the system is not affected when
the function is used.

Constant Communication Response

[~ Enable

® Error Log Location

If the PLC option button is selected, error logs will be stored in the special data registers in the
CPU modules. If the PLC and PLC CARD option button is selected, error logs will be stored not
only in the CPU module, but also in the memory card.

Twenty error logs at most can be stored in an AH500 series CPU module. If there are more than
twenty error logs, the oldest error log will be overwritten by the latest error log. However, if the
PLC and PLC CARD option button is selected, and there are more than twenty error logs, the
oldest error log will be backed up in the memory card before the oldest error log is overwritten.

Error Log Location
(« PLC

" PLC and PLC CARD

® CPU Operation at Program Error & CPU Operation at Bus Fault

If an error occurs, the status of the CPU may change. The status of the CPU depends on an error
code generated. Users can define the status of the CPU module for some errors. They can select
the Stop option button or the Continue option button in the CPU Operation at Program Error
section, select the Stop option button or the Continue option button in the CPU Operation at
Bus Fault section, and download the parameters to the CPU module. Please refer to operation
manuals or related technical documents for more information.

CPU Operation at Program Error

(¢ STOP

(" Conitite

CFU Operation at Bus Fault
(+ STOP

" Continue

® Remote Reset
If the Enable checkbox is selected, the CPU module can be reset through a remote system. After
users select the Enable checkbox, and download the parameter to the CPU module, they can

click Format PLC Memory... on the PLC menu, and select the Reset PLC Memory (Factory
Setting) option button in the Format PLC Memory window.

Femote Reset
v Enable

3-60



Chapter 3 PLC System Configuration & Settings

PLC | Tools Windew Help

—

&7 Transfer »
Systerm Security » Format PLC Memory

() Fm Ctel+F11

Q i CubF12 Clear Al Program MW emory
Cmnline Maode Ctrl+F4 T

7 " ke (#) Reset PLC Memory (Factory Settmg);l

& Mew Devices Table

& t PLC ML

F’ e = | oK Cancel |

System Log \

System Information...  Ctel+Alt+1

3.3.2.3 CPU Basic Parameter: Latched Device Range

After users click the CPU tab at the top of the window, and the Latched Device Range tab at the
bottom of the window, they can set a range of latched devices.

COM Port ] Ethernet - Basic ] Ethetnet - Advance ]

M i D T i HC

Latched Device Range

LatchedRange [0 3| ~ [aor 3 Clear Default

D S e e e 8191

Name | SystenC Latched Device Range b

(1) After users click a device type, they can be set a range of latched devices. There is a
rectangular bar in the setting area. The values at the two ends of the bar represent a maximal
value and a minimal value. The blue part represents a range of latched devices.

‘ D T & HC

Latched ange
Latched Range |0 =~ ko =] [ ks | [ Defutt
O 2191

(2) Please select values in the boxes. The value in the left box is a start address, and the value in
the right box is an end address. The value in the left box must be less than the value in the
right box. Besides, the value in the left box cannot be less than the minimal value at the left
end of the rectangular bar, and the value in the right box cannot be larger than the maximal
value at the right end of the rectangular bar.
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M D T C HC

Latched Devwice Range

LatchedRange  [4096 —=| ~ [6101 =] | [ Clear | [ Defaut

(3) If all the devices in the block are not latched devices, the users can click Clear. After the users
click Clear, the boxes become gray, and the range of latched devices will be -1~-1.

s D T c HC

Latched Devwice Range

|LatchedRange | :I - | | Diefault

(4) If the users want to restore the setting to the default values, they can click Default. After the
users click Default, the setting will be restored to the default values.

M D T C HC

Latched Device Range

LatchedRange [0 = ~ [s191 3 Defauit

Additional remark

Some latched device range may not cover the entire area. When there is a maximum value
restriction, a hint will appear under the setting area. The following image is the AHCPU530-EN
model setting page for latched range of D device; since the permitted latched range total is 32768
words, this means users can setup the latched range to be smaller or equal to 32768 from the entire
section setting range from 0~65535. For example, 0 ~ 32767 or 10000 ~ 42767.

Take the diagram below for instance, the image show input device range as 0~32768, yet the length
has reached 32769 words, thus, when leaving the page, the system shows a warning message
regarding PLC Parameter Setting.

M D T C HC

Latched Device Range

PLC Parameter, Setting g]

The value exceeds the range!

Latched Range ||D il - |32?68 jIl

*The latched data registers roist be consecutive, and the number can not be more than 33768 words

(EX. 0 ~ 32767 or 10000 ~ 42767)

3.3.3 Setting COM Port Parameters

When users click COM Port from the main category label and enters the setting page and two COM
port is setup for the model type, e.g. AHCPU5xx-RS2. The setting page will have two identical COM
port setting section but both are independent from each another.
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For notes on connecting hosts through COM ports, please refer to section 2.4.8 for more
information.

CPU themet- Basic ] Ethernet - Advance ]

COM 1

Communication Type RE232 -| €— o

Baud Rate 9600 v| bps g— @
DataLength Stop Bit
* Thit  Zhit @ 1hit  C Zhit

Patity
" Mone " Odd (+ Ewven < @

Transfer Mode

" RTU + ABCI
Btation Address 1 3: <4+ 9
Times of Auto-retry 3 3: <+ 6

Titne interval of Auto-retry (ms) 3000 3: < @

© Select types of communication with options including RS232, RS485, or RS422.

@ Select the Baud Rate for the communication speed. When choosing RS232, the baud rate
options include 9600 bps, 19200 bps, 38400 bps, 57600 bps and 115200 bps; while for RS485 or
RS422, the baud rate options include 9600 bps, 19200 bps, 38400 bps, 57600 bps, 115200 bps,
230400 bps, 460800 bps, or 921600 bps.

© Setup other communication protocol parameters. When RTU is selected for Transfer Mode, the
Data Length is limited to choosing 8 bit.

@ Setup COM Port station address for device identification during connection, while station
address on the same network is not allowed to be repeated, the setting range is 0 ~ 247.

When the port is referred to as a slave and there are other slaves connected, the port station
address cannot be set as 0 because it is defined as broadcast communication under the
communication protocol. However, when the Master assigns data transfer to Slave station
address 0, this means the data packets are transferred to all slave stations regardless of the
station address.

© When communication fails, the host will retry to connect. Users can setup the times of auto-retry
within the range of 0~20.

(@ Setup the time interval for auto-retry once communication fails. When PLC host retries to

connect due to communication failure, users need to setup the interval time to start the next
connection. The setting range is 100~65535 ms.

3.3.4 Setting Ethernet Parameters

Users need to select Ethernet - Basic from the main category label for parameter settings, e.g.
AHCPU5xx-RS2. The page provides parameter settings for Ethernet port. For information regarding
host connection through Ethernet, please refer to section 2.4.8. As for descriptions about the
Ethernet, please view other related documents or references.
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FU | comt o Ethemet - Basic Dithernet - Advance |

Fthernet Configuration

| IP Addressing Mode  [Static v |4_0
IF Address [oz1ea 11
Netmask Address [sszss2ss 0 4_@
Gateway Address ’W

Keep Alive Timer L] sec (1 ~ 633535 sec) |<—@

© Setup the IP address mode. When choosing Static, this means users can directly assign the IP
address parameter; but when selecting DHCP or BOOTP, this means the IP address is
managed by the dynamic allocation of DHCP or BOOTP.

@ When IP address mode is Static, users can setup the IP Address, Netmask Address, and

Gateway Address.
© When the host is not transmitting any data on the internet and already exceeds the Keep Alive

Timer, it will automatically disconnect.

If Dynamic is selected in the IP Addressing Mode drop-down list box, the IP address, the subnet
mask, and the gateway can be read from the CPU module by means of the following steps.
(1) Connect the CPU module to Ethernet, and make sure that the network and the CPU module

operate normally.

(2) Select Dynamic in the IP Addressing Mode drop-down list box, and download the parameter
to the CPU module.

(3) After Refresh is clicked, the system will read the IP address, the subnet mask, and the gateway
from the CPU module. The IP address, the subnet mask, and the gateway will be displayed in

the boxes.

IF & ddressing Mode

Yaant®

v,

For AH5x1 or AH560 redundant system series, users can use the DNS server to auto-retrieve the
DNS server address or adopt user-defined one or other server addresses.
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3.3.5 Setting Advanced Ethernet Parameters

If a CPU module is equipped with an Ethernet port, users can enter this page. For example,
AHCPU5Sxx-EN is equipped with an Ethernet port. After users click the Ethernet—Advance tab at
the top of the window, they can set devices on a network.

3.3.5.1 Ethernet - Advance: Filter

After users click the Ethernet - Advance tab at the top of the window, and the Filter tab at the
bottom of the window, they can set a filter. Devices on a network are filtered. The setting here
ensures that objects communicating with the CPU module are devices which are allowed.

CPU | COM Port | Ethernet - BasidC Ethemnet - Advance [D

[™ Enable [P Address Filter [~ Enable Static ARF Tahle

[1tem | StenPAddress | FndIP Address |4 [ 1tem IF &ddress MAC Address [+]

RIS = N N PO S
I R IS

=[O
=
= o
=]

[
B | =

Kl
Kl

TF | Email | Emsil Trigger | Email and Trigger Configuration | Socket | Wel

S

® Enable IP Address Filter
If the Enable IP Address Filter checkbox is selected, devices whose IP addresses are listed in
the table will be allowed to communicate with the CPU module, and the CPU module will discard
data packets sent from devices whose IP addresses are not listed in the table. The steps of
setting the function are as follows. Sixteen groups of IP address at most can be listed in the table.
(1) Selectthe Enable IP Address Filter checkbox, and then double-click an item which will be
modified or added in the table.
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able IF Address Filter
e |__Stert [} sddress

(2) Type a start IP address and an end address in the IP address Filter window. The start IP
address must be less than the end IP address. Finally, click OK.

® Enable Static ARP Table

Users can use this function to set MAC addresses and corresponding IP addresses. The MAC
address of every device is unique. If the MAC address of device A is known, the MAC address
can be bound to the IP address assigned to device A. The CPU module will regard the IP address
as the exclusive address of device A. Even if device B is assigned the same IP address, the CPU
module does not respond to device B. The steps of setting the function are as follows. Sixteen
groups of addresses at most can be listed in the table.
(1) Select the Enable Static ARP Table checkbox, and then double-click an item which will be
modified or added in the table.

able IF Address Filter
Item Btart IP Address End IP Address

(2) Type an IP address and a MAC address in the Static ARP Table window. Finally, click OK.

Take the tables below for example. After the setting in the tables is downloaded to the CPU
module, devices whose IP addresses are within the range between 192.168.1.1 and
192.168.1.50, and devices whose IP addresses are within the range between 192.168.1.100 and
192.168.1.150 are allowed to communicate with the CPU module if the CPU module operates.
Besides, if the CPU module communicates with a device whose IP address of 192.168.1.20, the
MAC address of the device must be BA:99:BA:14:BA:51. Likewise, if the CPU module
communicates with a device whose IP address is 192.168.1.21, the MAC address of the device
must be 00:10:5A:81:CA:FD.
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[v Enahle IP Address Filter [v Enable Static ARP Tahle
[ Ttem | StartIP Address EndIF Address 4] [ Item | IF Address MAC Address [+ ]
1 192.168.1.1 192.168.1.50 1 192.168.1.20 B&:99Ba:14B4:51
2 192.162.1.100 192.162.1.150 2 192.162.1.21 D0:10:54:81 CAFD
3 3
4 4
5 5
6 6
7 7
g g
a 9
10 10
11 = 11 .
12 12
13 13
= [~] - [~]

*1. If users want to know the MAC address of a CPU module, they can click Online Mode in HWCONFIG to view the
information about the CPU module (section 3.8.6), or click System Information in ISPSoft to get the information
about the CPU module connected and the status of the CPU module (section 17.6.1).

3.3.5.2 Ethernet- Advance: NTP

After users click the Ethernet—Advance tab at the top of the window, and the NTP tab at the bottom

of the window, they can enable the function of synchronizing the real-time clock in the CPU module
to an NTP server, and carry out the related setting. NTP will not be introduced here. Please refer to
related documents or manuals for more information about NTP.

CPU | COM Port | Ethemet - Basib Ethernet - Advance [

|

P
o

L

| K

Filterl( NTP )Email | Email Trigger | Email and Trigger Configuration | Socket | Web

Select the Enable NTP Client Service checkbox, and then set the related parameters.

@Enable HTF Client Service
NTP Server 192168 1.1 <+ 0

Update Cycle a0 nin (1 - 1440 muif) g a

Iv Daylight Saving

Btart Date 3 MESH - (Month £ Day)
End Date 9 MERE \d (Month / Day) 9
Time 0 hd C'Clack

Time Zone |(GMT-12:00) Eniwstok, Kwajalein - 4—9
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© Users can set the IP address of an NTP server. The CPU module corrects the time inside itself
by connecting to the server periodically.

@ Users can set an interval of correcting the time in the CPU module. If the interval is thirty minutes,
the CPU module will connect to the NTP server every thirty minutes.

© After users select the Daylight Saving checkbox, they can select a start date and an end data.

@ Users can select a time zone in the Time Zone drop-down list box.

3.3.5.3 Ethernet - Advance: Email

After users click the Ethernet - Advance tab at the top of the window, and the Email tab at the
bottom of the window, they can set the mail sending function.

CFU | COM Post | Ethermet - Basid Ethernet - Advance ))

I~ Enable Email Sending Function:

Ml ail Server Configuration Account [dentification
= i
Account Identification Info.
’7 o

Filter | NTP ( Email ail Trigger I Email and Trigger Configuration I Booket I Weh

After users select the Enable Email Sending Function checkbox, they can set the related
parameters.

@nahle Email Sending Function

M ail Berver Configuration A ceount Identifieation
" Ha * Yes <+ @
0 — P SMTP Server 192168, 1. 1
A ceount Identification Info.
@ — Pont 25 " Default(25)
Tser Name |ah1
@ — P Local Email Address | ahl@delta com.tw

T, [ 4_@
9 —P SMTF Subject AH Message

@ SMTP Server: Users can set the IP address of an SMTP server.
@ Port: Users can set a port for an SMTP server, or select the Default (25) option button.

© Local Email Address: Users can set the address of an actual sender. A local email address is

composed of 64 characters at most.

@ SMTP Subject: Data typed in the SMTP Subject box will be put at the front part of the subject of
every email. Only English letters, numerical digits, and special marks can be
typed in the box. The subject of an email is composed of 16 characters at most.

© Account Identification: If users want to authenticate themselves with a user name and a

password before logging in to an SMTP server, they can select the Yes
option button.
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® Account Identification Info.: Users can type a user name and a password which are used for

authentication. A user name is composed of 16 characters at
most, and a password is also composed of 16 characters at most.
If the parameters above are set correctly, and the computer can
connect to an SMTP server normally, users can click
Identification to test whether the user name and the password
are correct.

3.3.5.4 Ethernet - Advance: Email Trigger

After users click the Ethernet - Advance tab at the top of the window, and the Email Trigger tab at
the bottom of the window, they can set triggers for the sending of emails. Before setting triggers,
users have to click the Email tab, and select the Enable Email Sending Function checkbox.
Please refer to section 3.3.5.3 for more information.

CPU | COM Fort | Ethemnet - Basif_Ethemnet - Advance D

"Enable Email Sending Function" in "Email" tab has to be checked before the functions
in the list below start.

Trigger Configuration

ITtem Trigger Mame Trigger Mode Attached

Filtor | NTP | Bl el Trigges) Evail and Trigger Configoration | Sacket | Web

Triggers are listed in the Trigger Configuration table. Users can set eight triggers at most. If users
want to set or view a trigger, they can double-click the trigger in the table. The Trigger
Configuration window will appear.

Trigger Configuration
Ttem Trigger Hame Trigger Mode Attached
2 =
3 Trigger Configuration El
4 Trigger Setting Email Content
: _
. Trigger Name [~ User Message
— [comet ]
7 Trigger Interval |6 * 10 min (10 ~ 14400 mirg)
B
Trigger Mode [ EtrorLog

* CFU Etror Fatal Frror Only - Attachment

i CPU (3TOF <== RUM) &+ None

b

Bit Value Change ~ File
| Device | Humber | Bit | State | | J
" PLC Device

O Word Value Change

| Item | Device | Humber ‘Length‘
1
2

|Device | Humber | State | Value |

" Perindic Timer

(1) Type atrigger name and an interval of triggering the sending of an email in the Trigger Setting
section.
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Trigger Betling

Trigget Name Condition 1

Trigger Interval |6 * 10 mity (10 ~ 14400 tmity)

® Trigger Name
Users can type a trigger name in the Trigger Name box. Only English letters, numerical
digits, or special marks can be typed in the box. A trigger name is composed of 16
characters at most. If the sending of an email is due to this trigger, the trigger name will be
put in the subject of this email.

® Trigger Interval
Users can set an interval of triggering the sending an email. Ten minutes are taken as a unit.
If the condition of triggering the sending of an email is met, the system will send the email
every specific period of time, and the email will not be sent within the intervals.

(2) Select a condition of triggering the sending of an email in the Trigger Mode section.
Trigger Mode

v CPU Error Fatal Error Only -

£ CPU (STOF <== RUN)

" Bit Value Change

[Deviee | Number | Bit | state |

" Word Value Change

|Device ‘ MNumber | State ‘ Value |

" Perindic Timer

® CPU Error
If an error occurs in the CPU module, the condition of triggering the sending of an email is
met. Please refer to operation manuals for more information about errors occurring in CPU
modules. After users select the CPU Error option button, they have to select Fatal Error
Only or All Errors in the drop-down list box at the right side of the option button.
(a) Fatal Error Only: If a fatal error occurs in the CPU module, the condition of triggering the
sending of an email is met.
(b) All Errors: If an error occurs, the condition of triggering the sending of an email is met.
® CPU (STOP<=>RUN)
When the CPU module begins to run, or when the CPU module stops running, the condition
of triggering the sending of an email is met.
® Periodic Timer
An email is sent periodically. How often an email is sent depends on the interval typed in the

Trigger Interval box in the Trigger Setting section.
Trigger Selting

Ttigger Name Condition 1

Trigger Interval |6 #10 ity (10~ 14400 mirs)

® Bit Value Change

If the state of a bit device specified meets a condition set, the sending of an email will be
triggered. For example, if X0.0 is turned from OFF to ON, the condition of triggering the
sending of an email will be met. If users want to set a condition, they can double-click the
table under the option button to open the Trigger Mode window.
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|Dev1c:e | Humber | Bit | State ¢
'\ 0
&+ Bit Value Change

© Device: Users can select a device type in the Device drop-down list box.

® Number & Bit: Users can type a device address in the Number box. If the device type
selected is X/Y/DI/L, the users have to specify a bit number.
© state: Users can select Rising or Falling in the State drop-down list box.

® Word Value Change
If the value in a device specified meets a condition set, the sending of an email will be
triggered. For example, if the value in DO is larger than 10, the condition of triggering the
sending of an email will be met. If users want to set a condition, they can double-click the
table under the option button to open the Trigger Mode window.

=

|Dev1c:e | Number | State ‘ Value ¢
& Word Value Change
. +~—©

© Device: Users can select a device type in the Device drop-down list box.

® Number: Users can type a device address in the Number box.

© state & Value: Users can set s condition of triggering the sending of an email here.
(3) Select the User Message box or the Error Log box in the Email Content section. If a
user-define message is the text of an email, the User Message box is selected. If an error log
in the CPU module is the text of an email, the Error Log box is selected. Only English letters,

numerical digits, and special marks can be typed in the box under the User Message box.
Einail Content

v UserIiessage

Error Occurred 11

I~ ErrorLog

(4) Select the None option button, the File option button, or the PLC Device option button in the
Attachment section. If users want to set an attachment, they have to make sure of the
maximum size of an email which the CPU module allows. Please refer to operation manuals
for more information.
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Attachment

" None

" File!

|Exr0r Log j
" PLC Device

| Item | Device | Number |Length|
1
2

® None
If this option button is selected, no attachment will be inserted.

® File
Users can select an error log in the memory card, or the system backup file in the memory
card as the attachment of the email.

® PLC Device
If this option button is selected, the system automatically retrieves the states of the devices,
or the values in the devices listed in the table as the attachment when the email is sent. After
this option button is selected, users can double-click the table to open the Attachment
window. Two groups of devices at most can be set. For example, if the condition is met, the
values in DO~D9 will be sent as an attachment.

(5) After all the setting is complete, users can click OK to create the trigger.
Trigger Configuration

Item Ttigger Name Trigger Mode

3.3.5.5 Ethernet - Advance: Email and Trigger Configuration

After users click the Ethernet—Advance tab at the top of the window, and the Email and Trigger
Configuration tab at the bottom of the window, they can set the relation between triggers for the
sending of emails and receivers. Before setting the function here, the users have to click the Email
tab, select the Enable Email Sending Function checkbox, click the Email Trigger tab, and set at
least one trigger. Please refer to section 3.3.5.3 and section 3.3.5.4 for more information.
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CPU | COM Port | Etherriet - Basi€ Ethetnet - Advance D

"Enable Email Bending Function” in "Email" tab has to be checked before the functions in the list helow start. The conditions of transmitting an
etnail can be getin the following table. Eight receivers at most can he set. The steps for setting each group of conditions of transmitting an email
are as follows:

(1) Check the conditions of transmitting this email in Trigger]~Trigger 8 at the left.
() Enter the receiver's email address in Email Address column at the right.

Afterthe procedures of setting the conditions and downloading themm to the PLC are completed, the PLC will automatically transmit the etmail to

Configuration
Trigger1 |Trigger 2 |Trigger 3 |Trigger 4|Trigger 5 |Trigger 4] |Trigger 7 |Trigger 8| | Email A ddtess
Email 1 r r r r r [~ r [~
Email 2 r r r r r ] r ]
Email 3 r r r r r I r I
Email 4 r r r r r ] r ]
Email 5 r r r r r I r I
Email 6 r r r r r ] r ]
Email 7 r r r r r ] r ]
Email 8 r r r r r I~ r I~

Filter | NTP | Email | Email Trigge Email and Trigger Configuratio Socket | Web

First, type the email addresses of receivers in the Email Address column. Eight email addresses at
most can be set for the CPU module, and every email address is composed of sixty-four characters
at most. Then, select triggers corresponding to receivers. If email addresses or triggers are not set,
the corresponding selection positions are gray.

For example, if the condition represented by trigger 1 or the condition represented by trigger 4 is met,
the system will automatically send the emails to user_l@delta.com.tw. If the condition represented
by trigger 2 or the condition represented by trigger 5 is met, the system will automatically send the
email to user_2@delta.com.tw. If the condition represented by trigger 1 is met, the system will
automatically send the email to user_l@delta.com.tw, and user_4@delta.com.tw.

Configuration
Trigger 1 |Trigger2|Trigger3|Trigger 4|Trigger5|Trigger6|Trigger?|Trigger8| | Email & ddress |
Email 1 v r r v - r r - user_l@delta.comtw
Email 2 r ™ r r [v r r r user_2(@delta com tw
Email 3 r r r r - r r -
Email 4 v r r r r r r r user_4@delta.com.tw
Email 5 r r r r - r r -
Email 6 r r r r - r r -
Email 7 - ™ r r - r r -
Email 8 r r r r - r r -

3.3.5.6 Ethernet - Advance: Socket

After users click the Ethernet - Advance tab at the top of the window, and the Socket tab at the
bottom of the window, they can set the parameters for sockets through which data is transmitted.
This function has to be used with specific applied instructions. Please refer to AH500 Programming
Manual for more information.

Sockets will not be introduced here. Please refer to related documents or manuals for more
information about sockets.
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CPU | COMPort | Ethemet - Basic(Etheraet - Advance | )

[~ Enable Socket Function
TCP Zocket Connection TDF Bocket Connection

| Ttem | Remote IP Remote Port | Length | | Ttem | Remote [P Remote Port ‘ Length |

BRI T
BRI T

Filter | NTP | Email | Email Trigger] Email and TriggerConﬁguratior(

An AH500 system supports the transmission of data between the CPU module and other CPU
modules or devices by means of the creation of sockets, and supports TCP and UDP. Users can set
eight TCP connections and eight UDP connections. If users want to set a TCP connection, they
have to select the Enable Socket Function checkbox, and double-click an item in the TCP Socket
Connection table to open the TCP Socket Configuration window. If the users want to set a UDP
connection, they have to select the Enable Socket Function checkbox, and double-click an item in
the UDP Socket Connection table to open the UD Socket Configuration window.

Enable Socket Function
TCP Socket Connection TCP Socket Configuration 3]

TCF Socket Connection

Remote [F Remote Fort oK Length

Remaote IP 192.168. 1. 1
Eemote Port a
Local Port a

Send Data Length b @~s00words)
SendDataAddress  |D | [0

Receive Datalength [0 (0~ 300 words)
Receive Data Address |[D | [0

Keep Alive Timer [0 sec(l~655355e0)

IR RE- NN Yy

The parameters in the TCP Socket Configuration window are the same as the parameters in the
UDP Socket Configuration window except that there is no Keep Alive Timer parameter in the
UDP Socket Configuration window. The parameters in the TCP Socket Configuration window are
described below.
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TCP Socket Configuration

TCP Socket Connection

Femote IP 192 168, 1.100

1
@ Remote Port 65500

@ Local Port 65501

9 Send Data Length 10 @300 words)
@ Hend Data Address m ’U—

@ Receive Data Length ’20— (0 ~ 500 words)
0 Receive Data Address m ’W

@ Keep Alive Titer ’ﬁﬂ— sec (1 ~ 65535 ged)

@ Users can set a remote IP address.

@ Users can set a communication port used by the remote device for this TCP connection. The
port number must be within the range between 0 and 65535.

© Users can set a communication port used by the local CPU module for this connection. The port
number must be within the range between 0 and 65535.

@ Users can set the length of data which will be sent by the local CPU module. The length must be
within the range between 0 words and 500 words.

© Uses can set an initial device in the CPU module where data which will be sent is stored.

(® Users can set the length of data which will be received by the local CPU module. The length
must be within the range between 0 words and 500 words.
@ Uses can set an initial device in the CPU module where data which will be received is stored.

@ Users can set a maximum keep alive time for the connection. If no data is transmitted, and the
keep alive period has elapsed, the CPU module will terminate the connection automatically.

The port number used by the local CPU module and the port number used by the remote device can

not be the same, and the devices where data which will be sent is stored cannot overlap the devices

where data which will be received is stored. If the IP address of the remote device is 192.168.1.100,

the port number used by the remote device is 65500, and the port number used by the local CPU

module is 65501, the remote device and the local CPU module can transmit data through this TCP

connection.

If the local CPU module wants to send 10-word data to the remote device, the data will be stored in

D0~D9 before the data is sent. If the local CPU module receives 20-word data from the remote

device, the data will be stored in D100~D119.

If the length of data received is larger than the length set, the first 20-word data will be stored in

D100~D119, and the data after the first 20-word data will be discarded. Likewise, if the length of

data received is less than the length set, the data will be stored in the devices starting from D100,

and the values in devices where no new data is stored will be retained.

If no data is transmitted, and 60 seconds have elapsed, the CPU module will close the socket, and

terminate the connection.

3.3.5.7 Ethernet - Advance: Web

After users click the Ethernet - Advance tab at the top of the window, and the Web tab at the
bottom of the window, they can enable the built-in web monitoring function of the CPU module.
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CPU | COM Port | Ethemet - BasicCEthemet - Advance D

N
Fiter | NTP_| Email | Email Trigget | Emeil and Trigger Configuration | Socket( web |)

Select the Enable Web Function checkbox, and the select a language which will be adopted in the
drop-down list box. After the parameter is downloaded to the CPU module correctly, users can view
the built-in web pages in the CPU module by means of a web browser.

@a\:le Web Function
Language |Eng]ish j

Chinese (3implified)
Chinese (Tradition

*. Please refer to operation manuals for more information about the web monitoring function.

3.3.5.8 Ethernet - Advance: Data Exchange

The CPU module of AH5x0-EN series contains the data exchange function based on MODBUS
TCP. The built-in function is enabled by clicking the Ethernet - Advance tab at the top of the
window, and the Data Exchange tab at the bottom of the window as below.
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CPU | COM Port | Ethernet - Basid( Ethernet - Advance |)

Data Exchange Setup

Mode |Pr0g:ra.m Control j

Item | Enable | Remote Address IF Address Local Address Remote Address Ouantity Add

Move Down

Delete

Filter | NTP | Email | Emeil Trigger | Email and Trigger Configuration | Socket | Web (‘Diata Exchange

If users open this page of the PLC Parameter Setting window for the first time, the table is blank due
to no data set. A new row of data can be inserted by clicking Add. Double-click the data so that the
data setting window is opened.

PLC Parameter Setting §|
5O

CPU | COMPort | Ethemet - Basic Ethemet - Advance |

0-" Mode ‘Prog:ramContml jl

Data Exchange Setup

Item | Enahle Remote Ad. IP Address Looal Address Remote Address Caantity
0.0.0.0 =
o

Filter | NTP | Email | Emeil Trigger | Email and Trigger Configuration | Socket | Web  Data Exchange

Offline Driver2, [UEE: COMY]

@ Set the starting mode to Program Control; PLC decides whether the set data exchange is

performed. PLC Run means that the set data exchange will be performed automatically when
PLC is in RUN state. Always Enable means that the data exchange will be performed
constantly when PLC is powered on.

@ A new data exchange table will be added in area €@ by clicking Add. The present data

exchange table selected will be moved up or down by clicking Move Up and Move Down. The
present data exchange table selected will be deleted by clicking Delete. The present data
exchange table selected will be copied by clicking Copy and then can be pasted to the last row.

©® The data exchange table is listed and explained as below.
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Name Description
Item The number of the block for data exchange

To select whether to enable the data exchange table when the data
Enable .

exchange is performed.
Remote
Station The target slave station address of the data exchange table
Address
IP The target IP address of the data exchange table. One IP address can be
Address set for multiple data exchange tables.
Local , .

The device address range used by the master in the data exchange table
Address

[<<] :Input; the data block where the master read a slave
<< /[>> .
[>>] : Output; the data block where the master write to a slave

The device address range used by a slave in the data exchange table
Remote . . . . . . .
Address The device range will be m_hexadeumal dlsple}y, if the slave in the data

exchange table is a user-defined MODBUS Device.

. The size of the data exchange table, which is basically consistent with the

Quantity )

result calculated from the device range.

Double click a data exchange table to be set so as to open the Item window as below. Select the
checkbox of Enable to enable the data exchange table in the mode mentioned above. Remote
Address is the address of the target slave for data exchange. The Shortest Update Cycle is the
period for data exchange of the data exchange table. If the target device does not make any
response within the time specified by Connection Timeout, that is timeout. The master can
complete the read and write in a command to improve the efficiency of data exchange by selecting
Support Read/write synchronization (Function code 0x17) in which the specific MODBUS
function code is used. Please make sure that all devices in data exchange support MODBUS
function code for read and write synchronization. Otherwise, the read and write will fail on account of
the failure to identify the function codes after the command from the master is received. Device

Type is the model of a slave including Delta PLC and standard MODBUS devices.
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PLC Parameter Setting 3]
N
CPU | COM Port | Ethemet - Basic Ethemet - Advance I
Mo Frogram Contral ~
Data Exchange Setup
Ttem Enable Remote Ad. 1P Address Local A ddre: 2 Remote Address Quantity [ add |
0ooon
Iteml ﬁ‘
[~ Enable
Blave Address 0 The Shortest Update Cyrele (ms) 10
IP Address 0.0.0.0 Connection Timeout (ms) 50
[~ Support Readfwrite synchronization (Function Code: Dx17)
Filt NTF | Edf

Device Type |AH 500 j

Input

|Local Start Address (0~65535) [ Remote Start 4 ddress 200~ X511.15 | Quantity (oity

-

[o] 0 | Coil =~ o oo ] 0

Cutput

|Local Start Address (0~63535) \ Remote Start Address Y00~ X311.15 | Guantity (sit)

[o] 0 ¥ Coil =~ o o] [

® Input

AH5x0-EN series read data from a remote device.

Local Start Address: The start address of D data registers where AH5x0-EN series store data
Remote Start Address: Device type and start address of the remote device to be read
Quantity: Data length of input

® Output

AH5x0-EN series write data to a remote device.

Local Start Address: The start address of D device type of the source data of AH5x0-EN series
Remote Start Address: Device type and start address of the remote device to be written
Quantity: Data length of output

While the data exchange setup for AH5x0-EN series is conducted, the local device can only be the
data register D with Word as the unit. And remote address can take Bit as the unit which may not
start from 0, such as D0.3 as a remote start address. If the set data size is not a multiple of Word,
the local devices will still make the data exchange via corresponding bits and the bits which are not
in data exchange will keep original state. For example, if the data in remote MO~M19 is read to local
data register DO~D1, the data will be stored in D0.0~D1.3 in order and D1.4~D1.15 will keep their
original states.

3.3.6 Data Exchange Setup - COM & Ethernet

For AH5x1 and AH560 redundant system series, there are additional tabs for data exchange setup
in PLC Parameter Setting window, such as two COM ports or one COM port and one Ethernet port
according to different models. The parameters are set on the tabs of Data Exchange Setup-COM1
and Data Exchange Setup-COM2, or Data Exchange Setup-COM and Data Exchange
Setup-Ethernet for making the data exchange table of the communication port built in AH5x1 series.
AH5x1 and AH560 redundant system series working as the master exchanges data with the remote
devices working as slaves via COM1 and COM2 based on MODBUS protocol or via Ethernet port
based MODBUS TCP protocol.
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00—

Set the starting mode to Program Control; PLC decides whether the set data exchange is
performed. PLC Run means that the set data exchange will be performed automatically when
PLC is in RUN state. Always Enable means that the data exchange will be performed
constantly when PLC is powered on.

@ A new data exchange table will be added in area €@ by clicking Add. The present data

©

exchange table selected will be moved up or down by clicking Move Up and Move Down. The
present data exchange table selected will be deleted by clicking Delete. The present data
exchange table selected will be copied by clicking Copy and then can be pasted to the last row.

The data exchange table is listed and explained as below.

Name Description

Item The number of the block for data exchange
To select whether to enable the data exchange table when the data

Enable exchange is performed.

Remote The slave station address of the data exchange table, One address can be
Station set for multiple data exchange tables. It is a station address for COM1 and
Address COM2 tabs and IP address for Ethernet tab.

Local Address | The device address range used by the master in the data exchange table

[<<]| : Input; the data block where the master read a slave

<</>> [>>] : Output; the data block where the master write to a slave
The device address range used by a slave in the data exchange table
Remote . . . . . . .
Address The device range will be |n_hexadeC|maI dlspla_ly, if the slave in the data
exchange table is a user-defined MODBUS Device.
. The size of the data exchange table, which is basically consistent with the
Quantity

result calculated from the device range.
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3.3.6.1 Data Exchange Setup - COM1/COM2 /COM

On the page of tab Data Exchange Setup - COM1, Data Exchange Setup - COM2, or Data
Exchange Setup - COM, double click a data exchange table which is to be set to open Item window
as below. Select the checkbox of Enable to enable the data exchange table in the mode mentioned
above. Remote Address is the address of the target slave for data exchange. The Shortest
Update Cycle is the period for data exchange of the data exchange table. If the target device does
not make any response within the time specified by Connection Timeout, that is timeout. The
master can complete the read and write in a command to improve the efficiency of data exchange
by selecting Support Read/write synchronization (Function code 0x17) in which the specific
MODBUS function code is used. Please make sure that all devices in data exchange support
MODBUS function code for read and write synchronization. Otherwise, the read and write will fail on
account of the failure to identify the function codes after the command from the master is received.
Remote Device Type is the model of the target slave including Delta PLC and standard MODBUS
devices.

® Input

AH5x1-EN series read data from a remote device.

Local Start Address: Device type and start address of devices where AH5x1-EN series store data;
Remote Start Address: Device type and start address of the remote device to be read;

Quantity: Data length of input

® Output
AH5x1-EN series write data to a remote device.
Local Start Address: Device type and start address of the source data of AH5x1-EN series;

Remote Start Address: Device type and start address of the remote device where data are to be
written;
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Quantity: Data length of output

3.3.6.2 Data Exchange Setup - Ethernet

On the page of tab Data Exchange Setup - Ethernet, double click the data exchange table to be
set so as to open the Item window as below. The settings are almost same as that for Data
Exchange Setup - COM except the target slave model option in Device Type which contains Delta
PLC and standard MODBUS TCP equipment as well as IP address for typing the IP of remote
slaves. For other settings, refer to the content of Data Exchange Setup - COM.

2N
2\

Select the check box of Apply to all to the right side of The Shortest Update Cycle and
Connection Timeout and then click OK. The settings for The Shortest Update Cycle and
Connection Timeout will be written to other data tables on the tab Data Exchange Setup -
Ethernet. Users could set a data exchange table separately without selecting the check box of
Apply to all.

3.4 Parameter Settings for AHXXEMC Series PLC

3.4.1 Open the PLC Host Parameter Setting Page

Double click the CPU icon on the system configuration area after HWCONFIG is started and the
PLC Parameter Setting window will be opened automatically. The parameters to be set and
window display may look different for different CPU models.

A Please refer to the operation manual for the CPU module before the parameters in a CPU

module are set and learn about the impact of the set parameters on the CPU module and
the entire system so as to prevent from the system and personnel damages.
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*. Download the parameter settings to the host. For ways to download, please refer to section 3.8.4.

Description

of the device

The parameters are classified into several types. The users can click the primary tabs at the top of
the window. Users should switch to different setting pages according to main types of parameters
and their secondary tables. Parameter name, Value, Unit, Default, Minimum and Maximum are
listed in the title bar in the right of the window.
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3.4.2 Options

3.4.2.1 Options - System Information

Device Info, System Parameter, Latched Device Range and IO Interrupt under Device Setting,
click the Options tab to see these options.

There are Name box where maximum 31 characters can be input and Comment box where
maximum 63 characters can be input on the Device Setting page. There is no special restriction on
the input characters; special marks and spaces are allowed to use here. However, the users have to
note that one Chinese character occupies two characters.

When adding an ISPSoft project, the system will use the project name as the host name by default
and appear next to the model name in Project section to be re-defined.
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Users can identify a device by means of the name of the device. When several devices are
connected to one network, users can check whether a device connected to the computer is the
device they expect by checking the device name. To prevent errors, when users are downloading or
uploading data or operating online, the system will check whether the label name of the host and the
label name in the Project section is the same or not, when the name of the CPU module is different
from the name attached to the model in the project management area.

The following image is the System Parameter setting page that provides drop-down lists to choose
or box to input appropriate parameter values.

® Clear Non-latched Device (STOP --> RUN)

If the Clear Non-latched Devices checkbox is selected, the states of the non-latched devices and
the values in the non-latched devices will be cleared when the CPU module begins to run.

® Y state (STOP2>RUN)

When the CPU module begins to run, the states of the Y devices are OFF, retained, or restored to
the states before the CPU module’s stopping running.

> Clear: Set all Y device output to OFF.
> Retain Present State: Output retain to present state.
> Previous State before STOP: Restore Y device output to previous state before STOP.
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® Error Log Storage Location

Users set the place where the error log is stored.

» PLC: If the PLC option button is selected, twenty error logs at most can be stored in an AHXXEMC
series CPU module. If there are more than twenty error logs, the oldest error log will be overwritten
by the latest error log.

» PLC and PLC CARD: Ifthe PLC and PLC CARD option button is selected, and there are more
than twenty error logs, the oldest error log will be moved to the memory card before the overwritten.

® CPU Operation during an occurrence of a Program Error

If an error occurs in the program, the status of the CPU may change.
» Stop: CPU switches to the Stop state.

» Continue: CPU retains the state before any error occurs.

® CPU Operation during an occurrence of a Bus Fault

If an error occurs on the bus, the status of the CPU may change.
» Stop: CPU switches to the Stop state.

» Continue: CPU retains the state before any error occurs.

® Remote Reset Enable

The function is for setting whether to allow the remote system to reset the CPU. After users select
the function and download the parameter to the CPU module, they can click Format PLC

Memory... on the PLC menu, and select the Reset PLC Memory (Factory Setting) option button
in the Format PLC Memory window in ISPSoft.

» Useless: The function is not used.

» Use: The function is used.

Id

LC | Tools Window Help

&7 Transfer ¥
System Semrity » Format PLC Memory
Oy Rm Ctel+F11
Q tep CurleF1Z Clear Al Program Memory
Omline Mode Ctrl+Fd T
7 " il (+) Reset PLC Memory (Factory Settmg);l
& Mew Devices Table
= F t PLC M.
[5_romat rcttenry oK Cancel |

System Log \
System Information...  Ctrl+4Alt+]

® Constant Communication Response Enable

If this function is not enabled, commands received through the communication ports will not be
processed until the scan cycle is complete. If this function is enabled, commands received through
the communication ports will be processed every specific period of time. However, the scan
procedure is interrupted when the system processes commands received through the
communication ports. As a result, the scan time will be prolonged if this function is enabled. Please
make sure that the operation of the system is not affected when this function is used.

® Watchdog Timeout

Users can set a timeout during which the program is scanned. If the scan procedure cannot be
completed within the time set for some reason, the watchdog timeout occurs, and the CPU module
will be in an erroneous condition.

® Constant Scan Enable

Users can select the Constant Scan Enable checkbox, and set a scan time. If the actual scan time
is less than the setting value, the CPU module will not carry out the next scan until the setting value
is reached. If the actual scan time is larger than the setting value, the CPU module will ignore the
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setting value, and operate according to the actual scan time.

® Scan Time

Users type the period of scan time in the box if the preceding constant scan is enabled. User should
notice that the timeout error will occur once the CPU starts to run if the set scan time is larger than
Watchdog Timeout value.

® Interval Interrupt Time O

Users can set interval timers to trigger the interrupts. The function is used with Timer Interrupt O in
the work management together. Please refer to chapter 5 for more information.

® Interval Interrupt Time 1

Users can set interval timers to trigger the interrupts. The function is used with Timer Interrupt 1 in
the work management together. Please refer to chapter 5 for more information.

® Interval Interrupt Time 2

Users can set interval timers to trigger the interrupts. The function is used with Timer Interrupt 2 in
the work management together. Please refer to chapter 5 for more information.

® High-speed Scan
Users can set interval timers to trigger the interrupts. The function is used with Timer Interrupt 3 in
the work management together. Please refer to chapter 5 for more information.

Users set a range of latched devices on tab Latched Device Range.

Click button -=-+| to open the setting window where users can set the start and end addresses of the
device. If users need to use the function of non-latched area, users need to set up the start and end
addresses of the device in the range of zero and the maximum. After the users click Default, the
setting will be restored to the default values. After the users click Clear, the value in the box will be
cleared to -1 and the function of the non-latched area will be disabled. Exit from the window by
clicking OK to save the settings and Cancel to give up the settings.
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Tab 10 Interrupt is for users to select X input points and enable the IO interrupt input function.

X0.8~X0.15 will match 10 interrupt 1~ IO interrupt 8 separately. Please refer to chapter 5 for more
information.

Tab 10 Input Filter is for users to setup 10 input filter to reject unwanted signals.

® X Input Single Filter Time
Users can set up the response time for pulse input, the setting range is 0~1000, unit is ms. Any
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response time below the set-up value will be filtered.

® X Input Single Hardware Frequency Filter Time

Users can set up the value to be lower than the time of X input Duty On, the setting range is
1~50000000, unit is 0.1us. Base on the time (t) and frequency filter equation (f) * =

(Hz), if the frequency input signal is higher than the (f) * value, the input signal will be
filtered. (For more information on the time of X input Duty On, please refer to AH Motion
Controller operation manual.)

*. About 10 Input Filter, please refer to AH Motion Controller operation manual for more information.

3.4.2.2 Option - COM Port Setting

AHxXEMC is equipped with 2 COM ports. Users could set COM1 and COM2 parameters individually
by clickihng COM Port 1 Setting or COM Port 2 Setting under COM Port Setting. COM1 is for
uploading and downloading; COM2 is for Data Exchange.

The setting items are same for the two COM ports.

@ Set the communication protocol of the COM port.

@ Users can set a station address at the communication port. A device on a network can be

identified by means of the station address of the device. The station address of a device on a
network cannot be the same as the station address of another device on the same network.

If the communication port functions as a slave, and there are other slaves, the station address of
the communication port cannot be 0. Station address 0 has the meaning of broadcasting to all
slaves in a communication protocol. If a master specifies in a data packet that data must be sent
to station address 0, the data will be sent to all slaves. No matter what station addresses of these
slaves are, these slaves will receive the data packet.

@© If the sending of a command fails, the CPU module will retry the sending of the command. Users
can set the number of times for sending a command in the box of Times of Auto-retry and set
the time interval to retry the sending of a command in the box of Time Interval of Auto-retry

when the communication fails. PLC module will make a next connection with the network every
the set interval time when the communication fails.

3.4.2.3 Option- Ethernet Setting

The users can set the communication parameters for the Ethernet port in the CPU module in this
page. They can refer to section 2.4.7 for more information about connecting to a CPU module
through the Ethernet port on the CPU module, and refer to other related documents or manuals for

3-89



ISPSoft User Manual

more information about Ethernet.

Users can set an IP addressing mode for the CPU module. If users select Static in the IP
Addressing Mode drop-down list box, they can specify an IP address. If Dynamic is selected in the
IP Addressing Mode drop-down list box, an IP address is assigned dynamically.

3.4.2.4 Option- Ethernet Setting (advanced)

On the Ethernet Port Advance Setting window, users can set the parameters for sockets through
which data is transmitted. In the Socket table, users can set COM port parameters for data
transmission via Ethernet. However, the function should be applied with specific API instructions.
Please refer to AHXXEMC Series Instrunction Manuals for more information. Sockets will not be
introduced here. Please refer to related documents or manuals for more information about sockets.

The system for AHXXEMC series modules supports the data transmission between the CPU
module and other CPU module or device via a socket as well as TCP and UDP protocols in each of
which 8 groups of connections can be set. Users should select Socket Function Enable checkbox
before any setup and then do other setting in TCP and UDP setting pages respectively.

The parameters in the TCP Socket Setting are the same as the parameters in the UDP Socket
Setting except that there is no Keep Alive Timer parameter in the UDP Socket Setting. The
parameters in the TCP and UDP Socket Setting are described below.
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® Remote IP: Users can set a remote IP address.

® Remote Port: Users can set a communication port used by the remote device for this TCP
connection. The port number must be within the range between 0 and 65535.

® Local Port: Users can set a communication port used by the local CPU module for this
connection. The port number must be within the range between 0 and 65535.

® Send Address: Users can set the length of data which will be sent by the local CPU module.

® Send Length: Uses can set an initial device in the CPU module where data which will be sent is
stored. The length must be within the range between 0 and 1000 bytes.

® Receive Address: Users can set the length of data which will be received by the local CPU
module.

® Receive Length: Uses can set an initial device in the CPU module where data which will be
received is stored. The length must be within the range between 0 and 1000 bytes.

® Keep Alive Timer: Users can set a maximum keep alive time for the connection. If no data is
transmitted, and the keep alive period has elapsed, the CPU module will terminate the
connection automatically.

The port number used by the local CPU module and the port number used by the remote device

cannot be the same, and the devices where data which will be sent is stored cannot overlap the

devices where data which will be received is stored. If the IP address of the remote device is

192.168.1.100, the port number used by the remote device is 65500, and the port number used by

the local CPU module is 65501, the remote device and the local CPU module can transmit data

through this TCP connection.

If the local CPU module wants to send 10-word data to the remote device, the data will be stored in
D0~D9 before the data is sent. If the local CPU module receives 20-word data from the remote
device, the data will be stored in D100~D119.

If the length of data received is larger than the length set, the first 20-word data will be stored in
D100~D119, and the data after the first 20-word data will be discarded. Likewise, if the length of
data received is less than the length set, the data will be stored in the devices starting from D100,
and the values in devices where no new data is stored will be retained. If no data is transmitted, and
30 seconds have elapsed, the CPU module will close the socket, and terminate the TCP connection.

3.4.3 Data Exchange - COM2 &Ethernet

After users click the tab Data Exchange - COM and Data Exchange — Ethernet, the parameters for
making the data exchange table of the communication port built in AHXXEMC series can be set.

AHxXEMC series as a master exchanges data with remote devices working as slaves via COM2
based on MODBUS protocol or via Ethernet port based on MODBUS TCP protocol.
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00—

As one start mode, Program Control decides whether the set data exchange is performed.
PLC Run means that the set data exchange will be performed automatically when PLC is in
RUN state. Always Enable means that the data exchange will be performed constantly when
PLC is powered on.

@ A new data exchange table will be added in area €@ by clicking Add. The present data

exchange table selected will be moved up or down by clicking Move Up and Move Down. The
present data exchange table selected will be deleted by clicking Delete. The present data
exchange table selected will be copied by clicking Copy and then can be pasted to the last row.

© The data exchange table is explained as below.

Name Description
Item The number of the block for data exchange

To select whether to enable the data exchange table when the data
Enable .

exchange is performed.
Remote The slave station address of the data exchange table, One address can be
Station set for multiple data exchange tables. It is a station address for COM2 tab
Address and IP for Ethernet tab.

Local Address

The device address range used by the master in the data exchange table

[<<]| : Input; the data block where the master read a slave

<</>> [>>] : Output; the data block where the master write to a slave
The device address range used by a slave in the data exchange table
Remote . . . . . . .
Address The device range will be |n.hexadeC|maI dlspla_ly, if the slave in the data
exchange table is a user-defined MODBUS Device.
: The size of the data exchange table, which is basically consistent with the
Quantity

result calculated from the device range.

3.4.3.1 Data Exchange - COM2

On the page of tab Data Exchange - COM2, double click a data exchange table which is to be set to
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open Iltem window as below. Select the checkbox of Enable to enable the data exchange table in
the mode mentioned above. Remote Address is the address of the target slave for data exchange.
The Shortest Update Cycle is the period for data exchange of the data exchange table. If the target
device does not make any response within the time specified by Connection Timeout, that is
timeout. The master can complete the read and write in a command to improve the efficiency of data
exchange by selecting Support Read/write synchronization (Function code 0x17) in which the
specific MODBUS function code is used. Please make sure that all devices in data exchange
support MODBUS function code for read and write synchronization. Otherwise, the read and write
will fail on account of the failure to identify the function codes after the command from the master is
received. Device Type is the model of the target slave including Delta PLC and standard MODBUS
devices.

£
'\

~

® Read

AHXxXEMC series read data from a remote device.

Local Start Address: Device type and start address of devices where AHXxXEMC series store data;
Remote Start Address: Device type and start address of the remote device to be read;

Quantity: Data length of input

® \Write

AHXxXEMC series write data to a remote device.

Local Start Address: Device type and start address of the source data of AHXXEMC series;
Remote Start Address: Device type and start address of the remote device where data are to be
written;

Quantity: Data length of output

3.4.3.2 Data Exchange - Ethernet

On the page of tab Data Exchange - Ethernet, double click the data exchange table to be set so as
to open the Item window as below. The settings are almost same as that for Data Exchange -
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COM2 except the target slave model option in Device Type which contains Delta PLC and standard
MODBUS TCP equipment as well as IP address for typing the IP of remote slaves. For other
settings, refer to the content of Data Exchange - COM2.

2N
'\
94

Select the check box of Apply to all to the right side of The Shortest Update Cycle and
Connection Timeout and then click OK. The settings for The Shortest Update Cycle and
Connection Timeout will be written to other data tables on the tab Data Exchange- Ethernet. Users
could set data exchange tables separately without selecting the check box of Apply to all.

3.5 Parameter Settings for AS Series PLC

3.5.1 Open PLC Host Parameter Setting Page

After users double-click the CPU module in the system configuration area, the PLC Parameter
Setting window will appear. The parameters which can be set vary with the models or hardware of
the CPU modules. For more information on the hardware and operations of the CPU modules,
please refer to the manuals and catalogues of the PLC series.

A Before the parameters in a CPU module are set, users have to refer to the operation

manual for the CPU module. To prevent damage to the system or staff, the users have to
make sure of the effect that the parameters which are set have on the CPU module and the

whole system.

*. The parameter settings are not effective until they are downloaded to the CPU module. Refer to
section 3.8.4 for the download method.
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The parameters are classified into several tabs on the setting page. The users can click the primary
tabs at the top of the window. Users should switch to different setting pages according to main types
of parameters and their secondary tables.
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3.5.2 Options

3.5.2.1 Options - System Settings

System Information, System Parameter, Latched Device Range, Input Point Filter Time,
Limited Point Setting and Daylight Saving Timing under System Settings appear after users
click the Options tab.

There are only PLC Name box where maximum 15 characters can be input and Comment box
where maximum 31 characters can be input on System Information page. There is no special
restriction on the input characters; special marks and spaces are all allowed to use here. However,
the users have to note that a Chinese character occupies two characters.

After an ISPSoft project is created, the project name will be taken as the default name of the CPU
module, and the default name of the CPU module will be attached to the model in the project
management area. Users can change the default name of the CPU module in the Name box later.
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Users can identify a device by means of the name of the device. When several devices are
connected to one network, users can check whether a device connected to the computer is the
device they expect by checking the device name. To prevent errors, if users want to

download/upload the program, the system will remind the

users to check the name of the CPU

module and the name attached to the model in the project management area, when the name of the
CPU module is different from the name attached to the model in the project management area.

The parameters on System Parameter table are shown in

the following window. Users could set

appropriate values via a drop-down option list or type the values in the box.

® Clear non-latched area when STOP --> RUN

If the state of the CPU module changes from Stop to Run, the states of the non-latched devices and

the values in the non-latched devices are cleared.
> Enable: The current states and values of devices are retai

ned.
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> Disable: The states and values of devices are cleared to default value.

® Y output point keep when (RUN <-> STOP)
The state of Y device is set when the state of CPU is switched between RUN and STOP.

> Off : All Y devices are set to OFF.

> Retain Present State: The states of the Y devices are retained.

® |/0O module CONFIG by Auto/Manual when Power On

The actual /0O module configuration is read automatically when the CPU module is powered ON.
Or the CPU module operates based on the configuration set manually by users in HWCONFIG.
» Auto: Operates based on actual connected modules without any module and parameters set.

» Manual: Operates based on the configuration set in HWCONFIG by users.

® Select Action when 1/0O Module parameter with Manual CONFIG Different

The parameter cannot be set unless the Manual option is selected in the above parameter I/O
module CONFIG by Auto/Manual when Power On.

» Auto update: The CPU module will update its configurations based on the actual module
configurations.
» CPU alarm: The CPU module shows a warning when an error occurs.

® CPU module Stop when I/O Module No Response

The parameter sets whether the CPU and other normal modules can operate constantly when there
is a expansion module, which does not response when offline.

» Stop: The CPU module stops running and gives errors.
> Keep Run: The CPU module and other normal modules keep running.

® CPU module Stop when I/0O Module Occurred Error

The parameter sets the method to deal with a tiny error in the expansion modules.
> Stop: The CPU stops running and sends an error.

> Keep Run: The CPU keeps running but records the warning message.

® Setting delay time to detect I/O Module

The parameter sets how long after the CPU is powered on, the 1/O module and remote 1/O module
begin to be scanned.

® Assign X Input Point Control Run/Stop
The parameter sets whether one X input point controls the RUN or STOP state of the CPU.
> Disable: The function is closed. The state of the CPU can be changed with its DIP switch.

> Enable: Use the specified X input point to control and the DIP switch of the CPU can also be
used.

® Select X Input Point

Select one X input point on the drop-down list to switch Run/Stop if the above parameter Assign X
Input Point Control Run/Stop is enabled.

® Constant Scan Cycle Time

The parameter sets the shortest constant time to complete a cycle of scan.

» Disable: The function is closed.

» Enable: The CPU starts the next scan after the waiting time reaches the setting value if the actual
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scan time is less than the setting value. However, the CPU will operate based on actual scan time
disregarding the setting value if the actual scan time is greater than the setting value.

® Input Constant Time

Type the cycle time value in the parameter box if the parameter Constant Scan Cycle Time is
enabled. Please note if the setting value of scan time is greater than the setting value of Setting
Watchdog Time, there will be a timeout error once the CPU operates.

® Setting Watchdog Time

The parameter sets a timeout during which the program is scanned. The CPU module will send an
error if the program execution exceeds the time.

® Show Battery Low Voltage Error

The parameter sets whether the alarm is shown when the lithium battery for the real-time clock is of
low voltage or is not installed in AS series.

» Disable: The function is closed.

> Enable: There is an alarm when the lithium battery is of low voltage or not installed.

® Save Error history into
The parameter sets the location to store error logs.

» PLC: The error logs are stored in PLC. Twenty error logs at most can be stored. If there are more
than twenty error logs, the oldest error log will be overwritten by the latest error log.

» PLC & SD Card: The error logs are stored in PLC and SD card. There are more than twenty error
logs, the oldest error log will be moved to the SD card before the oldest error log is overwritten. .

® COM Communication Error Record

The parameter sets whether to enable the error record when there is an error at COM port.
» Disable: The function is closed.

» Enable: The error record function is enabled.

® Select Action When 24Vdc Input Unstable
What to do when the 24Vdc power is unstable

» Continue Running when power stable: waits till the power is stable and then PLC begins to run.

» Into Error Status: Stops and go to the error mode -
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® Communication Module Refreshed Priority

» Scan time first: only refresh the data that is different from the original ones to save scan time
» Synchronous Data first: scan and refresh all the data to ensure all data are synchronized.

® 1601 Timer interrupt Setting Time Base

Users can set the interval of triggering 1601 timer interrupt. The function is used with Timer Interrupt
0 in the work management together. Please refer to chapter 5 for more information.

® 1602 Timer interrupt Setting Time Base

Users can set the interval of triggering 1602 timer interrupt. The function is used with Timer Interrupt
1 in the work management together. Please refer to chapter 5 for more information.

® 1603 Timer interrupt Setting Time Base

Users can set the interval of triggering 1603 timer interrupt. The function is used with Timer Interrupt
2 in the work management together. Please refer to chapter 5 for more information.

® 1604 Timer interrupt Setting Time Base

Users can set the interval of triggering 1604 timer interrupt. The function is used with Timer Interrupt
3 in the work management together. Please refer to chapter 5 for more information.

3-100



Chapter 3 PLC System Configuration & Settings

The parameters on Device Range Setting table are shown in the following window.

Set the start address and end address of this kind of devices by clicking =:+| button. Click Default
button to restore to the default value. Click Clear button to clear the box content to 0. Finally, click
OK to save the settings or Cancel to give up the setting and leave the dialogue box.

The filter time of every input point is set on the Input Point Filter Time table. The signal will be
filtered as a noise if the period of time during which an input point receives a signal less than the
filter time. And users could set an appropriate filter time according to the interference state of the
field environment.
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® XlInput Point Setting Mode

The parameter sets whether to set the filter time of input points or to use default settings.
» Default Setting: Filter time is set to default value.

» Custom Setting: Users set the filter time of every X input point themselves.

® X0.0~X0.15 Input Filter Time Setting

Users could type the respective filter time of X0.0~X0.15 if Custom Setting is selected as X
Input Point Setting Mode.

The parameters on Position Control Parameter table set to specify input points as the positive and
negative limits of axis 1~ axis 6 channels. 12 limit points can be set at most. Axis No. 1~6 can also
be set as Z phase triggers, home function finish points and clear output selects or positive/negative
limited position.

® Axisl (Y0.0/Y0.1) Positive/negative Limited Select~ Axis 6 (Y0.10/Y0.11) Positive/negative
Limited Select.

Select the rising or falling edge trigger and X input point on the drop-down list.
® Axisl (Y0.0/Y0.1) Z Phase Trigger ~ Axis6 (Y0.10/Y0.11) Z Phase Trigger
Select the rising or falling edge trigger and X input point on the drop-down list.
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® Axisl (Y0.0/Y0.1) Home Function Finish and Clear Output Select ~ Axis6 (Y0.10/Y0.11) Home
Function Finish and Clear Output Select

Select the rising or falling edge trigger and X input point on the drop-down list.

® Axisl (Y0.0/Y0.1) Positive/negative Limited Position ~ Axis6 (Y0.10/Y0.11) Positive/negative
Limited Position

Set up the number of pulses as the positive or negative limited position in axis 1~6; setting
range is -2147483647 ~ 2147483647.

The parameters on Daylight Saving Timing table are used to enable or disable the function of
daylight saving time and set the date when the daylight saving is conducted. The clock will
automatically set the daylight saving time in advance based on the period of time set after the
function is enabled.

® Disable/Enable D.S.T Function
The parameter sets to enable or disable daylight saving time.

® Start date- month
The parameter sets the month from which the daylight saving time starts.

® Start date- day
The parameter sets the date on which the daylight saving time starts.

® End date- month
The parameter sets the month in which the daylight saving time ends.

® End date- day
The parameter sets the date on which the daylight saving time ends.

® Saving time
The parameter is used to adjust to the earlier daylight saving time with the unit of minute.

3.5.2.2 Options - COM1 Port Setting & COM2 Port Setting

AS series modules are equipped with one or two COM ports based on different models. COM1 and
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COM2 parameters are set by clicking COM1 Port Setting and COM2 Port Setting in the list on the
left-side of the following window. And the specific setting items are same for the two COM ports.

@ Users can set a station address. A device on a network can be identified by means of the station

address of the device. The station address of a device on a network can not be the same as the
station address of another device on the same network. If the communication port functions as a
slave, and there are other slaves, the station address of the communication port cannot be 0.
Station address 0 has the meaning of broadcasting to all slaves in a communication protocol. If
a master specifies in a data packet that data must be sent to station address 0, the data will be
sent to all slaves. No matter what station address of these slaves are, these slaves will receive
the data packet.

@ Users can set the timing of getting effective for the communication port. The communication port
will take effect when the CPU module changes from STOP to RUN if users select Stop --> Run.
The communication port will take effect when the CPU module is powered on if users select
Power on.

© Users set the baud rate for the COM port. Users can select one of the preset baud rates on the
drop-down menu or select custom to type a custom baud rate.

@ Users set the communication protocol for the COM port.

© Users set a value for Delay time to Reply. The AS CPU module waits for a period of time set
and then gives a reply after receiving a communication command so as to match the time when
the remote device switches the mode. Users set a value for Received Data Timeout. The AS
CPU module sends a communication command as a master. But it cannot receive a reply within
a period of time set and that will be regarded as a timeout.

@ Setting COM1 to show for: when COM1 is selected from the drop-down list, it will show the
RS485 communication status of the COM1; when Cardl is selected from the drop-down list, it
will show the Card1l communication status.

Setting COM2 to show for: when COM2 is selected from the drop-down list, it will show the

RS485 communication status of the COM2; when Card2 is selected from the drop-down list, it
will show the Card2 communication status.

3.5.2.3 Options - Ethernet Port Basic Setting

Users can enter this page by clicking Ethernet Port Basic Setting in the project list of the window.

The communication parameters can be set for the Ethernet port in the CPU module in this page.
Refer to section 2.4.8 for more information about connecting to a CPU module through the Ethernet
port on the CPU module, and refer to other related documents or manuals for more information
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about Ethernet.

Mode sets the addressing mode of the IP of the CPU module.
If users select Static, they can specify an IP address directly. If DHCP or BOOTP is selected, the IP
address is assigned dynamically by a DHCP/BOOTP server.

3.5.2.4 Ethernet Port Advance Setting

Users can set the parameters of Ethernet Port Advance Setting under Options including IP Filter,
NTP, Email, Sockl and RTU Mapping.

IP Filter sets the filter function of network devices. It is another acknowledgement mechanism to
ensure the communication object is a device which is allowed by us. The function can limit the
communication object. Only the devices in the IP address list are allowed to communicate with the
CPU module after the IP filter function is enabled. The data packets sent from devices of other IP
addresses will be discarded by the CPU module. The setting steps are shown below. Eighteen
groups of IP address at most can be listed in the table.
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Select IP Filter Function Enable checkbox to enable the IP filter function and type the start address
and end address of group 1~8 IP. Users can use NTP table to enable the CPU module and adjust
time via NTP server. Relevant parameters are set here. For more information on NTP, refer to
related literature and manuals.

@ Select NTP Client Function Enable checkbox to enable the function.

@ Set the address of NTP server and cycle of constant update. Take the figure above as an
example. The CPU module connects to the NTP server every 30 minutes.

© Set up the time zone for the daylight saving time area.

Email table is for users to set the email-related functions. The email will be sent to the set email
address after the email function is enabled. Total four groups of email sending conditions and four
groups of email addresses can be set.

© Select Email Function Enable to enable the function and then start setting the following
parameters.

@ Set an IP address of SMTP server. Set the COM port of SMTP server at the COM port and set
the sender’s email box at local email address. Type a mail subject as the start of the subject
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of every email.
© Select Account identification checkbox to enable the function. Users can set to authenticate
themselves with a user name and a password before logging in to an SMTP server.
@ Type the target email address of a receiver.
Type a trigger name in Trigger Name box and a minimum interval in Trigger Min Cycle in the
Trigger Setting table. And then select a trigger condition on the drop-down list. When the sending

condition is met, the system will send an email every a period of time. But the same email will not be
sent again within the set interval.

Trigger modes can be set as follows.

® CPU Error

If an error occurs in the CPU module, the condition of triggering the sending of an email is met.

Please refer to operation manuals for more information about errors occurring in CPU modules.

After users select the CPU Error option button, they have to select Fatal Error Only or All Errors in

the drop-down list at the right side of the option button.

a) Fatal Error Only: If a fatal error occurs in the CPU module, the condition of triggering the
sending of an email is met and an email will be sent.

b) All Errors: If an error occurs in the CPU module, the condition of triggering the sending of an
email is met and an email will be sent.

® CPU (RUN<=>STOP)
When the CPU module begins to run, or when the CPU module stops running, the condition of
triggering the sending of an email is met and an email will be sent.

® Bit Status Change

If the state of a bit device specified meets a condition set, the sending of an email will be triggered
and an email will be sent. For example, if X0.0 is turned from OFF to ON, the condition of triggering
the sending of an email will be met. If users want to set a condition, they can click ***/ button in the
following window.
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1st Trigger Bit Address hAD

1st Trigger Bit Trigger State Rsm@/ <+ 0
—©

1st Trigger Bit Address 1.0

1st Trigger Bit Trigger State Rising

© Device Name: Users can select a device type in the Device Name drop-down list box.

® Device Number & Bit: Users can type a device address in the Device Number box. If
the device type selected is X/Y, the users have to specify a bit
number.

© state: Users can select Rising or Falling in the State drop-down list.

® Register Value Change

If the value in a device specified meets a set condition, the sending of an email will be triggered and
an email will be sent. For example, if the value in DO is larger than 10, the condition of triggering the
sending of an email will be met and an email will be sent. If users want to set a condition, they can

they can click ™I button in the following window.

1st Trigger Reg Address Do <4 o
1st Trigger Reg Trigger State = /
1st Trigger Value 1] @ —>

+—©
1st Trigger Feg Address 0o
1st Trigger Reg Trigger State >
1st Trigger Value 10

© Device Name: Users can select a device type in the Device Name drop-down list.

@ Device Number: Users can type a device address in the Device Number field.

© state & Value: Users can set s condition of triggering the sending of an email here.

® Periodic Timer
An email is sent periodically. How often an email is sent depends on the interval typed in the Trigger
Min Cycle box in the Trigger Setting section.

Where any trigger mode is set, the user message and error log related parameters will show up.
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Select the Trigger User Message Enable box and then click -*| button to the right side of Trigger
User Message. Type some content as the email text in the pop-up window.

If users select the Error Log Enable checkbox in the Trigger Setting table, the error log will be
added to the email content automatically.

The options on the drop-down menu of Trigger Attachment Mode decide whether to add an
attachment to the email. Please make sure the maximum size of the email file allowed before setting
an attachment. For more information, refer to relevant operation manuals.

® None
If this option button is selected, no attachment will be inserted.
® File

Users can select an error log in the memory card, or the system backup file in the memory card as
the attachment of the email.

® PLC Device

If this option button is selected, the system automatically retrieves the states of the devices, or the
values in the devices listed in the table as the attachment when the email is sent. After this option

button is selected, users can click I button in the following window to open the Attachment
window. Two groups of devices at most can be set. For example, if the condition is met, the values in
D0~D9 will be sent as an attachment.

1st Trigger Attachment Data 1 Address | D0
15t Trigger Atachment Data 1 Length /
15t Trigger Atachment Data 1 Address DO
1st Trigger Attachment Data 1 Length |10

Select the target email address of a receiver when the condition of sending an email is met in
Trigger Receiving table. And the specific email box is set in the Email section.
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In the Socket table, users can set COM port parameters for data transmission via Ethernet.
However, the function should be applied with specific API instructions. For relevant details, refer to
AS series programming manual. And for the information on the socket, refer to relevant literature.

The system for AS300 series modules supports the data transmission between the CPU module
and other CPU module or device via a socket as well as TCP and UDP protocols in each of which
four groups of connections can be set ( AS200 series: 2 groups of connections can be set for each
TCP and UDP protocols). Users should select Socket Function Enable checkbox before any setup
and then do other setting in TCP and UDP setting pages respectively.
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The parameters in the TCP Socket Setting are the same as the parameters in the UDP Socket
Setting except that there is no Keep Alive Timer parameter in the UDP Socket Setting. The
parameters in the TCP and UDP Socket Setting are described below.

® Remote IP: Users can set a remote IP address.

® Remote Port: Users can set a communication port used by the remote device for this TCP
connection. The port number must be within the range between 0 and 65535.

® Local Port: Users can set a communication port used by the local CPU module for this
connection. The port number must be within the range between 0 and 65535.

® Send Address: Users can set the length of data which will be sent by the local CPU module.
The length must be within the range between 0 words and 200 bytes.

® Send Length: Uses can set an initial device in the CPU module where data which will be sent is
stored.

® Receive Address: Users can set the length of data which will be received by the local CPU
module. The length must be within the range between 0 words and 200 bytes.

® Receive Length: Uses can set an initial device in the CPU module where data which will be
received is stored.
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® Keep Alive Timer: Users can set a maximum keep alive time for the connection. If no data is
transmitted, and the keep alive period has elapsed, the CPU module will terminate the
connection automatically.

The port number used by the local CPU module and the port number used by the remote device
cannot be the same, and the devices where data which will be sent is stored cannot overlap the
devices where data which will be received is stored. If the IP address of the remote device is
192.168.1.100, the port number used by the remote device is 65500, and the port number used by
the local CPU module is 65501, the remote device and the local CPU module can transmit data
through this TCP connection.

If the local CPU module wants to send 10-word data to the remote device, the data will be stored in
D0~D9 before the data is sent. If the local CPU module receives 20-word data from the remote
device, the data will be stored in D100~D119.

If the length of data received is larger than the length set, the first 20-word data will be stored in
D100~D119, and the data after the first 20-word data will be discarded. Likewise, if the length of
data received is less than the length set, the data will be stored in the devices starting from D100,
and the values in devices where no new data is stored will be retained.

If no data is transmitted, and 60 seconds have elapsed, the CPU module will close the socket, and
terminate the connection.

In the RTU Mapping table, users can set Delta RTU-ENO1 slave in connection with AS series
module. The remote device can be controlled via Ethernet and 4 groups of RTU-ENO1 are
connectable in the network. For the setting and operation of RTU-ENO1, refer to the operation
manual.

Select RTU Mapping Enable checkbox to enable the function of connection between RTU module
and AS series module. Set the update cycle in Cycle box and a timeout in Timeout box. It means a
timeout when RTU does not give a reply within the timeout set.

The data mapping between each group of RTU-ENO1 and AS series module is set in the RTU
Mapping section. RTU-ENO1 and I/O module connected to it are set via DCISoft. For more
information on DCISoft, refer to the operation manual.
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@ Users can select RTU1 Enable to enable this RTU function. Each RTU can be set individually.
@ Users can set a station address and IP address.

© Users can set RX mapping address and RX mapping length to make the digital input points of
DI module connected to RTU mapped to X/M devices and length of AS series module. While,
the RY mapping address and length set is used for making the digital output points of DO
module mapped to Y/M devices and length of AS series module.

O Users can set RCR Read mapping address and RCR Read mapping length to make the
analog input points of Al module connected to RTU mapped to D/SR devices and length of
AS series module. While, the RCR Write mapping address and length set is used for making
the analog output points of AO module mapped to D/SR devices and length of AS series
module.

3.5.2.5 Options - Function Card 1 Setting

The Function Card 1 Setting table is used for setting parameters of function card 1 in AS300 series
CPU module, which is installed by inserting to the slot.
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© Users can select Auto in Card1 Detect mode box to detect the actual card model and setting
or Manual to select the AS--F232/ F422/ F485/F2AD/F2DA function card which need be
configured in the Manual Select Card box.

@ For the setting of parameters in AS--F232/ F422/ F485, refer to COM port setting in section
3.5.2.2.
© Users can set F2AD to receive the signal of 0~10V or 4~20mA in F2AD Analog Input Mode

box and set F2AD to send the signal of 0~10V or 4~20mAin F2DA Analog Output Mode box.

The average times are set in F2AD Sampling Time and Average Times boxes respectively.

3.5.2.6 Options - Function Card 2 Setting

The Function Card 2 Setting table is used for setting parameters of function card 2 in AS300 series
CPU module, which is installed by inserting to the slot. Besides function card 2 settings, the option

also in

clude settings for AS-FENO2 and IP filter. For function card 2, AS-FCOPM and AS-FENO2 in

Manual Select Card box are additional options that does not exist for function card 1. If users select
AS-FCOPM card, the parameters can be set in the following window.

o

4]

Users can select AS Remote Control/Delta Servo Drives and AS Remote Module/CANopen
DS301 from the AS-FCOPM working mode box. The AS Remote Module and Delta Servo
Drives adopts communication protocols exclusive to Delta servo products and AC motor
drives. In addition, the AS Remote Module and Delta Servo Drives are also applied in
connecting remote 1/0 AS series as well as CANopen DS301 for the application of DS301
standard protocol.

Users can set the address of the station when CANopen DS301 is selected from the
AS-FCOPM working mode box.

The remote I/O parameters can be set if AS Remote Mode is selected from the AS-FCOPM
working mode box. The AS Remote Module No. sets the number of remote I1/O modules and
each one can connect an expansion module. For AS remote module operation, please refer
to section 3.5.3.
If Delta servo drives and AS Remote Mode is selected as working mode, users can set the AS
remote module no. and the total no. of remote 1/0. When the no. of AS remote I/Os are
connected, each remote I/O can connect to an expansion module. Please refer to section
3.5.3. for more information on remote module operation.

If AS Remote Mode/Delta servo drives and AS Remote Mode is selected from the AS-FCOPM
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working mode box, users can Select run mode after detect remote module to run the number of
actual connected modules inconsistent with the set number of modules, then the actual connected
remote module operating or all remote modules will stop running; AS CPU keep or Stop when
slave node dis-connected only shows errors or stops running and sends an alarm when the
remote /O module is disconnected during operation; AS Remote and CANopen Communication
Timeout sets the timeout during which the remote I/O module does not give a reply; Auto Retry
connection after Disconnected sets the times of retrying to make a connection after a timeout
occurs.

© All three AS-FCOPM working modes can set the AS-FCOPM Bit Rate.

@ The DS301PDO Data Exchanged parameter contains Start after power and PLC RUN
Will work when CANopen DS301 protocol is selected from the AS-FCOPM working mode box.

In Function Card 2 Setting for AS300 series, users can set AS-FENO2 card as Manual Select Card
(Note: If AS-FENO2 card is selected from Manual Select Card, then Function Card 1 Setting under
Options tab cannot be used for setup and settings in Data Exchange-Function Card 1 & Data
Exchange-Function Card 2 tab cannot be used as well) for AS-FENO2 Setting. Under this setting,
users can setup parameters of Ethernet communication port used in AS-FENO2. To assign a static
IP address for AS-FENO2, users need to provide the assign subnet mask for this IP address. For
dynamic allocation of IP addresses, select DHCP/BOOTP for setting.
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After completing the setting of AS-FENO2 in Manual Select Card, users can select IP Filter
Function Enable. The IP filter adds another layer of confirmation to ensure the devices for
communication are permitted. This function can also limit communication objects. When IP filter
function enables, only the devices within the listed IP address from the IP filter table are allowed to
communicate with AS-FENO2. As for devices transmitting datagrams from other IP addresses, the

CPU will clear those data. The following IP filter setting process includes up to 8 sets of IP
addresses.
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By selecting IP Filter Function Enable, users can input the beginning and ending of 1-8 set of IP
address.

3.5.2.7 Options - Built-in AD/DA Setting

For Built-in AD/DA Setting, the selected AS series need to be equipped with AD/DA ports to set the
following parameters.

(1] Options for AD channel 1 & 2 input mode parameters include Voltage (-10~+10V) , Current
(-20~+20mA) and Disable.

(2] Options for DA channel 1 & 2 output mode parameters include Voltage (-10~+10V ) , Current
(0~+20mA) .

© Setting AD Sampling Time (unit: ms).
(4] Setting AD Average Times
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3.5.2.8 Options - Built-in CAN Communication

For Built-in CAN Communication Setting, the selected AS series need to be equipped with CAN
port to set the following parameters.

o —®
O—
0 :g
()/*

O rorcAN port work mode, users can select the AS Remote Mode, Delta Servo Drives and AS
Remote Mode and CANopen DS301. The AS Remote Mode can be used to connect remote 1/0O
AS Series; Delta servo drives and AS remote mode is selected for communication protocols
designed for Delta servo and AC motor drive products as well as for remote I/O AS series; the
CANopen DS301 is applied in DS301 standard communication protocol environment.

® Under the CANopen DS301 work mode, users can set CAN port node ID.

© Under AS Remote Mode, users can set its remote module no. Each remote I/0 can connect an
expansion module, please refer to section 3.5.3 for remote module operation.
If Delta servo drives and AS Remote Mode is selected as working mode, users can set the AS
remote module no. and the total no. of remote 1/0. When the no. of AS remote I/Os are
connected, each remote I/O can connect to an expansion module. Please refer to section 3.5.3.
for more information on remote module operation.

O If AS Remote Mode/Delta servo drives and AS Remote Mode is selected as work mode, users

can Select Action when the detected remote module to run the number of actual connected
modules inconsistent with the set number of modules, then the actual connected remote module
operating or all remote modules will stop running. The Select Action when the slave node
dis-connected shows errors or stops running and sends an alarm when the remote I/O module
is disconnected during operation. For ASRemote and CANopen Communication on Timeout
sets the timeout during which the remote 1/0 module does not give a reply; Re-connected retry
number after timeout sets the times of retrying to make a connection after a timeout occurs.

© All three working modes can set CAN bit rate.

@ Users can set data sampling position value under CANopen Communication.

@ When CANopen DS301 mode data exchange is enabled, users can select Start after power
and PLC RUN to activate DS301 PDO data exchange.

©® Select Enable for CAN Hardware error counter

3.5.3 Configuring AS-Series Remote Modules

AS300 series CPU module can connect remote IO modules so as to save the wiring between a
device in the remote place and the controller. AS Remote Control can be selected in AS-FCOPM
Working mode box and the number of AS remote module can be set in AS Remote module No.
box after users select Manual in Card2 Detect Mode box and AS-FCOMPM in Manual Select Card
box in Function Card 2 Setting table under Options tab.
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If users set 2 units in AS Remote module No. box, there will be 2 remote modules in the system
configuration area after clicking the OK button.

Users can set the remote module in the system configuration area according to the introduction
such as adding, deleting, copying and moving an expansion module in section 3.2.2. The actions of
clicking with the mouse or dragging as well as right-clicking and selecting context menu options are
the same as that for a general controller as follows. All expansion modules except network modules
can be configured.
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Likewise, users can double click to open the parameter setting window of a remote module and the
expansion modules connected to it.

6
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For the remote module, the start of input device range can be set as follows. Click one remote
module, double click Input Device Range box in Remote Module Group 1 table and then type the
device No. in the pop-up window. After the OK button is clicked, the input and output device range
of the remote device will be updated and that of expansion modules connected to it will be
configured automatically.

Remote Module Group 1

Extension No Type Module Mame | DDF ersion | Input Device Ra... | Dutput Device Comment

Network Module  [ASO0SCM -4 23040 ~ D 25043 (el s ]
Function Card?
Function Card? | Function Card | A5-FCOPM None
Module Information’ |Analog 1/0 Module | 450450 4 005000 |DZ3060 ~ D24079
3.54 Data Exchange - COM1, COM2 and Ethernet

After users click the tab Data Exchange-COM1, Data Exchange-COM?2 or Data Exchange-Ethernet,
the parameters for making the data exchange table of the communication port built in AS series can
be set.

AS series module can be the master and exchanges data with the slave remote devices via COM1
and COM2 based on MODBUS protocol or via Ethernet port based on MODBUS TCP protocol.
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Their setting windows are the same as below.

(4 O

© When setting the start mode to Program Control, the program in the PLC decides whether the
set data exchange is performed. PLC Run means that the set data exchange will be performed
automatically when PLC is in a RUN state. Always Enable means that the data exchange will
be performed constantly when the PLC is powered on.

@ A new data exchange table will be added in area € by clicking Add. The present data
exchange table selected will be moved up or down by clicking Move Up and Move Down. The
present data exchange table selected will be deleted by clicking Delete. The present data
exchange table selected will be copied by clicking Copy and then can be pasted to the last row.

© The data exchange table is explained as below.

Name Description
Item The number of the block for data exchange
Enable To select whether to enable the data exchange table when the data

exchange is performed.

Remote Station/IP | The slave station address of the data exchange table, one address
Address can be set for multiple data exchange tables. It is a station address
under COMland COM2 tabs and IP under Ethernet tab.

The device address range used by the master in the data exchange

Local Address table

[<<]| : Input; the data block where the master read a slave

< /[>> .
[>>] : Output; the data block where the master write to a slave
The device address range used by a slave in the data exchange
Remote Address | @ble o _ _ . _
The device range will be in hexadecimal display, if the slave in the
Aata Anverhannn tahla ic A Liear Aafinad NMANNDIIC NAvian
. The size of the data exchange table, which is basically consistent
Quantity

with the result calculated from the device range.

@O Select automatically scan slaves and then operate data exchange during the first time.

The data exchange is not effected by the enabling or disabling of connection information.
(Supports Data Exchange- COM1 &COM2)

3.5.4.1 Data Exchange - COM1 and Data Exchange - COM2

On the page of tab Data Exchange-COM1 or Data Exchange-COM2, double click a data exchange
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table which is to be set to open Item window as below. Select the checkbox of Enable to enable the
data exchange table in the mode mentioned above. Remote Address is the address of the target
slave for data exchange. The Shortest Update Cycle is the period for data exchange of the data
exchange table. If the target device does not make any response within the time specified by
Connection Timeout, that is timeout.

The master can complete the read and write in a command to improve the efficiency of data
exchange by selecting Support Read/write synchronization (Function code 0x17) in which the
specific MODBUS function code is used.

Please make sure that all devices in data exchange support MODBUS function code for read and
write synchronization. Otherwise, the read and write will fail on account of the failure to identify
function codes after the command from the master is received.

Device Type is the model of a target slave including Delta PLC and standard MODBUS devices.

2
K\

2\

® Read

AS series module reads data from a remote device.

Local Start Address: Device type and start addr